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PART ONE 

I hope you were warned, before you ever invested in a The Concept 
Macintosh, that this litlle computer is addictive . It pulls 
you in. It has you invenling work fm- yourself just so you 
can use it. It creates an atlitude lhat makes you fee l like 
you're having fun while being productive-what a concept. 

There's not much you need to know to operate th e Mac. 
That's why this book is so lillie . This book is just a direct 
path to the essentials o f operaling the computer so you 
can get straight to the fun, I mean warlt, without wasting 
too much time diddling around trying to figure it out. 
There's not much technical in formation here because 
most of us don't need it or want it; you don ' t have to 
know how to fly the plane to take a vacation in Paris. 

There is one technical point that I do have to n ote right 
here , though. Please forgive me. This edition of The Little 
Mac Book comes at an awkward time in the evolution of 
the Macintosh . You have probably heard some of th e 
hoopla about System 7, Ll1e new "operating system" (see 
page 11 ) that runs the computer. For lhe next year or 
so some people will be working with System 7 and many 
people will con tinue working wil11 previous versio ns 
(hopefully some versio n of System 6). Eve n if you d on ' t 
quite understand what an "operating system " is, you 
should know whethe r you arc using Syste m 7 or not. 
There is an instant way to te ll: Look in the upper right 
corne r of your screen when th e Mac is on. If you see a 
little question mark inside a balloon-like thing, your 
computer is "running" System 7. 

Most of the basic functions in bolh Systems operate 
exactly the same; System 7 just has a few new be lls and 
whistles. Since most people are still usi ng System 6, the 
major portion of this book is written from that standpoint. 
Chapters 23 thro ugh 30 re late ,!E;cifically to System 7. 
'Wherever you sec this symbol, lf.l, in the first portion of 
lhe book, it means Ll1at particular feature is a little different 
in System 7. If you are running System 6, ignore that litlle · 
symbol. If you are runni ng System 7, you should probably · 
check out the referenced pages to no te the diiTerence. · 

. •;g:;!i,MMAA!GQJ!t 441MI4WM'*11§4A$¥ ##4-M 

System 6 or 7 

~Dt>S ov 

Wt~.Vv.~t 

~ ,J~Wss~ 

If you see this icon, or 
picture, in the upper right 
of yma· screen, your Mac 
is using System 7. 
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READ ME fiRST 
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I apologize for any awkwardness this combination of 
System 6 and System 7 may present, but we just have to 
accept the fact that things will be awkward for a while until 
the dust settles and we aJI get back on an even footing. 

If technical information really bothers you, skip the first 
chapter-you can live wi thout it for a while . That chapter 
isn' t as painful as it sounds, actually, but if you 're a little 
nervous about using a computer in the first place, just 
bounce right over to the second chapter, called "Starting 
Up." In fact, skip over anything that doesn't make sense 
right away. That's one of the most wonderful things about 
the Mac-we can bumble along for a lo ng time on just a 
little bit of information. When your brain is ready to absorb 
more, come back to the parts tha t d idn 't make sense the 
first time around. The information will still be there. 

Whenever you come across a term you ar e not familiar 
with, check the index. It will refer you to the page where 
that term is defined. 

Anyway, technical stuff aside, I do hope you have fun 
and take advantage of this new concept in productivity 
as you, too, become addicted. 



Ks, MEGS, 
AND DISKS 

CHAPTER ONE 

People who've been working with the Mac for a wh ile 
start tossing aro und jargon like, "It won 't fit cuz it's a 
900K document," o r "My SE has 30 megs," and people 
who are not famili a r with th e Mac feel dumb because it 
all sounds so esote ric and we' re sut·e we' ll nevct· be able 
to unde rstand all this sophisticated computer sLUff and 
besides we do n't want to know all that technical stuff 
anyway we just want to learn how to run the darn th ing. 
We ll , as far as technical stuff goes, all most of us need 
to know is the machine is magic. Pure, simple, magic. 
Like an airplane. 

Knowing the d ifference between a bi t and a byte and a 
Kand a meg, tho ugh , can help organize things in your 
brain a little bit so what you are working with wi ll make 
more sense. This is how it goes: 

Technical Magic 

Actually, the computer isn ' t that smart; it can o nly count Bits 
to one. Reme mbe r in school when we learned the binary 
system, which we have now completely forgotten about, 0 
except that for some reason you could on ly count from Each one oftheseis one bit 
zero to on e and you had to use exponential no tation ? 
Well, Mac uses a binary system: it coun ts zero and o ne-
zero means Off and one means On. See, it sen ds these 
little e lectronic messages, each a series of Off and O n . 
And each on e of those lit tle messages is a bit. 

Now, one little bit doesn't te ll the computer a whole 
lot, so it strings together a bunch of bits to create a 
more important message: eight bi ts, such as 01000001, 
makes one byte. As you can see in the column to the 
right, one byte o f information is still ra ther limited-
it takes a lot of bytes to create any sort of document. 

So a bunch of bytes is gro uped together and called a 
kilobyte. You wou ld think that a kilobyte wou ld be a 
thousand bytes, yes? No. Since th e computer can only 
count to one, the closest it can get to 1000 in its binary 
system with expo nen tia l no ta ti on is 1024. But wege ner
ally round it off an d say there's about 1000 bytes in a 
kilobyte. And ki lobytes arc the Ks everyone talks about. 

Bytes 

01000001 
This byte rejmsents 
the lell£r A. 

Kilobytes 
Approximately 
IOOOBytes 
equals 1 Kilollyte. 
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Ks, MEGs, AND DisKs 

How do Ks figure in real life? Kilobytes are what disk 
space and file/ document size are measured in; the larger 
and more sophisticated the document or the software 

# program, the greater the number of Kit will occupy on 
the disk. 

Floppy Disks . You've probably seen the nice little 3.5" floppy disks that 
the Mac uses. A disk stores the information for running 
the computer, for operating the programs, for saving the 
documents you create. Originally the Mac could only deal 
with a single-sided disk (one that took information on 
on ly one side of itself), but unless you have a very old 
machine with on ly a single-sided drive, you won't be using 
single-sided disks. 

Disk Capacity : Anormal double-sided disk holds about 800K (kilo
bytes) of data. Four pages of double-spaced typewritten 
text takes about 6K of disk space; therefore, you can 
get about 500 pages of textual inforri?-ation on one disk 
(leaving some room for the messages it has to send to the 
computer). Spreadsheets, graphics, and other complex 
info take up a lot more space, of course. 

High-density disks have 
an extra hole on the 
right side of the disk. 

· A high-density double-sided disk holds about 1.4MB 
(megabytes, which are bigger than kilobytes, see page 10) 
of data. These disks look just like normal disks, except 
they usually have the letters HD somewhere on them, and 
they have an extra hole. That extra hole tells the Mac that 
the disk is high-density; only Macs with a "SuperDrive" 
(like the SE30, the Mac II fami ly, and the LC) can read 
these high-density disks. Some people advocate putting a 

8 

piece of tape over the extra hole to trick other Macs into 
reading the disk, but that a lmost always ends in a disk 
fai lure. Don't risk your work. 

Caring for : 'Why is the disk called a floppy disk when it's not floppy? 
Floppy Disks . Actually, it is floppy. If you slide over that metal end you' ll 

· see the floppy d isk inside. Don't touch it! It's full of tiny 
messages that your oily fingers or sharp nails can destroy. 
Keep your disks away from heat: they'll warp just like a 
record album when left in your hot car. And keep them 
away from magnets-a magnet will destroy all the data on 
the disk. So don't attach them to your refrigerator; don't 
store them near your telephone or stereo or any other 
electronic device; and don 't pile them on top of your 
magne tic paperclip holder. 



I also recommend you don't keep disks in those little 
plastic bags they often come in; the plastic can build up 
static electricity which has the potential to destroy your 
precious data. 

When you buy your floppy disks, they aren't farrnatted 
and so must be initialized. T hey come unformatted 
because other types of computers are now using these 
handy little things, and they can be initialized for e ither 
type. So when you first insert an uninitialized disk, Mac 
asks you several questions. You need to name the disk 
and you need to choose to initialize it single-sided or 
double-sided. Obviously, if it's a double-sided disk you' ll 
choose double-sided. The system may warn you that you 
are going to erase all the information on the disk, but 
since it's blank, so what. When you finally click OK, the 
Mac will lay down the formatting it needs to store all the 
valuable info you will be giving it. 

It is possible to lock a disk. \-\'hen a disk is locked, 
whoever is using it cannot change anytl1ing on it, nor 
can other fi les be saved onto it. To lock a disk, find the 
little black tab in the comer. You'll notice you can slide 
it up or down. 

"When the tab covers the hole, the disk is unlocked. 
"When you can see through the hole, the disk is 

locked. 

A hard disk is actually a large, hard disk, rather than a 
floppy piece of fi lm. In principle it works the same as a 
floppy disk, but it can hold a great deal more data. The 
hard disk itself can be installed inside your Mac, or it 
may be a separate unit. Either way, a hard disk is a 
storage container for holding a ll your documents and 
software applications, and typically holds your System 
Folder for starting your machine (see page 11 for more 
info on the System Folder). Hard disks allow you to store 
your applications and documents all on one disk instead 
of on a lot of separate floppies, making it much easie r 
and faster to work. It is essential now to have a hard d isk, 
as applications and documents are rapidly outgrowing 
even the double-sided disks. 

Initializing 
a New Disk 

Locking a Disk 

This dislt is unloclted. 

Hard Disks 
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Ks, MEGS, AND DisKs 

Megabytes 
ApjJroximately 1000 K 

equals one Megabyte. 

Make Backup 
Disks 

r== :;::;-:nnm; .. 

In fact, a hard disk holds so much data that it' s not even 
measured in ki lobytes; it's measured in megabytes, also 
known as megs or MB. You've already figured out that 
one megabyte is 1024 kilobytes, right? Right. 

Now, 1024 ki lobytes (one megabyte) is more than what 
one normal Ooppy disk can hold. Hard disks come in 
various sizes, able to store from 20 megs to 30 to 80 to 
160 megs of information, and they're getting bigger all 
the time. So on a small hard d isk th en, say 20 megs, you 
have as much storage space as on more than 25 jlojJfJY 
dishs.' You can load all kinds of applications onto your 
hard disk and create all kinds of documents without 
having to fiddle with putting noppies in and out. As the 
soft,vare applications get more and more sophisticated , 
they take up more and more space, and already there are 
applications that just can ' t be used without a hard disk. 

Always back up your software applications. As soon as 
you buy a new application, make a copy of all the disks 
and use the copy (the copy is your back up); keep the 
original disks safe in a clean, dust-free place. That way if 
a catastrophe happens to befall your application that you 
paid so much mon ey for, you always have an extra copy. 
Software companies, you know, won ' t give you a new 
copy if you destroy yours. 

· Also always make sure you have a current back up copy 
· of everything on your hard disk-all your documents you 

have so laboriously created. A hard disk can "crash" and 
leave no survivors. At the end of each working day, or 
more often if it is really important, make copies (page 37) 
onto disks of everything you created or modified that day 
(label the disks!). 

Yo u certainly don't want to lose all that data. A hard disk 
comes with a back up application-be sure to check it 
out. If you are in a situation where there are massive 
amo unts of information to back up regularly, check into 
those appl ications designed specifi cally for the process. 

Rule Number 3 Back Up Often. Like everyday. 
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(No, yon didn't miss Rules 1 and 2-Rule I is on jmge 51; 
Rule 2 is on fmge 44.) 
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T he Mac turns on with a little switch on the back left of 
the mach ine- admittedly a very inconvenient place. A 
Mac II, though, can al so be turned on vvith e ithe r the big 
key with the triangle on it at the top of the SE keyboard 
(that key tha t is useless for everybody else) , or the key on 
the top fa r right on the extended keyboard. It's recom
mended on a Mac II that you always use the keyboard for 
turning it on and off, rathe r than the switch on the back. 

If you have an internal hard disk for your machine, as soon 
as you turn it o n it will boot up from the System on the 
hard disk. (The term "boot up" comes fro m the idea of 
pulling itself up by its bootstraps, as the Mac is going into 
its own System and turning itself on.) 

If you have an external hard disk, tha t piece of hardware 
should be turned on first, and then turn on you r Mac. 

If your compute r has any other switches for turning it o n, 
either on top of the monito r o r on the keyboard , the 
s\'litch on the back o f the Macintosh must always be 
turned o n as well (see page 93). 

If you don't have a hard disk (you can read a little about 
hard disks on page 9) , the n you must insert a flo ppy disk 
with a System Folder on it. The System Folder, whether it 
is installed on your hard disk ar stored on a floppy, must have 
at least t>vo icons in it: the System icon and the Finder 
icon (shown be low, right). Wi thou t those two items in 
the machine, it can ' t start itself up; it will spit ou t any 
other disks you try to insert and \viii give you the sad-Mac 
face. The System Folder is an extremely important item. 
Although you can rename the folder, I stro ngly suggest 
you don ' t, just to keep the concept clear. 

The System and the Finder are sort of like this: You are 
going on a trip. Your car is full of gas. You have the keys. 
You put a key in the ignition and start the car; the engine : 
hums. But you can't get to where you're going yet-your 
car will sit in the driveway all day humming away until 
wha t? (Go ahead-think a minute.) Until you put it 
in gear. And tha t's sort of like what the Mac does: Your 
machine's plugged in. You turn it on. T he screen gets 

System 7 update: System Folder. page 11 9. The basic concept is 1he some, bul what 
you see inside the System Folder looks o lillie different. 

CHAPTER Two 

Turning It On 

Internal Hard Disk 

External Hard Disk 

Other Switches 

System Folder V 
L]] 

System Folder 

The System and 
The Finder 

System Finder 
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Inserting a Disk : 
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t ~l 

Start up disk 

System and 
Software 
Versions 

Only One 
System per· 
Computer! · 

bright and that li ttle picture is fl ashing. But you' re not 
going to get anywhere until you put it in gear by inserting 
a System and a Finder (the Finder runs the Desktop). 

If you ore not working from a hard disk, the n the 
Syste m disk is inserted into the internal drive (th e drive 
is the little slot in the machine that takes the disk). Disks 
go in with the label-side up (the side that does not have 
the round metal piece on it), and the me tal end goes in 
first. Your application, or progra m disk, the n goes into 
the external drive (usually a little box that sits on tl1e 
right side of the compute r). You can save data onto either 
disk, provided tl1ere is enough room. (Some Macs have 
two drive slots on the monitor; in tha t case, put the 
System disk into the top slot and the application disk 
into the bottom one.) 

If you ore working from a hard disk, then your 
applications are probably already inside the computer 
and you won't need to insert a ny o the r disks to access 
them. You 'll be inserting disks to save back up copies or 
to install other files onto your h ard disk. Either way, on 
the right side of th e screen you ·will see icons, or pictures, 
of the st:.:'lrt up disk and any other disks tl1at have been 
inserted (see Chapter 8 for more info on icons) . 

The disk icon that appears on your Desktop in the upper 
right corner is the start ufJ disk, the disk that holds the 
System Folder that booted (started ) th e Mac. 

All computer software is constantly being upgraded and 
updated , making tl1em more effi cient, powerful, magical. 
The developers let you know which upgrade you have by 
labeling the m ·with version numbers. At the moment of 
this going to press, the Macintosh System version is 6.0. 7 
(unless you are using System 7; see tl1e introduction on 
page 5) . T he Finder version is 6.1.7. 

As the System upgrades, the software programs are created 
to work with the pa rticular nuances of the newer System, 
so it's a good idea to keep up on them. Although you 
don't have to use the newest Syste m, it's usually free, so 
why not take adva ntage of it? 

You should never have more than one System in the 
computer. This wi ll invariably end in a bomb (see page 95). 



The Desktop is what you see on the screen when you 
first boot up your Macintosh; it's also known as the 
Finder. Consistent with the Mac environment that 
analogizes everything to parts of our real life, this Desk
top works much the same as your desktop at home or in 
your office: You have desk accessories (under the Apple 
menu) such as a calcula tor, a clock, and a note pad. You 
have a filing cabinet (the disk) that stores all your file 
folders full of information. You have as many file folders 
as you could possibly want to organize it al l. You can put 
folders inside of fo lders inside of folders ad infinitum 
(well , about 12 layers anyway) just like you would organ
ize your hanging files. You even have a trash can. 

It's a good idea to keep your Mac Desktop organized, just · 
like you would your office desktop. Create new folders · 
(from the File menu; also see page 33) for each category 
of information, and store all applicable files in it. If you 
create a new folder at the Desktop before you begin work 
in an application, then you can put your new document 
right into that folder when you Save (see page 35). This 
way, when you come back to the Desktop everything is 
organized and in its folder so nothing gets misplaced. 

Whenever you Quit working in an application , Mac 

.S File Edit Uiew Speciol 

CHAPTER THREE 

The Desktop 
or Finder 

automatically takes you 
back to the Desktop. If 
you don ' t see the name 

"Special" in the menu, : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : c::::=l : : 
or if there is no trash 
can, you am not at the 
DesktojJ-you are sti ll in 
the application. To get 
to your Desktop, from 
the File menu choose 

"Quit," not "Close." 

'T'he DeshtojJ; 
also /mown a.~ /.he Finder. 

: : : : : : : : : : : : : : : : : : : : : : : : : : : : . : : : : : : : : :H.a~d.D.is.k : : 

:: ::::: ::::::: ::::: : : ::: :: ::: : ::: : : :: :: ~-::: 
• • •••• • 0 • • • •• •• • ••••••• ••• ••• •• • • • 0 •• • ••• •• • 

: : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : : rr~s~: : : . .. .. . . . . . . . . .. . . .. . .. .. . ... . ........... .. . . 
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Organizing 
Your Desktop 

Below is an example of a neatly organized Desktop 
window, utilizing the hierarchical filing sysll>rn (HFS) , 
which is a fancy way of saying folders-inside-of-folders. 
Each category of softvvare or documentation has its own 
place, and inside these folders may be o ther folders, 
each compartmentalizing specific data. It's much easier 
to keep things organized on a Macintosh Desktop than it 
is on an oak desktop. 

_o Hard Disl< 0 
12 items 1 8 ,334K in disk 838K available 

ltJ CJ CJ CJ 
System Folder Utilitil?s Programs Frl?elance 

CJ CJ CJ CJ 
Publications Invoic ing Fishing TapDance 

CJ CJ CJ CJ 
Robin Jimmy Ryan Scarlett 

K:JI 

A ha.n.l dis/1 window on the Desktop, using lite folders 
/o organize alltlw files. 

fM1UiJiif#'*'i&*&ii§¥B'&!!Wi#R*" I 

Q 

ro 
l_Q Q] 



The mouse, of course, is that handy little piece of 
hardware that controls the movement of the cursor on 
the screen. As you move the mouse across the desk, the 
cursor moves across the screen in the same direction. 
In most Macintosh applications, you cannot fully utilize 
the program witl1out the mo use. A few programs give 
you the option of doing absolutely everything from the 
keyboard if you choose; but why learn 450 keyboard 
commands-isn't that exactly what we're trying to avoid? 

The mouse is used in several different ways: 

A single click is a quick, liglu touch on the button of 
the mouse, with the cursor (be it a pointer or an 1-beam 
[page 41] or anytl1ing e lse) located at the spot of your 
choice on the screen. 

A single click with the arrow on an icon at your 
Desktop will select the icon; a single click with the 
I-beam will set down an insertion poinL 

A double click is a quick click-dick on the butto n , again 
"'.jth the cursor located a t the appropriate spot on the 
screen. A double click has to be quick and the mouse 
must be still, or it will be interpreted as two single clicks. 

Double-clicking on a file will usually open that 
fi le; double-clicking o n a word will select that 
word for edi ting. 

A press is simply pointing to something and holding 
the mouse button down. 

Pressing with the pointer on the menu lets you sec 
the commands under tha t item; pressing o n the 
arrows in a scroll bar scrolls through that window. 

Press-and-drag is to point to the object or the area 
of your choice, hold/press the mouse bztllon down, and 
drag across, letting go when you reach your goal. 

Choosing menu commands is a press-and-drag 
function; dragging icons across the screen is 
a press-and-drag function; selecting text is a 
press-and-drag function. 

CHAPTER FouR 

The Mouse 

Single Click 

Double Click 

Press 

Press-and-Drag 
(also known, 
misleadingly, 
as click-and-drag) 
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The Pointer · When you ' re using the pointer, re member that the part 
of the pointe r that does the trick is the vmy tip, called the 
"hot spot." So be sure that tJ1e extreme point is in the 
area you want to affect. 

Cleaning 
the Mouse 

: The hot sjJot ....... ~ The tip of the pointer 
does the trick. 

It's important and easy to keep your mouse clean . As 
you're ro lling it around you can feel if any cat hairs or 
dus tballs have gouen inside. Take it apart regularly and 
clean it, fo llowing these steps: 

1. Take the mouse in your hand and turn it 
upside-down . 

2 . With your thumbs, slide the round wheel to the 
left unti l the li ttJe marker on the wheel points 
straight up to the "0 " (those little symbols on the 
back of the mouse actually are an "0" and an "L" 
for Open and Lock). T his wi ll open the lid. 

3 . T urn it back over into your left hand so the lid 
and the ball fall out into your palm. 

4 . You can clean the ball with a soft, dry cloth; clean 
the rollers inside wil11 a cotto n swab dipped in 
rubbing alcohol. 

5 . When clean, put tJ1e ball in you r left hand; with 
your right hand place the mouse o n top of the ball 
and fl op your hands over. T his places the ball 
safe ly into its little cubby. 

6 . Put the lid back o n and twist it to the righ t, lining 
up the marker with the "L" for Lock. 

7 . That's ill 



Across the top of the screen is the menu. This is called 
a pull-down menu, because when you point to a menu 
item and press the mouse butto n down , a list of menu 
commands drops do·wn . 

CHAPTER FM 

Pull-Down 
Menus 

...... ( _•_F_i l_e_E_d_it_u_i_e_w_s_p_e_ci_a_l __ __.1: V 
The Desktop Menu 

To choose an item in the menu, simply keep the mouse 
button pressed and slide the pointer down; you' ll notice 
that certain commands beco me highlighted, or selected, 
as you pass over them. When the command you want is 
highligh ted, just let go of the mouse button-don 't elicit! 

In some programs the pull-down menu itself contains a 
pop-out menu where you not o nly slide down, but also 
out to /.he side, usually in the direction of the arrow. 

In the list, you can see that some commands a re in 
black letters and some commands are in gray. When 
a command is gray, it means that particular item is not 
available at that moment. 

The most common reason that a command is unavai lable 
is that something was not selede<l before you went to the 
menu. For instance, you cannot choose "Open H from the 
File menu if you haven't first selected a disk or fi le as the 
item to be opened {to select some thing, click once on it). 

Choosing a 
Menu Item 

New Folder 
Open 

Get Info 
Eject 

Pop-Out Menus 

Courier 
Geneua 
Heluetlca 

'-----t Monoco 
Times 

Gray vs. Black 
Commands 

New Folder 
UJten 
C l o~•~ 
Gel Info 
Eject 
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THE MENU 

Keyboard 
Command 

Shortcuts 

New Folder OON 
Open 00 0 
Getlnfo 00 1 
Eject 00 E 

T o the right of th e commands in the pull-down menu 
you often see a little code, such as ag N. Th is is a key
board shortcut you can use inste{J(l of using the menu. 
If you hold down t11e Command key (the one with the 
cloverleaf symbol on it: 3€) and pres.s the le tter associ
a ted with it, tl1en the computer reacts just as if you had 
chosen that command from the menu. For instance, if 
you click once on a file to select it and then press 3€ 0 , 
the selected fi le wi ll open just as if you had chosen tl1at 
command from the File menu with the mouse. 

The people who designed the Mac interface have been 
ve ry thoughtful-as many as possible of the keyboard 
shortcuts are allite rative: 3€0 Opens files; 3€ P Prints; 
3€ E Ejects; 3€ W closes Windows; etc. Also see the 
following chapter. 

Ellipses •.• · 
& Dialog Boxes · 

Anytime you see an ellipsis ( the three dots: ••• ) after 
a menu command (as in "Open .. . "), it means you will 
get a dialog box. T here are d i[ferent varieties of dialog 

18 

boxes, such as a lert boxes or message boxes, but basically 
they all are meant to communicate with you. 

Dialog boxes always give you an option to Cancel, so it 
is quite safe to go exploring menu commands this way . 

. Just choose a command that is followed by an e llipsis, 
check out the dialog box, then click Cancel. Even if you 
clicked around o n buttons or typed in the dialog box, 
cli cking Cancel will make sure none of your changes are 
put into effect. 

Saue publication as 

I= Hard Dislc I 

CJ Freelance 
Cl lnuolcing 
CJ MacDosics 
Cl PM3.0 
Cl Programs 
CJ Publications 

I New Document 

[jed ] R OK lJ 
Driue ] ( Cancel ] 

= Hard Di slc 

S~:~ue as: 

® Publication 
0 Template 

' A "Save as ... "dialng box; notice JOU can Cancel. 
e You can also choose to eject a floppy disk before you Cancel 

if you need to eject or swap dis liS. 



IMPORTANT 
KEYS 

There are several keys on the Macintosh keyboard 
that are particularly important and useful. They come 
in handy for sho rtcu ts, manipulating images, accessing 
alternate characters, and any number of things in 
specific applica tions. 

Speaking of keyboards, the re are basically three kinds for 
the Mac: two slandard keyboards with the keypad at the 
end (like a ten-key adding machine)- one version for 
the Mac Plus and older models, and one for SEs, Classics, 
and similar models-and the extended keyboard that has 
all the function keys and o ther little arcane sets of keys. 
Often people think the standm·d keyboard is the extended 
one because it has the numeric keypad that we didn't have 
on our typewriters. It isn't. All the keyboards generally have 
standard characters, but there are several keys that are 
placed differe ntly, depending on which model you have. 
No matte r where they are placed, though, all keyboards 
have the following keys, and they all operate the same. 

The symbols noted under each heading are the symbols 
that appear in men us to indicate pressing that key. T hey 
are usually used in combina tion with le tte rs- always ho ld 
dmvn all the descriptor keys (Command, Shift, e tc.) and 
give a quick tap on the let•er key associated with it. For 
instance, to Open fi les the command is often 3€ 0 : hold 
down the Command key while typing a quick 0. 

The Commond key is on the bottom row, the key with 
the California freeway cloverleaf symbol on it: 3€ . On 
the SE and extended keyboards it also has an apple o n it, 
and you may hear it referred to as the "Apple key." The 
symbols you see in the menu are referring to this key, and 
most applications have keyboard shortcuts using it. 

Next to the Command Key is th1.. Option key. I t's often 
used in combination with the Command key and/ or the 
Shift key. It's through tl1e Option key that you access the 
special characters, such as¢ and ®, as ·well as accent 
marks, as in resume and pirh ta (see page 48- 50). 

The Backspace key, called Delete on most keyboards, 
is located on the upper right. The name was changed to 

CHAPTER SIX 

The Keyboard 

Command Key 

ag 

Option Key 

~ 

Backspace or 
Delete Key 
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Delete because that's really what it does-whatever 
is selected will be removed when the Delete key is hit; 
whatever letter is to the left of the insertion point will 
be deleted as it is backspaced over. 

Tilde Key · The Tilde key ( "') is located on the upper left of some 
· keyboards and next to the Spacebar on others, including 

the extended keyboards. It's often called the Undo Key, 
Escape Key · because in certain applications it will undo the action 

esc immediately preceding. Although on the SE and the 
extended keyboards the upper left key now says esc 
(escajJe) and the Tilde has been placed next to the 
Spacebar, in many applications esc can still be considered 
the Undo key because it often does the same thing. 

Control Key · The Control key, found only on the bigger keyboards, 
doesn't do much yet; in most applications it's just a dead 
key. They say it's something we'll grow into. You can type 
the Command key symbol with it: in the Chicago font, 
press Control Q to produce 3C (but not in S)•slem 7). 

Return Key . The Return key is often used for other procedures than 
simply starting a new paragraph. For instance, any button 
in any dialog box that has the double border around it 
can be activated with the Return key instead of tl1e mouse. 
Different programs use it in different ways. 

Enter Key · The Enter key on the keypad will also activate buttons 
~ · with the double border,just the same as the Return· key 

· as noted above. Again, different programs use the Enter 
: key in different ways. 

Spacebar · The Spacebar is represented in menus by the symbol 
- · shown to the left or as a blank space. That'll really throw 

: you. How long does it take to figure out that D ag 
. means press the Shift key, the Command key, and the 
. Spacebar? 

Shift Key : The Shift key is one of the most common keys used in 
D . keyboard shortcuts, symbolized by an upward arrow. 

Caps Lock · just a note: the Caps Lock key does not act just like the 

! · Shift Lock on a typewriter-in Caps Lock you get capital 
letters, yes, but you do not get the characters above the 
numbers or above the punctuation. If you want the Shift-
characters you must still press the Shift key to get them. 
Some keyboard shortcuts wi ll not work if the Caps Lock 
key is down , so check for that if you' re having problems. 



CHAPTER SEVEN 
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A window, as shown below, is a basic, fundamen tal 
inte rface of the Macintosh . If you imagine your disk as a 
filing cabinet in which you store all your work in mani la 
folde rs, then o pening windows is like opening fi le d rawers. 
to see wha t's in the cabine t. It's impor tan t to know all the · 
little tricks in using a window, as you ' ll find windows in 
almost every application. They're simple and fun to con trol. : 

W indows 

T"tl B z B I e arb oom ox~ Close Box 1 
El Hard Disk 

Information 14 items 1 7 ,596K in disk 1 ,575K available 

Bar, or ~ 
Scroll 

Header LlJ 0 0 0 
Box 

System Folder Utilities Programs Freelance 
Gray 
Scroll 

Icon EJ 0 0 0 Bar 

Hy percard lntro /Work Pagemaker Publications 

=-- 0 
Cl l 1¢123 Size Box 

Scroll White~ Hidden 
Arrow Scroll Bar Icon 

Title Bar T he title bar is the a rea a t the top of the window in 
which, logically, the ti tle appears. This title refers to the 
disk, folder, or document you have opened. If you press
and-drag in the title bar, you can move the window 
around the Desktop; it moves as an outline. just le t go 
when you have the oull ine placed where you want. 

Moving the 
Window 

If you have more tl1an one window o pen, only o ne 
will have lines in its ti tle bar; this means it's the 
window. If the windows are overlapping, the active 
window is the o ne that is foremost. 

The active window is the window that the commands 
from the keyboard or the menu will affect. For instance, 

Active Window 



WINDOWS 

~ ToMakethe 
Y.f Window Active 

' • 
Gray Icons 

illiliil!l!l!l! 

Size Box 

~ 
Zoom Box 

=~r 

if you go to the File menu and chose "Close," it will close 
the active window. If you ask for a "New Folder ," the new 
folder will appear in the active window. 

To make a window active, simply click on any visible 
part of it; this will also bring that window to the front of 
any othe rs. You may have to move o ther windows around 
in order to see the window you want to make active. 

T o move a window without making it active, hold 
down the Command key while you press-and-drag 
in its title bar. 

Sometimes you can' t see the window itse lf bu t you can 
see its gray icon; in that case, double-click o n the gray 
icon to bring its window forward and thus make it active. 
(Also see pages 29 and 98 regarding gray icons.) 

On the bottom right corner is the size box. If you 
press-and-drag in the size box, you will make the window 
larger or sma ller. 

On the upper right corner is the zoom box. If you click 
in the zoom box it will enlarge to fill almost the entire 
Desktop. If you click in it when it's large, the window will 
zoom back down to the size it was just before you zoomed 
it larger. 

Scroll Bars · Along the right and bottom edges of the window are the 
· scroll bars. The scroll bars allow you to view everything 
· in the window, even if it cannot all fit on the Desktop 

or if the window is sized too small. You ' II notice in the 
example on page 21 that the scroll bar along the right 
side is gray, while the one on the bottom is white . 

Gray Scroll I' . When a scroll bar is gray, it's indicating that there are 
othe r items in the window you can ' t see. In the example 
on the previous page, you can see a folder along the 
bottom edge that is barely visible, so the scroll bar is 
gray, telling you something more is beyond its borders. 

White Scroll Bar · 

©1 I~ 

Scroll Arrows 

12[ :J2l 
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When the scroll bar is white, it's indicating the re is 
nothing more in tl1e direction of tl1e arrows (the hori
zon tal direction in the diagram) than what you can see. 

At either end of the scroll bars are the scroll arrows. 
When tl1e scroll bar is gray you can press on a scroll 
arrow, making the conten ts of the v.~ndow glide past 
vou as the scenery outside a u·ain windmv. 

System 7 update: active window and zoom box, page 11 0 



Notice the little scroll box in each scroll bar. AI; you 
press on the arrows, this box moves so you can see where 
you are in the window. '"'he n tl1e box is a ll ilie way a t 
one end, that's the en d of tl1e window. 

Another useful techn ique using the scro ll box is iliis: if 
you press-and-drag ilie scroll box, you can move it to any 
position on the scroll bar, let go, and the window will 
immedia tely jump to that particular place rathe r than 
scrolling through everything. This is very handy inside 
an application where you have a long document and 
scrolling wi th the arrows would take too long. In some 
applications a n umber ap pears within the scroll box to 
indicate what page you 're on. 

T here's yet ano tl1er way to use the scroll bars: if you 
simply click th e po inter in any gray area of the bar, 
ilie window will move up, down , or across, usually a full 
window view-wha t was at the bottom of ilie view will 
th e n be at the top or vice-versa. 

Just under the title bar you 'll find some ve ry useful 
information: if your window is showing icons, yo u'll see 
how many items are in tha t window, how much space is 
be ing used up on the disk, and how much space is left on 
the disk. O n a hard disk, the numbers are still re fe rring 
to kilobytes, so just round it off to megs by referring to 
the number in the thousands place (e.g., 7,856K would 
be almost 8 megs). lfyouT window is not showing icons, then 
the information bar indicates how your files are curre ntly 
be ing organized (see "Viewing the Window," below). 

And, of course, in the uppe r left is the close box. 
Clicking o nce in t.l1a t li ttle box will close the window for 
you , sen ding it back to the disk or folder it came from. 

The Macin tosh always tries to allow things to happen in 
a way t.l1al you fee l is most workable for you. The view 
of the window is anothe r good example- you can 
choose to see what 's in your window in a variety of ways, 
a ll appropriate for d ifferen t purposes or styles. 

T hese differen t views are fou nd, of course, in the View 
menu whe n you ' re at your Desktop. When you choose 
one, the ac tive window will appear in ilia t choice (the 
ac tive window, remembei-, is the one tha t has the lines 
in its title bar ). T he view will stay tha t way un til you ..... ..... .. 
System 7 update: Scrolling. page 110; Info bar, or header, page 123: 

major conveniences in viewing and customizing the window, page II 0 . 

WINDOWS 

Scroll Box V 
~ Scroll Box . 

~ 

Clicking in the 
Scroll Bar 

~ ~~)~~u ~~ ~~~~J 91 

Information 1i7 
Bar, or Header "..( 

14 ttems 596K In disk 17!iK <lV<lil.lblt I 

Close Box 

~ 
Viewing "1F7 
the Window "'..( 
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D 

0 Children 
0 Freelance 

0 HC Book 

0 HIJpercard 

0 lntro/Works 

0 Tap Dance 
0 Utilities 

Notice the 
underline in the 
infonnation bar 
indicating which 
view is being 
disfJla)'ed. 

change it. As you change the views, you'll notice the name 
of the view you have chosen is underlined in the window. 

While viewing the files as a list, you can still manipulate 
them just as if they were icons (i.e., pick them up and put 
them in the trash or in another folder, rename them, 
copy them, open them, e tc.; see Chapter 8 on Icons). 

· View by Small leon keeps that feeling of looking at 
: pictures, if that's what you prefer , but the icons are tiny 
. so you can fit more in the window. T hey're not in any 
. specific order. 

: View by Icon is what you typically see-pictures 
. representing the data. Visually-oriented people tend to 
· prefer this style. Again, the files are in no specific order. 

: View by Name turns the icons into text for those who 
prefer looking at words rather than pictures. A tiny li ttle 

· icon is still present so you can see what sort of fi le it is. 
· They're listed in alphabetical order by name . 

. View by Date lists the files in chronological order 
backwards from the date they were last modified, not the 
date they were originally created. This is handy when 
you have, for instance, several budget documents and 
you want to see the most recent version. 

· View by Si:ze lists the flies in order of size, beginning 
· with the largest. It te lls you how many K (kilobytes) that 

particular file is taking up on your disk. T his is handy if 
you need to remove something to make room; you can 
see which fi les to remove to clear enough space. Unfortu
nately, it won't show the size offolders; to find their size 
you need to select the folder and choose "Get Info" from 
the File menu (see page 31). 

· View by Kind lists the files in groups of applications, 
· documents, or folders. This is handy if you want to see a 

list of all your applications, or all the documents in your 
budget folder, etc. 

' View by Kind is particularly useful for a folder 
e that holds an application and all its accessories

d ictionaries, tutorials, technical fi les, samples, etc. 
This view will always put the application itself at 
the top of the list so it's easy to find. 
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vVhen you 're viewing icons in your windmv, they often 
get all scrumbled up and look like a mess. To align them 
all nicely, simply choose Clean Up Window from the 
Specia l menu-all the icons will fly to the nearest little 
cubby available on the underlying invisible grid . 

When they fly to the nearest spot on the grid , 
though, the re are ofte n spaces left available 
where another icon could fit in. If you want 
them to all line up in rows, from left to right 
with no empty places, hold down the Option key 
when you choose "Clean Up Window. " 

If an icon is selected, then the menu will say "Clean Up 
Selection ," in which case just th at selected item will be 
straightened up. Older systems may just say, "Clean Up." 
It works the same. 

771~f is the button I want in my house-the dishes Jump onto their shelves, the 
laundry jmts iLfe/f away in the drawers, and all the toys go badt in the toybox. 

To close all the windows that are open on your Desktop, 
hold down the Option key while clicking the active 
window's close box; they'll all go away one after another! 

If you have System 6.0 or higher, you'll notice in 
the File me nu there is a keyboard command for 
closing the ac tive window: Command W. If you 
want to close all the windows at once, press 
Command O ption W and all the windows will 
fly away home. 
Note: Unless you are in System 7, this will no/ worlt -if a 
Desk Access my is the active window; nor will it work if 
the Caps Lock key is down. 

Clean Up 
Window 

' • 

Close All the 
Windows 

' • 

Another fa n cy trick to close all the windows is ' 
to hold d own the O ption key whe n you choose • 

"Quit" from any applicatio n. KeejJ holding the 
Option ltey down until you see you1· DesltlojJ. \Vhen 
you arrive, there won ' t be a single window o pen. 
If you use this trick you can legitimately call 
yourself a Power User. 

Often th e fil e you want to open is buried within ' 
several folde rs. Hold the Optio n key down while e 
you double-click to open those folders. They' ll 
close up behind you as you go along. 

25 
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Print the 
Window 

on an 
Image Writer 

Occasionally you may have a need to print the informa
tion you find in a particular window; for instance, to 
make a list of all the documents that are on that floppy 
disk, or all the dated budget fi les that are in the Budget 
folder. You can't do this on a laser printer~ though. 

To print the info in the window: 

... Turn on your printer . 

... Make sure the window that contains the data you 
want is the active window (click once on it) . 

... Hold down the Command and Shift keys and 
press 4 (Command Shift 4 ); when the printer 
responds you can let go. 

Print · The above procedure prints only the visible contents 
the Screen · of the active window; if you want to print everything 

on the screen, the whole screen and nothing but the 
screen, then do the same as above but this time press 
the Caps Lock down before you press Command Shift 4 . 
This way you can pr int the contents of any and all open 
windows. 

If you want to print a picture of your screen on your laser 
printer (and you are not using System 7), you can create 
and print a screen dump, or screen shot. See page 30. 



Icons-the little pictures you see on the screen-are 
another intrinsic part of the Mac interface. Instead of 
having to type in a cod e to get into an application or 
document, you simply click on the icon representing it. 

A note about clicking on icons-if you're trying 
to select or open it, don't click on the name, or 
the icon thinks you want to change the name. 

vVhe n you initia lly turn on your machine and get to the 
Desktop (as o n page 13), you 'II always see an icon of the 
disk you 're using, whether it's a hard disk or a floppy 
(the hard disk icon may look different than this one 
shown, depending on whe re it is and what kind it is) . 

.,. Single-clicking on a disk icon will select it. 

.,. Double-clicking on a disk icon will open it 
to show you a window holding all the files. 

Note: If a disk icon is gray, it is either already 
open (page 29) or has been left in RAM after 
being ejected (page 98). 

vVhenever you have a window open, most like ly you' ll 
see folder icons. They ac t just like folders in your filing 
cabinet. Be sure to read the following chapter on 
Folde rs, as they are an important organizatio nal tool. 

.,. Single-clicking on a folder will select it. 

.,. Double-clicking will open it to show you a window 
with all the files that are stored in that folder. 

Inside the folder named System Folder are all th e 
system icons that he lp run the Macintosh, as well 
as a variety of icons that are for extra or fancy optio ns. 
The ones that look like little Macs are system icons 
that perform essential operations. You'll see one called 
Syste m and one called Finder-if those two are not 
inside the System Folder, you won 't even be able to 
use your machine . 

.,. Single-clicking on a system icon will select it. 

.,. Double-clicking will give you a message telling you 
an applicatio n can't be found or that it is locked 
o r in use . That' s because system icons are just visua l 

System 7 update: renaming and creating your own icons. page I i 2: 
folder icons. page 109; system icons, page 119. 
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Printer Icons 

representations of the data on your disk that makes 
them work-there's really nothing to look at besides 
the cute little icon. 

Also in your System Folder are printer icons. In order to 
print to any printer, you must fi rst have the icon inside 
your System Folder. If it is not in the System Folder, then 
when you go to the Chooser (see page 81) to tell Mac 
which printer you want to use, there will be nothing to 
designate and you won't be ab le to pr int. 

• Single-clicking on a printer icon will select it. 

• Double-clicking will give you the same message 
as the one you get with the system icons, for the 
same reason. 

Application or · The application (or program) icons are the fancy ones. 
Program Icons These belo ng to the actu al applications (the software 

& programs). Each application has its own design , so they 
~ all look different, but what they have in common is that 

MacPaint 

Mac'w'rite II 

they all try to give some sort of visual clue as to what they 
do. For instance, in the icons to the left you can see that 
MacPaint is an art program; MacWrite II is a word 
processing program. 

• Single-clicking on an application icon will select it. 

• Double-clicking will either open to a new, blank page 
within that program, or at least to a dia log box where 
you can choose to create a new, blank page . 

Document Icons Document icons represent documen ts, or fi les, that you 
have created in any particular application. Whenever 
you are working in an applicatio n and you save your 
documen t with a title, a document icon is created for 
you on your Desktop. 

Peaches 

Article 

28 

Document icons almost always look like a piece of paper 
with the top righ t corner folded down, or perhaps a 
sheaf of papers or a stack of cards. Typically they have 
some resemblance to the application they were created 
in , as you can see by the MacPain t and the MacWrite 
icons on the left. 

• Single-clicking on a docume nt icon will select it. 

• Double-clicking will usually ope n the application in 
which the document was created, with that particu lar 
document on the screen. (If you get an error message, 
check page 94, "Can't open a fi le.") 
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When an icon is gray, as the one on the right, that means 
it's alread)' open. Maybe you don't see the icon 's window 
because it's hidden behind another open window, but 
you know it's open somewhere. (If a floppy disk icon is 
gray, but it is not in the machin e, see page 98!) 

,. Single-clicking on an open icon will select it. 

,. Double-clicking will bring its window to the front 
as the active window. 

Whe n an icon is black, like the one on the right, that 
means it is selected-it got selected by someone clicking 
once on it. Once an icon is selected , you can press-and
drag it somewh ere; menu commands will affec t it, such 
as Open or Put Away or Clean Up Selection; you can 
change its name by typing. 

,. Single-clicking is what selected this icon in the 
first place . 

,. Double-clicking a selected icon will open it just 
like any other icon. 

The trash can icon works just like the trash can in your 
yard-you put things in it you don't want a nymore and 
the garbage collector comes and takes it away and you 
never see it again. 

To put something in the trash: Press-and-drag an icon 
over to it. When the can becomes black, le t go and the icon 
will drop inside. If you find a bunch of garbage h anging 
around outside the can, it's because you didn 't wait for 
the can to turn black-you just set it down next to it. 
Try again. The tip of the pointer must tonch the can! 

To remove something from the trash: If you double
click on the trash can you' ll find that it opens up to a 
window, just like any o the r window. So if you decide you 
want that item you just threw away, you can go get it. 
Either press-and-d rag the icon back to the disk/folder it 
came from; or click once o n it to select it, then from the 
File menu choose "Put Away" and it wi ll go right back 
where it came from. How d oes it know? 

Don 't count on anything staying in the trash vel)• long, 
though! Read o n ... 

System 7 update : Trash con, page 103. 
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You can empty the trash by going up to the Special 
menu and requesting "Empty Trash." Once you do that, 
it's gone forever. No amount of crying or pleading or 
screaming or kicking will bring it back. Believe me. 

Now, you can empty the trash yourself, as noted above. 
But sometimes the garbage collector comes when you 're 
not looking, so don ' t count on it staying there 'til you 
empty it. 'Whenever you eject a disk, copy a file, Shut 
Down , Restart, or turn off the computer, the trash gets 
emptied. Whenever you open an application , the trash 
gets emptied. Whenever the power goes out, even for 
a split second, the trash gets emptied. And if the Mac 
runs out of RAM (Random Aaccess Memory, where 
everything stays until it gets saved to a disk), Mac herself 
will empty the trash for you and take that memory space. 
So be careful. 

vVhenever anything Mac thinks is important has been 
put in the trash, such as an application or system icon, 
you'll get a dialog box asking if you really want to throw 
tha t away. That's nice. 

If you don't want to see the waming dialog box, 
hold down the Option key while trashing the item. 

Unfortunately, Mac doesn 't think anything you have 
created is worth warning you about 

When trashing items to make more space on 
the disk, the trash must be emptied before the 
space will open up; watch the numbers in the 
information bar of the window when you 
empty the u·ash. 

Occasionally you will see or create an icon that is named 
Screen 0 or Screen 1, etc.; this is a screen dump. A 
screen dump is a picture of the computer screen at 
the time you pressed the special key combination. 

. VVhenever you press Command Shift 3, a MacPaint 
screen dump, or screen shot, is created for you; an icon 
for the shot will appear in the window that con tains the 
System Folder. You can open MacPaint, open this file 
(or use almost any paint program with the MacPaint 
button in the Open box chosen), and view/ change the 
image just like you would any other paint image. Then 
paste it into another document. 



ICONS 

For instance, all the images in this book were created 
using screen shots. With the image on the screen in its 
natural habitat, I pressed Command Shift 3. Then I 
opened DeskPaint and opened the Screen 0 file that had 
been created. Since the screen shot took a picture of the 
entire screen, I had to erase all the excess stuff around 
the image. Then I could c hange, resize, ro tate, flop , etc., 
the graphic. I put the images in the Scrapbook (page 86) 
and later pasted the m onto these pages. 

You can create up to 10 screen dumps, and they'll be 
labeled 0 to 9. You can create more, but you have to 
rename the others first. 

Get Info is not an icon , but a menu item that can give 
you important information about any file represented 

Get Info 

by an icon on your Desktop, be it applica- fii§~D~~~~~i:~ln~f~o~~~~~~ 
tion, document, system, printe r, or folder. F 

ToadHall lack<!d 0 
Select an icon, any icon, by clicking once 
on it; then from the File menu choose "Get 
Info." You 'll get a little information window 
that tells you interesting things about the 
file, such as how big it is, when it was made, 
which software program it was created in, 
which sofnvare version you have . 

The nicest thing about this window is 
you can type in your own information ' • in the box at the bottom (the insertion 
point flashes, waiting for you to typ e). This 
comes in vel)' h andy: you can write notes to 

Kind: PageMaker 4.01 document 
Size: 42K on disk (42, 176 bytes used) 

Yhere : Hard Disk : Robin: 

Created : Wed, Jun 26, 1991 , 1 :33 PM 
Modified : Wed, Jun 26, 1991 , 1:52 PM 
Yersion : n/ a 

Comments : 

Party inv ita\ions-get these in the mail by t he 
first. 

This is the bo.>: yourself about that particular file and what it contains, 
briefly detail this budget file from that budget fil e , 
record any bugs you find in it, make note of further 
changes you want to employ, leave notes for your lover , 
e tc. The information you type is automatically saved. 

in which you can 
lyfJe your own notes. 

(If at some point you chooose to rebuild your Desktop 
[see page 92], the rebui lding process will unfortuna te ly 
destroy any Get Info no tes. Darn it. ) (Even hafJpms in System 7.) 

The info on the fo llowing page explains the little 
"Locked" checkbox you see in th e upper right. 

System 7 update: Getlnfa boxes and stationery pods. peg~ /07: cuslcmizing icons .. ~ge 112. 31 
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Locking the File · There is a Locked checkbox in the upper right corner 

Locked 1:8] 
This file is now locked. 

' • 

· of the Get Info window. If you check this box (click 
once on it), the file cannot be renamed or inadvertently 
thrown away-as soon as it hits the trash a dialog box will 
come up telling you a locked file cannot be thrown away. 

It also becomes a Read-Only file: anyone can open and 
read the file, but no one can save any changes to it. This 
is handy for sending around copies of a document and 
ensuring no one accidentally changes anything. You 
can't even change the Get Info notes. 

Ifyou hold down the Option key, you can 
throw away a locked fi le. Uh oh . 

Lochd 0 : To unlock the fi le, simply click in the checkbox again. 
This file is now unlocked . . If there is no X, it is unlocked. 

32 

Moving Icons . To move icons, simply press-and-drag on them. You can 
put any icon into or drag any icon out of any folder icon. 
Also see Chapter 10 on Copying/Selecting. 

Renaming 
Icons 

To rename an icon, click once on it. When it turns 
black, simply type and the name will change. If the 
name does not change, click once more on the icon; 
sometimes it insists on two single clicks (not a double-click!) 
as a safety feature protecting you from changing the 
name accidentally. Use standard word processing 
procedures to set an insertion point, double-click a 
wMd to select it, backspace to delete, e tc., as detailed 
in Chapter 12 on Typing. 

Undo If you perchance do accidentally change the name of an 
Icon Name · icon (which is very easy to do-files have been known to 

Change · mysteriously change their names to\\\\\\\\\\\\\\\ or------
: while you weren't doing anything but leaning on the 

keyboard), you do have one chance to restore it to its 
original form: Undo. As soon as you see this mistake has 
been made, from the File menu choose "Undo." lfyou 
haven't done anything since this minor catastophe (and 
things could be worse), Undo will restore the original 
name, even if you forgot it. If you are too late to catch 
Undo, you ' II just have to rename it yourself. 

System 7 update: renaming icons, page 112. 



Folders are essentia l to the organization of your work 
on the Mac. They are, of course, visual representations 
of our office and home environmen t, and they function 
in much the same way. 

You can consider your disk to be the main filing cabinet. 
When you store items in a fi ling cabinet, you don'tjust 
toss them in the drawer, do you? Can you imagine what 
a mess your fi ling cabinet would be -v.~thout folders? 
Many Mac in lashes become just as messy and just as 
difficult to find work in. It's very important to learn 
to take advantage of the folders. 

You can create your own new, empty folders by 
choosing "New Folder" from the File menu, or by using 
the keyboard shortcut, Command N. The new folder will 
appear in the active window. 

The new folder shows up in the active window already 
highlighted, or selected (it's black), with the name 
"Empty Folder." Mac assumes you want to change the 
name, so while it is black you can just type the name you 
want it to have and the new name will appear. If you type 
an error, just backspace over it (use the Backspace or 
Delete key in the upper right of the keyboard) and 
continue typing. You can use up to 27 characters, but 
you can't use a colon . 

If you accidently unhighlighted the new folder before 
you changed its name, or if you want to change the name 
of any o ther folder , it is still very easy to do: simply click 
on the folder and it will turn black. You'll notice the 
pointer changes from an arrow to an I-beam when it's 
pointing to the name of the folder; this is a visual clue 
that whatever you type now will replace the title that is 
already there. So go ahead and type the new name while 
the folder's black. 

If typing while the folder is highlighted doesn't change 
its name, click once more on the folder; sometimes it 
insists on two single clicks (not a double-click!) as a safety 
feature pro tecting you from changing the name 
accidentally. 

System 7 update: expanding and compressing (alders, page 109; 
creating o new (older, page I ll. renaming icons, page 112. 
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Putting 
Something 

Inside a Folder 

Opening 
a Folder 

Removing 
Something 

From a Folder 

Note: · 
Moving os · 

opposed to Copying : 

34 

Organizing 
Your Disk 

Using Folders 

To put something inside the folder, press-and-drag any 
icon over to it; when the folder turns black, let go and 
the icon will pop inside. The folder does not have to be 
open to place an item inside of it, and it can be gray. You 
can have folders inside of folders inside of folders, which 
is technically called the Hierarchical File System (HFS). 

Double-clicking on any folder will open it to a window, 
showing you all the valuable information you have 
stored inside. 

To remove something, open the fo lder first, so you see 
its window and the icons in side, as below. Then simply 
press-and-drag the icon(s) out, e ither to the Desktop or 
to a nother Folder or window. 

If you are moving the icon to some place else on the same 
disk, it \Viii just pop out of that one folder and into the 
other. BUT iFyou are moving the item to a different disk, 
the o riginal icon will stay put and a copy of it v.rill be 
placed on the o ther disk. (See the tips on pages 37-38}. 

Below is an example of a well-organized ha rd disk; there 
isn't a bunch of junk lying around making it difficult to 
find things. (Woulrlllwt hmLfes w111·e so easy to il£e/J neat!) It's basically 
organized the same way a filing cabine t would be. 

0 Hard Disk E!l-
14 items 1 7, 776K in disk 1 ,396K available 

LlJ D D D D 
~ 

System Folder Utilities Programs Ft·eelance Fishing 

LJ LJ LJ LJ 
Hypercard 1ntro/Yiork Clip Art Publications 

LJ LJ LJ LJ 
Robin Jimmy Ryan Scarlett 

to 
K:JI 10 121 
Evel)'thing on the disk (I he "filing cabinet') is Itt cited into a folder. 
The folders may each have mb-fold~'l's lo further organize their col!lerLis. 

System 7 update: expondmg ond compressing Folders, pages 109. 



One of the best ways to keep windows tidy is to create a 
specific new folder for a new project before you create . 
the documents for the project, and then save the docurnents . 
right into theirownfoldet: For instance, if you are about to 
create a budget report with seven variations, or a news
le tter in wh ich there will be ten to twelve separate stories, 
then follow these steps: 

At your Desktop, before you open the application 
to start creating the reports, make your new folder 
and name it (le t's name this one Budget News). This 
new foldet· can be inside of another folder, of course. 

: 0 Hard Dislc t!r The new folder in the 
17 itoms 17 ,454K in disk 1 ,718K availabl• hard disk window, 

l1J LJ u ~ waiting for new stories 

~ 
to be stored inside. 

S~ s tom Foldor Utiliti•s Budg•t N•vs 

• Open your appli cation and create the first report. 

• When you go to "Save As ... " and name the story, find 
the folder Budget Ne-ws in th e Save As dialog box. In 
the list box you '11 see the name of the folder you 
created earlie r. Double-click the name to open the 
folder 

I C) Hard Disk I 

FOLDERS ----
Creating ~ 
Project-Specific V 
Folders 

E:l Budget News ~ 
E:J Hard Disk 

In this e;>:ample, 
tere is the folder 

B·udget News; 
tble-clidt on it 

to ojmt it. 

D Fishing 1 550K auailable 

' » D Freelance S<HI(~ 
D HC Course 
D Hypercard I fO (Cancel) 

Saue Current Document as: 

II I 
If you don't see the folder listed here, jJerhaps you 
have it tucked inside of another folder, in which 
case ym1 will need to ojJen that other folder first. 
Or elicit D1ive to see if it is on anotheT disk. 

( [ j(H t 

( Hrit~e 

System 7 update: creating new folders while within on application, page 105. 
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... After you double-click on the nam e of the folde r, you 
will see its name and an o pen folder icon in the label 
above the list box, as shown below. If you choose to 
Save right now, it will be saved into that folder. 

----:-:-----'--H-- -+16l Budget News I 
Make su1·e this title shows · · 

the name of your foUler. Q 
E:=J Hard Disk 

1706K auailable If you see the name of your · 
folder in the list. box · 

beneath it, double-clidl on 
that name to open the 

folder and make it.s name 
ajJpear here. 

Whenever you 
save a file, it is 

always saved into 
whatever folder or 

onto whatever disk 
appears in this title. 
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K Saue J ( 1: j(H t 

10 (Cancel) ( rll'ille 
~--------------~~ 

Saue Current Document as: 

I Budget Story # 11 

... When you go back to your Desktop everything v.rill 
be right where it belongs, tucked in to its own folder, 
and nothing will be forgotte n or misplaced. 

If you ref·use to read and follow these directions and 
have lost files, do read about Mr. Find File on page 83. 
He 'll find them for you. 



COPYING/ _,, 

SELECTING 

Copying files is an everyday task. You may need to copy 
an application from its original disk onto your hard disk; 
copy a report to give to a co-worker; copy a document 
to take to a service bureau for printing; create the ever
necessary backup copy; etc. etc. etc. 

Apple has made it as easy as can possibly be to copy files 
on the Mac (which is why pirating, or copying software 
without paying for it, is such a problem for software 
developers). 

To copy, simply click on the icon representing 
the file you want to copy; then press-and-drag 
the icon to the icon of the disk you want to copy 
it onto. A little message comes up telling you it's 
being copied. That's it. 

You may copy onto a disk, into a folder on another disk, 
or onto your hard drive. In every case, make sure that 
the icon of the place you are copying into turns black. 
When the icon is black, that means it's ready to accept 
the file/s . If the icon is not black, you' ll just be placing it 
next to the icon, not inside of it. The tip of the pointer is 
what turns any icon black. 

Actually, the copying process only takes place if you drag 
the file to another disk. If you want to make a copy of the 
fi le on the sam.e disk, click once on the fi le icon, then from 
the File menu choose "Duplicate" (or press Command D). 
This creates a second version in the same folder named 
"Copy of __ ." When you duplicate or copy folders, 
every item contained within that folder is also copied. 

If you want to put a copy of a fil.e into anotherfolder 
on the sa·me disk, hold down the Option key while 
moving the file . (This does not rename the file 
"Copy of __ .") 

To copy more than one file at a time, sel.ect more than 
one file (detailed in the next paragraph). When more 
than one file is selected, dragging one file will drag them 
all together, either to the trash can, into another folder, 
onto another disk, or simply to clean up the joint. 

CHAPTER TEN 

Why Copy? 

Copying 

' • 

Duplicate/Copy 
File on Same Disk 

,, 
•• 

Copying 
More Than One 
File at a Time 

37 



COPYING/SELECTING 

Selecting 
More Than 

One File 
at a Time 

' • 
You may have noticed in a Desktop window that when 

. you press in an empty space and drag the pointer, a dotted 

. rectangle comes out of the tip-this is the selection 

. marquee, common in many Mac programs. On the 
Desktop, any file· that is even partia lly enclosed in this 
marquee will be selected . ,-----------, 

! LJLJLJ I L __________ _ _j 
The selection marquee- just press-and-dmg ~ 
with the pointer tool. 

Selecting all the icons this way will of course turn them 
all black. 

,. When you press-and-drag on the black area of one 
of the selected items, they will all drag together. 

,. Clicking in any white space wi ll deselect all the files. 

Shift-Clicking : Another method of selecting more than one item is to 
to Select . Shift-click . You may have noticed that once a file is 

More Than · selected, clicking on another fi le deselects the first 
One File · one. But, if you hold down the Shift key while clicking, 

' every one of the fil es you click will be selected. This 
e way you can select several files in different corners of 

your window. 

Shift-Clicking · In the same manner, you can deselect one file at a time. 
to Deselect : For instance , if you group a bunch of files within the 

selection marquee but you don't want the one in the 
middle, simply hold down the Shift key and click once 
on that one-it will be the only one deselected. 

Ill 
iihJ!&&I 

Copy From 
Floppy to Floppy : 

with Only One . 

If you want to know how to copy from one floppy disk 
to another floppy disk when you have only one floppy 
drive, please see page 91 x. 

Floppy Drive . 

38 System 7 updote: cool selection tips, page I I 0 



Or Documents 

The term application is often used synonomously with 
program. It refers to the software package you are using 
to create your documents, such as Claris MacPaint, 
Microsoft Works, Adobe Illustrator, etc. They all do 
something different; they all have a particular function. 
Sometimes it takes a little research to find the software 
applications to meet your specific needs. 

To open an application, or software program, find its 
icon on the disk. Application icons, as noted in the 
chapter on icons, typically look fancier than anything 
else. Whether the program is installed on your hard disk 
or you are using a floppy disk, you will need to find its 
icon at the Desktop. 

From the Desktop, double-dick on the applica
tion icon to open to a blank page, ready for you 
to create a new document. 

Some applications open to a commercial, or at 
least LOan Opt:n dialog box; in t:itht:r cast: you 
can choose to create a new document at that 
point from the File menu. 

To open a document that has already been created and 
saved in an application, find its icon on your Desktop. 

Double-click on a document icon; most of the 
time this will open the application, placing your 
document on the screen as you last saved it. 

A few programs won't allow you to open their documents 
from the Desktop. If the software program itself is in the 
computer, either on the hard disk or on a floppy, and 
you get the dialog box telling you an application can't 
be found, then you must open the application first and then 
open the document from the File menu by choosing 

"Open." See the section on the follmving page for tips on 
maneuvering around the Open dialog box. 

Now, just because you have an icon representing a 
document you created in a certain software application 
doesn't mean you can open up that document just 
anywhere. Double-clicking on a document icon will only 
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open it IF the application itself is also in the computer, either 
on the hard disk or on a fl oppy disk that is inserted into 
one of the drives. If the application isn't there, then 
the document doesn 't have anywhere to put itself! 
(See page 94, "Can't Open a File," for more info.) 

New vs. Open Once the application is up and running, in the File menu 
. you see two choices: New and Open. This confused me 

at first because I thought, "Well, I want to open a new one." 
The difference is this: 

An "Open"· 
Dialog Box · 

Folder names are black 
(not gray) because · 

there may be a file inside · 
that · 

Single-click on 
one of these names to 

select that file. · 

to 

If the icon is a folder, as 

• New creates a clean , blank page on which you 
can begin a new document. 

• Open takes you to a dialog box (shown below) 
where you can choose to ojJen a document that 
has been previously created and saved. 

When the icon in the 
title here is a folder, 
this is a menu, as 
shown to the 1ight. 

This is the specific folder Press to see the 
or disk that contains hierm·clty. Also 

the document. see fmge 52. 

This is the name 
of the dish you're 
looking at. 

c:> Hard Disk 
Freelance 

0 Hypercard ( t j~H t ) 
0 I ntro/Work ( Driue ) 
0 Jimmy 

Newsletter/May ( Open ) 
0 Programs 

Publications [ Cancel ) 

this one is, it will open · 1.!:::=====================~ 
here in this list box to · 

show you the files inside . 
the folder; if the icon is . 

a document, it will . 
open that document . 

on yo111· screen. 
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Click Eiect to eject a disk so you can insert another. 

Click Drive to see what's on the disk in the other drive. 

Clic/1 Open to open the selected fi le; or you can 
double-clicli on the fi le name. 

Clicll Cancel to talw you bach to wherever you were 
without opening anything. 

System 7 updare: dialog boxes, page 105. 



In some applications typing is the main idea, as in a 
word processor. In some, it is the way to input the data 
whose purpose is to be manipulated, as in a database or 
a spreadsheet. In others, it is a sideline that is occasionally . 
necessary, as in a pain t program. And everywhere you find · 
dialog boxes where you type some answer o r o ther , and 
even on your Desktop you type the names of files and 
folders. Fo rtunately, in the consistent Mac environment, 
every program reac ts to typing in the same way. 

You may a lready be familiar with the Macintosh 
word processing 1-beam (pronounced eye-beam): I 
In the Macintosh , the !-beam is a visua l clue that you are 
now in a typing mode, as opposed to having an arrow or 
a cross-hair or any number of other cursors that appear 
in various programs. 

The !-beam is simjJly another pointer. And just like the 
pointer , it doesn' t do anything un til you click it. 

When you move the !-beam pointer to a spot and click, 
i t sets down a flashing insertion point that looks like 
this: I (but it fl ashes) . 

After you click the mouse to set the insertion point, 
then you can move the 1-beam out of the way (using 
the mouse)- the insertion point is what you need to 
begin typing. Wi th the insertion point flashing, anything · 
you type will start at that poin t and move out to the right. 
This is true whether the insertion point is at the beginning 
or the end of a paragraph, in the middle of a word, in a 
field of a dialog box, u nder an icon at your Desktop, or 
anywhere else. (The only time the words will not move to 
the r igh t is if the align ment has been set to align right or 
centered , or if a tab other than left-aligned has been set.) 
At any time you can take the mouse, move the 1-beam 
poin ter somewhere else, click it, and start typing from 
the new insertion point. 

Also from that insertion point, pressing the Backspace 
key (foun d in the u pper right, appropriately renamed 
the Delete key on the newer keyboards) will backspace 
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over and remove any letters in its path. So you can 
backspace/ delete to correct typos as you go, or set the 
insertion point down anywhere e lse in your text and 
backspace/ de le te from there. 

Highlighting Text Highlighting text is a shortcut to backspacing over 
letters to remove them. All through the Mac environ
ment, if you double-click o n a word with the 1-beam, the 
entire word is selected, indicated by the highlighting. 
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This MD! is highlighted. 

If you want to select more than one word, press-and-drag 
over the entire area you wish to highlight. 

Part of thi::; lin : is highlighted. 

What does highlighting do? Well, once a word is high
lighted (selected) , anything you type will entirely replace 
the highlighted text. Or you can now change the font 
(typeface) or style or size of the text using your menu 
commands. Or you can copy o r cut or delete that text. 
Or you can paste some thing in to replace it. In fact, 
you cannot do any of these things unless the text is first 
highlighted. (Each of these procedures is explained in 
this chapter.) 

' To unhighlight, click once anywhere, even in 
• the black space. 

When to Use · Word wrap: In a word processor, you never want to h it 
the Return Key : the Return key at the end of your line, unless it is the end 

' of the paragraph or unless you 1·eally do want the line to 
• end there, as in an address. This is because word proces

sors word wrajJ-the words just wrap themselves around 
onto the next line when they get to the right margin. 

: Why is that? Well ... 

· Hard return: \Nhat happens when you press the Return 
· key is that you insert \Vhat is called a ha1·d return. Then if 
· you were to change your margins, your line would always 
· break a t that hard return, even if there are only two words 

on the line. So,just keep those nimble fingers moving 
along and only hit the Re turn key when you want a new 
paragraph. 



Double-space: Hitting the Return key twice is like 
pushing the carriage return on a typewriter tv.-ice-you 
get a double space between the lines. This is for extra 
space between paragraphs (altho ugh in most word 
processors you can ask for an automatic increase of space 
between paragraphs). If you want the entire document, 
or even just a piece of it, double-spaced-that's different; 
there is always an instant way to change your spacing to 
double-spaced. Check your manual for the method for 
your particular application. 

Removing a Return: The computer sees a Return as just 
another character, which means to remove a Return you 
simply backspace over it, just like to remove an un-wanted 
character. The proble m is, in most programs you can't 
see the Return character. So you must set the insertion 
point just to the left of the first character on the line and 
backspace/delete, like so: 

lset the insertion point at the beginning of the line 
(as shown here) and backspace to remove the empty line 
above this one. Backspace/delete again to wrap the 
sentence bach up to the one above. 

The computer deals with blank spaces just as it deals 
with the characters you can see. Every tab, return, 
spacebar space, etc., is a character to Mac. T his means 
you can select blank spaces, blank lines, blank tabbed 
spaces, or Returns in order to delete them. Select and 
delete them just like you would any other cha1·acter. 

The space between 
these words is highlighted. 

In many applications 
you can also select the blank space 

between the lines to delete it. 

Also, since these blank spaces are characters, you can 
actually ch ange the size of them (font size, that is), as 
well as the leading (space between the lines), the style, 
the paragraph spacing, etc. This comes in handy for 
manipulating space. 

TYPING 

Blank Spaces 
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Centering Text · 

• • 
And a most importan t thing: when you center a word or 
line, Mac takes all those blank spaces into consideration, 
so any spacebar spaces or an y fi rst-line indents or any 
tabs you've inserted will be used to calculate the center 
of the line, making the line not afJpea-r centered . 

I hit the Tab key before I typed 

the first word in this centered line. This line is centered. 
The line appears not to be centered. __ __.;...:..__ ________ This line is also centered 

I selected the tab space 

but it includes a tab. 

The invisible tab character 
that is disrupting the alignment 

must be highlighted 
and removed, like so: 

to delete it. -
..:..:....:.=~------ This line is also centered. 

Then it will be centered just fine: 
---------- This line is also centered. 
After I deleted the invisible space, 
the line centered just fine. 

Changing Fonts · 
(Typefaces) : 

and 
Rule #2 

Throughout the entire Mac environment, to make any 
changes you must follow Rule 4t2: 

Select First, Then Operate 
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For instance, to change to a differen t font, or typeface: 
first select the type you want to change (press-and-drag 
over the word/ s), then choose the font name you want to 
change it into. The font list is found in your menu under 
various labels, depend ing on your program . 

' Notice that the insertion point picks up whatever 
e font and style and size and alignment is directly to 

the left of it. No matter where you set it down, you 
'""ill type in the font, etc., of that character , even 
if that character is an empty space (unless you 
proceed as in the fo llowing paragraph). 

Now, le t's say you know that the next thing you're going 
to type is going to be in a different font. Do you need to 
type it first and then select it and change the font? No. 



Set your insertion point d own whe re you want to type in ' 
the new font. With no text sel.ected, go up to the me nu and e 
choose the font (and style and size, if you like); wh en 
there is no text selected, a ll th e formatting gets pmn"ed into 
the insertion point-whateve r you type next will be in the 
font you just chose. A!; soon as you place the insenion 
point elsewhere, tho ugh, it will again pick up al l the 
formatting of the character to its left. 
Please see Cha pter 18 for more informa tio n on fonts. 

TYPING 

Style is refe rring to whe the r the type is plain, bold, italic, Changing Style 
outline, etc. To cha nge the style of th e type, you need to 
follow Rule #2: se!JJct first, then operate. Select the type you 
want to change (highlight it), the n choose the style you 
want from the menu. You can choose more than o ne of 
these; for instance, you can have a face tha t is bold-italic-
outlined-shadowed type. Yuk. 

To remove all of the style choices at once, simply ' 
select the text and choose Plain or Normal. e 

A!; mentioned in that last section about cha nging fonts, 
you can choose the style you want fro m the menu before 
you typ e it (as long as you don' t move the inser tion poin t 
afte r choosing). But even that's a pain if you just want to 
italicize the next word and the n return to no rmal text. 
This is an easie r meth od: 

Notice the keyboard shortcuts in the style menu? T hey 
are almost always Command B fo r Bold, Command I for 
Italic, etc. (Some progra ms may use Command Shift B 
and Command Shift I, etc.). 

A!; you' re ty ping alo ng , simply press Command B 
and the next word you type will be bold; when 
you want the next word to be not bold, press 
Command B again and it wi ll take of/ the bo ld 
(that's called a toggle switch, whe n choosing 
the same command turns that command off). 
Logically, you can press Command B I to create 
a word that is (guess!) bold i talic. 

Size in type is measured in fJoints. Points, in the Uaditional 
type world outside of pe rsonal comp uters, are each Yn 
of an inch . The Macintosh deve lopers were brillia nt 
in designing the Mac screen so each pixel, o r do t o n t.he 
screen , is Y12 of a n inch-type sizes a re quite t.rue to what 
those who deal with traditional type are accustomed. 

Changing Styles 
Mid-Stream
Without Using 
the Menu 

' • 

Changing 
Type Size 
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In your menu you see diffe ren t numbers referring to the 
size of type; logically, the bigger the number, the bigger 
the type. Again, to change the size : select first, then ojJerate. 
Or set your insertion point down and choose the size 
from the menu before you type (see the last two sections 
on changing fonts and styles). For more information on 
type sizes, see the next chapter on fon ts. 

Alignment · Alignment refers to where the margins are lined up: 
align lefl has the left margin lined up; align right has the 
righ t, obviously; align center has everything ce ntered on 
a vertical axis between you.r margins; justified has both the 
left and right margins lined up. To change your align
men t, you know what to do! That's right: select first, then 
operate-highligh t the text, then choose the alignment. 

A note when cen tering: If you have a first-line indent 
or tabs in the text that is to be centered , o r if you have 
inserted blank spaces eithe r before or afte r the text, then 
those spaces are taken into consideration when centering 
(see page 44). Also, alignment affects the entire paragraph; 
it is not possible to make one line align left and another 
align right in the same paragraph. There must be a hard 
Return separating the lines. 

Cut, Copy,. Almost anywhere you can type, you can cu t or copy text. 
and the · Wh en you cut text, it is removed from yo ur d ocument 

Clipboard and placed on the Clipboard. When you copy text, the 
· original is lefl on your document and a copy of it is placed 
: on the Clipboard. Well , what the heck is the Clipboard? 

· The Clipboard: The Clipboard is a li ttle "container" 
· somewhere in the depths of the Mac. In some programs 
: you can ask to Show the Clipboard, in which case it appears 

as a window with its contents displayed. In most programs, 
though, you never see it; you just must trust that it's 
the re. (If you have the Clipboard system icon in your 
System Fo lder , then it's there in every applicatio n.) 

· The Clipboard holds whateve r you have cut or copied , be 
it text, spreadsheet data, graphics, etc. Once something 

· is on the Clipboard, it wai ts there until you paste it in 
: somewhere (you 'll get to tha t in the next paragraph) . 
. The most important thing to remember about the 
. Clipboard is that it holds only one thing at a time; tha t is, 



as soon as you cut or copy some thing e lse, whatever was 
in the Clipboard to begin with is replaced with the new 
selection. 

~0~ Clipboard ~0~ 

The Clipboard ~ 
holds only one item 

The ClifJbonrd 
aptJenrs as a 
window (if it's 

~ availablefor 

~D~~illffiiTilllillf~illillt~~IQ~ looliing nt) 

at a time. 

/91 10 '21 

Items wi ll stay on the Clipboard even when you change 
applications; you can put something on the Clipboard 
in a paint program, then open up a word processing 
program and paste it into a new document. Items will 
leave the Cli pboard a ll by themselves if the computer is 
turned off o r if there is a powe r fai lure; the contents are 
stored in RAM, so anytime RAM gets ·wiped out, so do 
the contents of the Clipboard. (RAM info o n page 51). 

How to Cut: Simply select, then operate; that is, select Cut 
the text you wish to remove from the document (press
and-drag over it). Then from the Edit menu choose 
"Cut. " The text v.rill be eliminated from your document 
and placed 0 11 the Clipboard. (Be su re to read "Delete" 
further on in th is section.) 

How to Copy: Simply select, then operate; that is, select Copy 
the text you wish to copy (press-and-drag over it}, then 
from the Edit menu choose "Copy." The text will 7rtmain in 
your document and a cojry v.~ ll be placed on the Clipboard. 

OK-it's on the Clipboard. Now what? Well, the Clipboard Paste 
holds objects for pasting. You can take text or graphics 
out of one place and paste it into your document some-
where else, just as if you had a little glue pot. 

How to Paste Set the insertion point whe re you want 
the Clipboard item to appear; from the Edit menu choose 

"Paste." In most programs, whatever was on the Clipboard 
will be inserted in your d ocument beginning at theflashing 
insertion point. You can also select a range of text; tl1e pasted 
item will replace what was selected . Spreadshee t data, 
graphics, etc., all can be pasted in also. In some programs, 
the pasted object will just land in the middle of the page. 

As long as something is on the Clipboard, you can paste 
it in a million times. 

14 M ggu e 'UHNiffiA + 
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Backspace/ 
Delete 

or Clear 
and the 

Clipboard 

Now, Backspace or Delete is a little different: if you 
hit this key (upper right of keyboard) while something 
is se lected, whatever is selected is deleted and is not placed 
on the Clipboard. This mean s it won't replace what you 
have on the Clipboard, if you are saving something there 
to paste in again, but it also means that you don ' t have 
it anymore-it is really gone. Clear, sometimes found in 
the Edit menu, does th e same thing. 

Undo · Undo can some times save your boompah (no, that's not 
. compute r j argon-it's Grandma's euphemism). When 
. you do something that makes you scream, '1\ackl Oh no! " 

then try Undo. It's always the first command in the Edit 
menu (or press Command Z). 

' What Undo can undo is only the last action that 
• occurred. For instance, if you selected two paragraphs 

of brilliantly witty text that you spent three hours 
composing and just then the cat walked across 
your keyboard and obliterated the entire work, 
Undo could give it back to you IF you asked to 
Undo before you touched anything. If you start 
fiddling around with the keys and the mouse, then 
what you will undo is that fiddling around. So if 
something goes wrong, don ' t scream-UNDO. 
Then scream if necessary. 

Command Z XCV · Thoughtfully, the Mac designers have made the keyboard 
· shortcuts for the cut/copy/ paste/ undo commands ve ry 
: handy. Notice on your keyboard the le tters Z , X , C, and 
. V, all in a row right near the Command key. 
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"'Command Z will Undo (the closest to th e 3€ key). 

"'Command X will Cut (X like eXiting or Xing it out). 
• Command C will Copy (C for Copy, easy mnemonic). 
• Command V will Paste (V because it is next to C). 

It's nice to get familiar with these. Remember, select first 
(except to Undo) ; then hold down the Command key and 
lightly tap the other le tter. 

Accessing · Special characters are the symbols you have access to 
Special · on the Macintosh tha t aren 't available on a typewriter, 

Characters · such as upside-down question marks for Spanish (~ ), the 
pound symbol for English money (£), the cents sign ( ¢), 
the registra tion or trademark symbols (® TM) , etc. You 



can view all lhcse with your Key Caps desk accessory. 
(If you aren't sure what Key Caps is, please read page 84.) 

To get special characters into your document, fo llow 
lhese steps: 

"\Vhile working in your docume nt, pull down the 
desk accessory Key Caps from the Apple menu 
(far left; press on the apple). 

"From the Key Caps menu (a new item that appears 
in your menu bar!) choose the font you wish to view. 

"Find the character you want b)' pressing Shift or 
Option or Shift-Option together; press the character 
key; notice what combination of keystrokes produces 
the character you want. For instance, Shift Optio n ... 
(ti lde key) in the font Geneva will produce a bunny 
rabbit: ~ 

"So remembttrthat keystroke combination; close Key 
Caps to get back to your document (remember, 
you can access desk accessories in any program). 

"In your document, click to set your insertion point. 
Choose the fo nt Geneva and the size 12 point; press 
Shift Option ... . The bunny wi ll appear! 

Another way to accomplish this is to press Shift Optio n ... 
in whatever font you are currently using; some strange 
character will appear. Se lect th e strange character and 
change it into Geneva 12 point; it will turn into a bunny. 

You can also select and copy the cha racter showing in 
the Key Caps e nu-y bar- select as you would any text, 
and copy from the Edit menu . Back at your docume nt, 
se t the insertion point and paste it in. Unfortunately, 
if your document text is anoth er fo n t, the Key Caps 
characters wi ll pick up that font. You will still have to 
select the new characters and change them in to the font 
that held those characters you wanted. It seems easier 
just to do it the oth er way. 

Remember, the insertio n point picks up the 
Jonnatting of any character immediately to its Left, even 
if it's a blank space, so anything else you type will 
be in lhat character 's fo nt, style, etc. To continue 
in your originalfont, leave your insertion point 
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Using Key Caps 

Some special characters 
and the lleys lo 

access them: 

• Oplion 8 
© Oplion g 

"'"" Oplion 2 
® Oplion r 
¢ Oplion $ 

Option Shih 8 
Option ; 

Oplion hyphen 

Oplion Shih hyphen 

.fusl For Fun- using 
Shift OjJtion Tilde ( -) 

¥ New York g pt. 

"'- NewYork ! Opt. 

t New York 12 pt. 

JJ New York 14 pt. 

· 0 Geneva 9 pt . 

~ Geneva I 0 pt. 

~ Geneva 1 2 pt. 

- Monoco 9 pt. 

0 Mono co 1'1 pt . .. ~ 

•.: Hthens 11 pt . 

A terrible thiug has lwfJ/Je>IPd: 
System 7 emtliaJtl'd tlust 
characterJ! Wh at has tl pfJlr 
come to~~'! 

' • 
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so 

Using 
Accent Marks 

! 
A list of common 

II 

accent marks: 

Option e 

Option -

Option u 

Option n 

O ption i 

One Space 
After Periods 

A Commercial 

right where it is; from the menu just choose the 
font specifications you were originally using. 

Included in your special characters are accent marks, 
such as those in resume and pinata. You can find them 
in Key Caps, but it's easy to remember that they're 
accessed using the Option key and are hiding beneath 
the characters on the keyboard that would usually be 
under them; e.g., the accent acute over thee is Option-e; 
the ti lde over the n is Option-n. 

To type accent marks in your document, follow these 
steps (using the word resume ): 

... Type the word until you come to the letter tha t will 
be under the accent mark; e.g., r 

... Before you type that letter (the le tter e in this case), 
type the Option combination (Option e in this case) 
-it will look like nothing happened . 

... Now type the character that is to be under the accent 
mark, and both the mark and the le tter will appear 
together; e .g., r e 5 u m e 

... That's easy, huh! 

What?! One space after a period? If you grew up on 
a typewriter , this is not an easy habit to change. But 
characters on a Macintosh are not nwnospaced as they 
are on a typewriter (except for Monaco and Courier), 
so there is no longer the need to use two spaces to 
separate two sentences. Take a look at the font Courier 
o n page 72; notice the spacing of its le tters as opposed 
to the Times font above it. You can see why a font like 
that needs two spaces after periods. Check any book or 
magazine on your shelf; you will never find two spaces 
afte r periods (except books produced on a computer 
typed by someone still using t)•pe,vrite r rules). 

if you are typing on a Macintosh, you must face the fact that 
it is not a typewriter and that some of the standard conventions 
developed particularly for that wonderful little apjJliance do not 
afJfJly to the kind of tyjJe you rm now creating. A very important 
booh to read is The Mac is not a typewrite r. It 's srnall, 
its cheap, it's easy to read, and, it's true. Well, yes, I did. 
write it myself 



Saving is the process of transferr ing your document 
from the temporary memory bank where it is initially 
stored , over to th e floppy disk or hard disk where it 
becomes permane nt It is extremely important to save 
your document as soon as you begin working o r it, and 
to continue to update the save every few minutes. 

Until you ac tually go through the process of naming a 
docume nt and saving it, th e document is stored in RAM, 
which is Random Access Memory. RAI\11 is sort of like 
your desk, as opposed to a disk which is like you r filing 
cabine t where you keep all your fo lders of information. 
When you are working on a proj ect, you don ' t keep 
running to the filing cabinet every time you need a little 
piece of information , d o you? No, you take out all the 
applicable info and put it on yom desk, tl1e n whe n you're 
finished you put it a ll away again and take o ut some thing 
else. RA:\1 is sort of like that: whe n you open an appl ica
tion the co mputer puts a copy of that application into 
RAM . When you close that appl ication and open another 
one, Mac puts the first one back where it came from a nd 
puts tl1e new application into RA:\-1. That way the computer 
doesn't have to keep going into the filing cabine t to d o 
its work and it can o perate much mo re e fficie ntly. 

\-\'hen you create a docume nt, it sits in RAM, too, until 
you p ut it in the filing cabinet-your disk. Yo u put it on 
your disk by saving it. Once it's on your disk, eitl1er hard 
or floppy, it wi ll stay there until you trash it yourself. 

While your document is in RAM, tho ugh , it is in danger. 
At any mome n t, if there is a power fai lure, even for a 
split second, or you accide ntally hit the wrong button, or 
you have a system crash, or the screen freezes, or a virus 
attacks, or· any o the r catastrophe of considerable dimen
sion happens to befall , the n ever)'thing in RAM (what is 
commonly call ed uwmOI)') is gone. just plain gon e. No 
way on earth for a mortal person to get it back. 

The preven tio n? 505: Save Often, Stupid. We ll , that's a 
little harsh-how about Save O ften, Sweetie. Save Save 
Save. Every few minutes, when you're just sitting there 
thinking about your next marvelous move, Save. In most 
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Save Often! 
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programs it's as easy as pressing CommandS. Then 
if there is a catastrophe, you will have lost only the last 
few minutes of your work. 

Save As... To save a document for the first time, it must be given a 
vs. Save name. Under the File menu are the commands Save As ... 

and Save. At first the subtle difference can be confusing. 

Save As... Save As ... is the command you must use first in order 

This is a list of all the 
folders and documents in · 

the folder or disk named : 

to give the document a name, as a document cannot be 
saved without a name. "Save As .. . " gives you a dialog box 
such as the one shown be low (they're slightly different 
from program to program) . 

' • This shows which 
folder yau are saving 
your document into. 

Notice the 
folder icon. 

Unless the iwn on this title is a disk, 
jJre.ssing here with the mouse shows a 
mini-menu listing the folders and the 
disk a file is ne.sted into. Select another 
folderjust as you use your menu. 

above. Folder names are fF======;=t==:F:=:!==:=:=;:=======,j 
black because you can 

d()Ub/e-clidt to open them 0 Chapt 
a~n~d~st~o~~e~~~~J~·n~s~id~e~. ~~-t 
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This is where you 
name the document. . 

Once you name the 
document, the Save 

bul.lon tum s black 
and you can clidt it . . 

Saue document as 

Cancel 

This indicates 
onto which disk 
)'Olt are saving 
the document. 

=Hard Disk II 
1: j(H t ] '---'-----' if a floppy disk 

,...-----.. is disfJlayed, 
'-----1--' you can then 

@ SuperPaint 

StartupScreen 

0 MacPaint 
eject that disk 
/o switch /o 
another before 
saving anto it. 

QPICT 

Many programs allow you to 
JOUr document in one of 

di.Jfermt formals. Click 
one before J OU click Save. 

If you want 
to save to a 
diHerent disk, 
other than the 
one whose 
name appears, 

elicit Drive to disfJlay any disks that may be in the 
other d1ive slots. The name and icon will apfJem· in 
the dialog box, as well as at the tojJ of the scroll box. 

System 7 update. dialog boxes, page 105. 



Save is the command to use after you have named th e 
document and you wan t to save the new cha nges onto 
that same docume nt. Save just goes a head and does it
you won ' t see o r hea r anything. You must just trust. 

There is no keyboard shortcut listed in the 
menu lo r "Save as .... '' But if you have no t yet 
give n the document a name , then choosing 
Save (Co mmand S) wi ll g ive yo u the Save As .. . 
dialog box beca use the fil e must have a name. 
Some progra ms will not eve n allow the name 

"Un titled." 

If you want to create changes in a document, but want 
to keep a copy of th e o riginal without. the cha nges, the n 
use Save As . . . a second time to give the document a new 
name. This pu ts Lhe original docume n t safely away on 
your disk a nd o pe ns a new one (the copy) right where 
you are. You'll notice the name in the window ti tle ba r 
of your document will change to what you re named it. 
Any changes you make to this document wi ll no t affect 
the original. 

Also, if you made a bunch of ch anges you don ' t want, 
simply close the document and dun 't. save the changes. 
Reope n it and eve rything wi ll be exactly th e way it was 
las t time you saved . 

Occasio nally a program will have the option to Revert in 
the File men u; choosing this will take you back to the last 
time you saved , witho ut having to close the docume nt. 

SAVING 

Save 

Making 
Several Versions 

Reverting to the 
Last-Saved 

. Version 

! 
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CHAPTER FouRTEEN 

Printing is the process of copying your data that is inside Printing 
the Macintosh onto a piece or pape r. This piece of 
paper, then , in computer jargo n , is called "hard copy." 

There arc basically two types of printers: QuickDraw Printers 
printers and PostScript printers, 

is a computer programming language Lhat QuickDrow printers 
your Macintosh reads. It creates what you see on the screen. 
A QuickDraw printer can on ly reproduce what is o n the 
screen. The ImageWriter, the HP DeskWr;ter, and the 
Apple Style Writer are all examples of QuickDraw printers, 
with resolutions ranging from 75 1.0 400 dots per inch (the 
hig he r the resolution, the smoother the printed image). 

PostScript is a programming language that a PostSaipt PostScript printers 
printer reads. A PostScr;pt printer doesn't care what the 
heck you have on your screen. If the font or the graphic 
image is created with PostScript, it can look dreadful on 
the screen but wi ll print beautifully on the page. See the 
example on page 63. 

The re are also very expensive (like $80,000), very high
end PostScript printers with resolutions of around I 000-
2000 dots per inch , such as the Linotronic, These printers 
output on to fi lm, not paper, a nd the hard copy looks 
virtually like t.raditional typesetting, limited only by the 
professional expe rtise o f the person who input the type. 
This book was output on a Lin otron ic. 

Since the high resolutio n machines are so expensive, you 
only find them in a seiVire bu.reau.-a shop where they offer 
the output as a service. You take the disk con taining your 
document to the m, leave it there, and they print it up for 
you. It can cost from $5 to $ 10 a page, but it 's beautiful. 

Prin ting to your personal printer is very simple . Your 
applicatio n may g ive you different print dialog boxes 
depending on which prin ter you are conn ected to, and 
the dialog boxes with in different applications may look 
slightly d ifferen t, but basically all you need to do is 
answer the questions they ask. 

Preparing 
to Print 
You might want to read 
ChajJter I 8 on Fonts 
befm·e you print your 
dowment. 

ss 



PRINTING 

The first th ing you want to do is to Save again- as a 
preventive measure always save just before you print (one 
never kn ows when the documen t-eating gremlins are 
lurking about). Also, make sure the printer is turned on 
(the Image Writer must have its "Select" button on as well) . 

Chooser The very first time you print on your machine, or if you 
are hooked up to more than o ne printer , or if you go 

10 Chooser 

.l.,,;!w 
Select a pnnter port 

somewhere else and print, or if you fi nd 
you are having d iffi culty printing, you 
need to go to Chooser to direct the 
computer to the printe r. I 

~ ~ • 
User uame: 

Chooser is a desk accessory that is found 
under the Apple at the top left of your 
menu (also see page 81 for more info JRobln I 

Iii AppleTolk 
@>Actl ~o~e 
0 Inactive on the Chooser). For eve ry printer icon 

in your System Folder , the re will be a 

lf0l 
~ 

hnageWriter 
icon 

<2.] 
,::I 

Laser Writer 
icon 

Printer port icons. 
The cable to your 

QttickDraw printer i.~ · 
plugged into one of these : 

( chedt the little pictures . 
on the jJlugs on the bacll 

of your Mac) . 

3.3 1 

matching icon in your Chooser; even if you have a printer 
hooked-up right next to you, you wo n ' t be able to p rint 
to it unless its icon is in your System Folder. 

On the left side of the Chooser window you will see those 
printer icons; click on the one representing the machine 
you want to print to . On the right side sho uld be a port 
icon (asking which port, or p lug, the cable connected to 
the printer is plugged into) or the name of all printers 
that are connected to your Mac and turned on; click on 
the one you want to use. Make sure the network button 
(here it is AppleTalk) on the botto m is on if you are on a 
network (which you would be if more than one computer 
is going to the same printer) and oiT if you are not. T he 
LaserWrite r a lso requires that AppleT alk be Active. Then 

· j ust close the \\~ndow (click its close box) and proceed . 
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Print 
Dialog Boxes 

Afte r yo ur document is saved (and the printer is desig
nated th rough Chooser, if necessary),just go up to the 
File menu and choose "Print . . .. " Depending o n your 
app lication, you' ll get some sort of dialog box asking you 
questions. Most of them are self-explana tory; tJ1e follow
ing items are some terms tha t may not be so obvious: 

Quality: Draft quality on t11e lmageW1iter prints very 
quickly, but eliminates any graphics you may have 
had and p roduces really awful stuff; you can generally 
ignore this option unless you' re in an extreme hurry 
and don't care at all what it looks like. 



You can adjust the draft qua li ty with the button on 
the ImageWriter itself. If you turn off the Select light, 
you can push the Print Quali ty button to one of the 
three levels shown. You' ll get three levels of terrible 
type, from a·wful to worse. 

Orientation: Your application may use another term 
for it, but what the Mac wams to know is if it should 
print upside right or sideways (8.5 x II or 11 x 8.5); 
also known as Tall or vVide, Por trait or Landscape . 

Pages: All or From_ to_: You can choose to prin t 
all the pages contained in your document, or just 
pages 3 thro ugh 12 (or whatever your cho ice is, o f 
course). Choosing All \viii override any numbers in 
the From/To boxes. 

50% Reduction: This will prim your work at half 
size. Remember, half of an 8.5 x 11 is 4.25 x 5.5 -you 
must halve both directions. On paper, this looks like 
the image is !1.! the original size; it isn't-it's ha lf of 
both the ho rizontal and the vertical. 

Tall Adjusted: The Macintosh screen has a resolu
tion of72 dots per inch; the JmageWrite r prin ts at 
75 dots per inch. Thus the Image Writer tends to 
print large circles, such as pie charts, in oval shapes; 
choosing Tall Adjusted will fix that. It will a lso make 
the letterspacing more closely resem ble laser printer 
spacing; if you 're using the ImageWriter as draft 
copies for eventual productio n on a laser printe r, 
this will he lp you judge the work a little better. And 
it looks nicer. 

Computer Paper: This does not refer to pinfed Jmper! 
Computer paper is 11 x 13 inches. Pin-fed pape r is 
8.5 x 11 (le tte r-size, just a ll strung togeth er). 

V\'hen you click the last OK button, the messages wi ll 
be sent to the printer and your brillian t document shall 
come rolling along in a short moment. 

Most laser printe rs spew forth a sample page every time 
you turn them on, useful for checking the toner level 
and quality, as well as letting you know how many pages 
have been printed since you bought the printer . If you 
don't want to waste paper or ton er on this page everyday, 
simply pull the paper tray partially o ut before you turn it 
on . After a minute or two, push it back in. 

PRINTING 

The shaded portion is 
50% of the larger size
half of both the width 
a11d the lmgth. 

Save Laser Printer 
Toner & Paper 

' • 
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PRINTING 
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Align · Most applications let you determine how far down from 
lmageWriter : the top of the page you want the document to begin. 

Pin-Fed Paper . Unfortunately, the ImagevVriter doesn' t know where the 
perforation of the pin-fed paper is; it just assumes the 
paper is aligned at the top of the pprinter and adjusts 
itself according to your specifications. In order to keep 
the printing consistent, so your documents always begin 
where you expect and line breaks will occur at perfora
tions rather than in the middle of documents, do this: 

1. Turn the printe r on. 

2. Make sure t.he Select light is off. 
3. Press the line feed button until the perforation 

is just at the top of the printe r head (if you h old 
the button down, a fter four lines it will form
feed unti l you let go). 

4. Print your work (take no tice if you need to 
arrange that first adjustment higher or lower; 
that is, above or below the printer head). 

5. When your work is finished printing, don't 
ever roll the paper forward manually in 
order to get to the perf to tear it off! That's 
exactly what causes the problem because 
then the paper isn't lined up any more. 

6. Instead , turn th e Select button off. 

7. Press the form-feed button; this will roll o ne 
e n tire sheet out of the pnnte r, leaving the 
perforation lined up exactly how you just set 
it in ste p #3. 

8. Turn the Select light back on now so you 
don 't forge t, since you cannot print with 
the Select light off. 

9. Now you can tear off your page, leaving one 
lull sheet hanging ou t of the printe r. 

Obviously, this is going to waste one page of paper pe r 
document. But it actually wastes less than if your document 
printed r ight over the perforation marks and you had to 
reprint the whole thing! Another good aspect of doing it 
this way is that with that whole sheet ha nging out of the 
printer, the paper doesn't get curled around the roller and 
roll back inside itself when you try to print. You can always 
save th e extra sheets for your kids, for scratch paper, or 
have the local copy shop make pads for you. 



CLOSING/ 
QuiTTING 

'When you are finish ed working on a document, you can 
choose to close that particular document in order to 
create a brand new one to work on, or to open one that 
has already been created. Either way, you are just closing 
the document and remaining within the ajJjJlication (the 
software program). You still see the menu belonging to the 
application, even though the rest of your screen may 
look gray, just like your Desktop. 

If you don 't see "Special" in your menu, or if the 
trash can is not there, you have not quit-you 
have just closed, but not quit. 

r a File Edit Uiew Special 
If you don't see this menu, ymt are nol at your Desktop. 

To really get back to your Desktop, whe re the menu 
items are File Edit View Special, you need to quit the 
application. This is always done from the File menu, 
the very last ite m. In most programs you can use the 
keyboard command: Command Q. 

If you haven't saved all your changes, Mac will politely 
ask if you want to save them at th is point, whether you 
are closing or quitting. Thank goodness. 

Saue changes to "Article" 
before quitting? 

n Yes n 
[ No ] Cancel 

If you click Yes and you haven' t yet even saved the 
document with a name, you'll get the Save As ... dialog 
box (page 52) to name it before quitting, because 
nothing can be saved without a name. Click the No 
button if you decide at this point you don 't want the 

CHAPTER F1mEN 

·Closing 
·A Document 

QuiHing an 
Application 



(LOSING/ Q UiniNG 

' • 
changes (or the document, if you've never na med it). 
Click Cancel to re turn to your docu ment without saving 
any changes. 

If you ho ld down the Option key while choosing 
"Quit," and heejJ lwlding it down, whe n you arrive at 
your Desktop all the windows will be closed! 

ShuHing Down : See page 63 about Shutting Down, if you are a ll done 
for the day. 
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EJECTING 
DISKS 

There are actually many ways to ej ect a disk, some of 
which are preferable to others. Le t's start at the Desktop. 

If you are done for the day and are planning to shut 
down the who le system, then close up all your windows 
(Command Option VV for System version 5.0 or highe r; 
make sure Caps Lock is no t down). From the Special 
me nu choose "Shut Down." This will ej ect any floppy 
disks and reassuringly notifY you that it is now safe to 
turn off the computer. 

Even if you're not ready to shut dov.rn , you may sometimes 
need to eject a fl oppy disk in order to trade it with another, 
or simply to take your disk and go away. Beginners usually 
go through the routine of selecting the disk (by clicking 
once on it) and choosing "Eject" from the File menu 
(or using the keyboard shortcut Command E). T his will 
certainly work, but it is actually not the best me thod. 

You may have no ticed when you ej ect a disk by using the 
menu that a gray version of the icon stays on the screen. 
Tha t's because the memory of this disk is still in RAM 
(see page 51). If someone e lse comes alo ng to use this 
machine while the icon is still showing , when they inser t 
the ir disk the Mac will very often spit it out and ask for 
the one that just left. T hat 's not a problem if the disk is 
sitting right there, but if Mary took that disk and left for 
a meeting in Chicago, then the only thing you can do, 
absolute ly your only optio n, is to turn off the compute r. 
While that dialog box is showing "Please insert the disk 
"Mary"," you are stuck. Mac will accept no substitutes. 
If you see a gray disk icon on your screen, you can try 
sticking it in the trash, but often times even then you ' ll 
get that dialog box. Occasionally pressing Command 
Pe riod wi ll satisf)' Mac, but not often . 

To avoid this problem , while at your Desktop it is 
actually preferable to eject your disk through the trash. 

CHAPTER SIXTEEN 

Eiecting 

Shutting Down 
Also see page 63. 

. From the Menu 
· or the V 

Keyboard 
· Shortcut 

Gray disk icon left on the 
screen after being ejected. 

· Through 
·the Trash 

Aack, you say! Yes, tha t's a frightening thought, but calm ' 
down; it 's quite all r igh t. T he tmsh can doesn't erase anything · • 
of!younlish. If you simp ly press on the d isk icon , drag it 
down to the trash and put it in , your disk will safely pop 

System 7 update: keybo01d shortcut to eject floppy disks, page 108. 61 



EJECTING DISKS 

Through 
Dialog Boxes 

More Keyboard 
Shortcuts 

The Mouse Trick 
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' • 
The PaperClip 

Trick 

! 

out and leave no gray icon on the screen. The computer 
now has no recollection of the existence of that disk and 
you can merrily be on your way a nd no o ne will be mad 
at you for leaving yourse lf behind. This is especially 
important if more than one pe rson uses the computer, as 
in an office or in a classroom. 

To eject a disk using the menu and leave no gray icon 
behind , press Command Option E, or hold the Option 
key down as you choose "Ej ect" from the menu. 

Some dialog boxes give you an option to ej ect a disk 
while in an application: "Save As ... "; "Open" in the Fon t/ 
DA !vi over; and "Open" iu any application, to name a few. 
When you want to ej ect a disk while working, just choose 
something like "Save As ... " even though you don 't really 
want to rename it; choose the disk you want to <:iect and 
click the ~ject button (if you don't see the name of the 
disk, click Drive to find it in the o the r drive slot). Then 
click the Cancel button to get back to your document. 

After ej ecting a disk in this way, you can of course insert 
a new disk if you like. If some thing from the ej ected disk 
is still open on th e screen, though, Mac will ask for the 
ej ected disk again so she can put it away. 

,.. To ej ect a disk from the inte rnal drive at any time, 
in any application , press Com mand Shift 1 (one). 

,.. To ej ect a disk from the exte rnal drive at any time, 
press Command Shift 2. 

,.. For a Mac with two internal drives and an external: 
Command Shift l ej ects th e bottom inte rnal drive; 
Command Shift 2 ej ects the top in ternal drive; 
Command Shift 0 (zero) ejects the external drive. 

If for some reason, pe rhaps because of a power outage or 
a system e rror, wh en you turn o fT the computer your disk 
is still inside, do this: 

H o ld down the mouse button; keejJ holding it down 
and turn the computer back on ; yo ur disk(s) should 
pop o ut like toast. 

If all else fa ils, no tice that tiny hole next to the drive slot? 
That's paperclip size. Unbend a paperclip and push it in. 
It's pretty safe , as all you're doing is re leasing the mech
anism tha t holds the disk in place-push firmly. 

System 7 updole: keyboard shortcut to eiecl floppy disks. page 108. 



SHuniNG 
DowN 

Shutting down is the process of the compute r tying up 
all the loose ends inside itself and parking the hard disk 
before it's turned off. You can turn it off wi thout shutting 
down , but it's n ot recommended . 

When you' re done with the Macintosh, it's good house· 
keeping to close up all your windows on th e Desktop.* 
If you have System 6.0 or above you can press Command 
Option W and all the v.rindows will fly away home (make 
sure the Caps Lock key is not d own ). If you have an 
earlier System versio n , th en hold down the Option key 
while you close the active window; all the rest will fo llow. 

Once all the windows are closed, from the Specia l menu 
choose "Shut Down." All your disks will pop o u t and 
you'll get a reassuring dialog box telling you that you 
can now turn off your compute r safe ly. 

Turn it off with the same button you lllrned it on, and 
away you go! On any of the Mac lis, "Shut Down " will 
also automatically turn off the compute r. 

*Alternate scenario: If you have a hard disk, then you 
probably need to open the hard disk window every time 
you turn on the computer. You can just leave that window 
open when you shut down and the nex t time you turn 
your Mac on, tha t window will be open and waiting for you . 

In fact, some people like to leave of1.en-used applications 
or documents r ight out o n the Desktop where they are 
easy to reach, instead of in a window. just drag the icon (s) 
ou t of their windows and make a neat little stack of the m 
off to the side somewhere, or a long the bouom of th e 
screen. They v.rill stay there even after you shut down. 
Keep in mind that some appli cations won 't open if they 
can't find certain supple mental information tha t is ke pt 
in th e origin al fo lde r. If you can't open the applicati on 
from the Desktop, put it back in its fo lde r and wait until 
you get System 7 (see Aliases in Chapter 28, page 127). 

CHAPTER SEVENTEEN 

Shutting Down 

Good 
Housekeeping 
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In the Mac environment, the term fonts refers to the 
typefaces available. Technically, that's not exactly what 
it means traditionally, but we' ll let it pass rather than 
confuse the issue. 

Certain fonts a re standard with the System that comes 
with your Macintosh: 

Geneva Helvetica 
New York Times 
Monoco 
Chicago 
Ve.nice. 

Courier 
Symbol (Greek & other characters) 

The list is separated into two columns intentionally
do you notice anything funny about them? No? Well, 
it's this: one list is all city names; the other is not. Big 
deal, you say. 

Actually, it is a big deal. The Mac prints to basically three 
sorts of printers: Qp,ichDmw printers like tl1e Image Writer, 
;vith a lower resolution of about 75 dots per inch, or the 
HP Deskjet or the Apple StyleWriter, with resolutions 
of 300 to 400 dots per inch; PostScript laser printers, with 
resolutions of 300 to 600 dots per inch; and PostScript 
imageseUers such as the Linotronic, with very high resolu
tions of around 2000 dots per inch. The higher the resolu
tion, the clearer and sharper the printed letters looh. 'What you 
are reading right now is from a Linotronic. 

Macintosh fonts are either !JitmafJped, designed for the low 
resolution of the computer screen and for printers like the 
ImageWriter; or outline, designed for high resolution like 
the LaserWrite r or Linotronic. The city names clue you 
to which font works best with which type of printer. 

The typefaces Helvetica and Times are very popular, 
standard typefaces in traditional type, which the Mac 
is emulating. Courier is monospaced and shaped like a 
typical typewriter font. These three, plus Greek Symbols, 
are installed in the Macintosh system, as well as in most 
laser printers (printers with the higher resolution of 300 
dots per inch. They look very nice when printed on the 
LaserWriter or any of the high-end printers. 

Fonts 

. Interesting Font 
· Information 

Prinrers: QuiclcDraw 
and PostScript 

Note: if you want a little 
more in-depth explanation 
of Q:.tickDraw printers 
and PostScript printers, 
see page 155 in 
Chapter 32 on jargon. 

Traditional Typefaces 
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fONTS 

Name Associations Now, what city do you associate with The T imes? 
New York, you say? (Actually, Times was invented for 
T he London Times, but we' re in America, so ... ) How 
right you are! New York is the bitmapped, QuichDraw version 
of Times. Times has been redesigned in to New York to 
look as clean as possible for the lower resolution of 
the Macintosh screen (72 dots per inch) and for the 
ImageWriter prin ter (approximate ly 75 dots per inch). 

This' ll stump you-what country is the typeface Helvetica 
named after? Wrong again, dear- Confederalio Helvetia 
is what Switzerland calls herself. Do you see a font wi th a 
city-name associated with Switzerland? Of course: Geneva. 
Geneva is the bitmapt1ed, Quid/Draw version of Helvetica. 

The bitmapped version of Courier (which looks like 
a typewriter and why anyone would want to use a laser 
prin ter to make their work look like a typewriter is a 
mystery to me) is Monaco. 

Other Installed Fonts Other PostScrifJl fonts are a lso installed into the Apple 
LaserWrileritself and into many other PostScript printers, 
so if you have bought them and they are installed in your 
System you can use them wi thout any trouble . 
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Palatino 

Avant Garde 
Z apf CfiancenJ 

Boolanan 
New Century Schoolbook 
Zapf Dingba ts: A • ~-. ~ 

(Zapf Chancery, by the way, was designed by a German , 
Hermann Zap f, but modeled on an old Italian calligra
phy. Its Image Writer versio n is Venice, an Italian ci ty. 
Zapf Dingbats: dingbats is a technical printers/typographers' 
term referring to those little tiny pictures.) 

The fonts tha t don 't co me with your System are things 
you have to buy; they are often called downloadable f onts. 
They come on a disk and must be installed into your 
System with the Font/ DA Mover. Apple provides a Font/ 
DA Mover on one of the disks that arrived with your Mac 
(see Chapter 19 to learn how to work with the Mover). 

Important : That's a lot of very interesting trivia, you say, but so what? 
Information Well, the important thing to remember about a ll this is 

the cardinal rule: 



fONTS 
. litci&ZCS£ 

Never use a typ petf5ac~ wt it~ a city name ~ 
on a os cr1p prmter. 'r.f 

What happens is the LaserWri ter, or any other PostScript · Why Not? 
printer, can't read bitmapped fonts so it has to create 

them when you pri nt. Many programs v..]ll automa tically 
substitute Times for New York, H elve tica for Geneva, and 
Courier for Monaco, foo ling you into thinking you have 
the real outline fon t. Have you ever seen (or produced) 
work on a Laser\Vriter where the words had awkward 
gaps between them, th e numbers didn't line up, the tabs 
did n' t line u p , the shift-line was broke n , or they looked 
almost as raggedy as on the screen? That's the result of 
printing city-named fonts on a PostScript printer. Examples: 

This is an example of 
9 pt. New York fr o m the 
Lase rWriter with n o 
font s ub stitution . 

This is an example of 
9 pl. New York from the 
LaserWriter with auto
matic font substitution . 

This is an example of 
9 pL Times from the 
LaserWriter. It doesn't 
need font substitution. 

The bitmapped city-named fon ts were designed (and 
actually look better than the othe rs) for the screen an d 
fo r the JmageWriler. 

T he type size listings in the Mac also have a li ttle vagary 
that 's nice to know about. Have you n oticed how some 
of the sizes listed are in o u tline style (which has nothing 
to do with outlinefonts), and some are not (see right)? T his 
can be different fo r each font. 

What th e outlined n umber is indicating is that this 
particular size for this particu lar font has been installed 
in the System . It will look its best on the screen in the 
outlin ed size, and will prin t best on a QuickDraw prin ter 
in the outlined size. You can ask for any o th er size, and 
in some programs type in your own size up to 127 poin t 
or beyond, but it' ll look funky on the screen . T he bigger, 
the fun kier. And if it looks funky on the screen , it will 
look funky on a QuickDraw printer because tl1at printer 
can only reproduce what it sees on ilie screen . 

A PostScript laser prin ter, on the othe r h an d, can create 
a PostScript fon t (not a city name) in a ny size you like. So 
even if it looks totally gross on t11e screen, the laser printer 
v..] ll print it as neatly at 95 point as it will at 12 poin t. Note 
the example o n the next page. 

System 7 update: citynomed fonts, page 135; type sizes. page 135. 

. Type Size 

6 
8 

U (DTI-Installed 
U ~ sius 

14 
18 

Note: read about A 1!\1 
and how it can improve 
the printing of fonts on 
QuickDraw printers; 
page 141. 
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fONTS 
-"mmtn¥!1£ If 

5 7 point Times R 
on the screen and 

jJrinted on the 
lrnageWriler R

57 fJoint Times 
fJrinted on the 
Laser Writer 

If you acquire more screen sizes (or e n tire fonts, for that 
matte r), you can install them with your Fon t/ DA Mover 
(see Chapte r 19). 

Warning: technical information below 

~ Screen fonts 
V and Printer fonts 

en 
Fonts 

The suitcase icon that 
holds screen fonts; used 

with the Font/ DA Mover. 

NewBasRom 

I con -repnJsenting 
a p rin lerfonl. 

(ITC N~w /Jaskervillt Roma>1) 

More Examples 
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Simple bitmapped fonts, which are those fon ts de
signed for the screen and QuickDraw prin ters like the 
ImageWriter and which usually have a cit")' name, have 
only one part to them-the screen font itself. Since a 
QuickDraw printer prints what it sees o n th e screen , the 
screen font contains all the necessary information . On ce 
the screen f ont is installed in the Syste m (it will show up in 
yo ur font list), you ' re ready to type and pri nt with it. 

PostScript fonts, however (those designed fo r PostScript 
printers such as the LaserWri ter) , have two separate parts: 
a bitmajJjJed screen font and a corresponding printer (or 
outline) font. W'he n you acquire new PostScript fonts, you 
must install the screen fonlwith the Fon t/ DA mover ,just 
as with simple bitmapped fonts. Yo u must also put the 
fJtinler font icon into the System Folde r. Printer f ont icons 
canno t be inside any o ther folder inside the System 
Fold er or the printe r won ' t be able to find the m. 

T he PostScript fonts that Apple provides with the Mac 
and with the LaserWriter, as well as any fo nts tha t are 
included in any other PostScript printer you may buy, 
have the ir printer fonts installed directly in to the pr inter, 
so you needn 't wor ry abou t fi nding an d fi ling their 
prin ter icons. 

O n the fo llowing pages are examples of the fonL~ tha t 
are supplied with your Macin tosh Sys te m, and also the 
o the r fonts that are installed in the Apple Lase rWriter . 

(Notice the apostrophes jJ1inted in these examples! See page 90 
if)'OU are interested- which you really should be-in how to 
tyjHI afJostro-phes and quotation marhs.) 

System 7 update: screen fonts vs . prinler fonts, page 136. 



FONTS 

Simple bitmapped fonts (city-named) on the lmageWriter 
Faster Quality ... Tall Adjusted 

Geneva ( 1 0 point) 

Plain: The quick bro1.1n fox jumps over the l azrJ doq's back. 
Bold: The quiet brovn fox jumps over the lozy dog"s bock. 
Italic: T lie •ll.lid.' br(}'h•'n f.),\' jumps· Ol·~r lite ~~Y do? ·s !J8ck. 
Bill Ita/_- Ttte quick IJrDtr"ll rox _jumps o•-er the /.a.zg dog"$ b!Jck. 

New York (10 point) 

Plain: The qui<;k bro"Wtl fox jumps over the lazy dog ··s back. 
Bold: The quick brown fox jumps over the lazy dog_ 
/t8:1i.:-: rhe quf.:-k bt''OW7Z fOX jumps OT·~r the lEM',V ~ J, b&k. 
Bid Ita:J: The quick /)roFD fo.r jumps over t.b.e lazy dog. 

Monaco <9 poi nU 

Plain: The quick brown fox jumps over the lazy dog's back . 
Bo I d: The qu i ck bro•n fox j uaps over the I azy dog_ 
Italic: Tf1e quid..- brol/m {;_,,'<.jumps O(,'e/' the iazy ~ r:5' back . 
Bdltai:The quick brO#Rl fox ju.ps o"er the lazy dog. 

ChicagD 41 0 point) 

Plain: The Quiet brown foH juml)s ot•er the lazy £iog's back. 
llold: The quick •n•n fell j•mpa Dille.- tlae 1111~1 deg. 
/18/k: Tile quirl: broJDn tOR jum.{N' otter /he !a;:g dog Js beck. 
111111161: Tie •llk.k l'Jr1ND6 fBI ft.I/RII 6rN:r IJte IBZ'/IIIDI, 

'Ro.t.n.~ 'J'he qu.tm fJt"own fm~:. jutnps Dl'£.t' tfu: [o:zy dog's &!:ldt.. 

•a£4:: :J'fu. 11.u.U:6. •~own. fo-x. jutn.p!i aver tiu. f.a.tiJ ~-
Un/a!: 7f~e qsai:;£ [Jr.ou>W ft»c.jlaups tlil£r dir. fa.z:y dOf! ~ /iat:W._ 
11£47.6JI£~ 71ir; ~ mr,.,. fox _jruaps o~ ~ ~ .dDtff-

WM 
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FoNTs 

-~~---------------=-------------------
Simple bitmapped fonts {city-named) fonts on the LaserWriter 
no font substitution 
(The lines ore drown in, os opposed fo using fhe underline funcfion} 

Geneva (1 0 point) 

Pl ein: 
Bold: 
Italic: 
Bid /tal: 

The quick brown fox jumps over the lezy dog's beck. 
The qu1ck brown fox jumps over the lezy dog's bock. 
The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 

NewYork (10 point) 

Plain: The quick brown fox jumps over the lazy dog's back. 
Bold : The quick brown fox jumps over the lazy dog. 
Italic: The quick brown f ox jumps over the lazy dog's back. 
Bld ltal: The quick brown fox jumps over the lazy dog. 

Monaco (9 point) 

Plain: The quick brown fo x jumps over the lazy dog's back. 
B o I d: The quIck brown fox j urnps over the I azy dog 
Italic: The quick brown fox jumps over the lazy dog's back . 
Bdltal: The quick brown fox jumps over the lazy dog . 

Chicago (1 0 point) 

Plain: 
Bold: 
It a/ic: 
Bid Ita/: 

The quick brown foH jumps ouer the lazy dog's bock. 
The quick brown foH jumps ouer the lozy dog. 
The quick brown foH jumps over the lazy dog's back. 
The quick brown foH jumps ouer the lazy dog. 

Venice (10 poi-nt) 

P!:ai-n: 'Jhe quic:~ brown Jox jumps over the !:azy d:o<J'S bac~. 
Bo[ci: 'Jh.e qu.t.c~ brown fox jumps over the l:azy Mg. 
ltalic: 1he quick. brown fo x jumps over the lazy cio9's back.. 
1Jltl UGl: 'The quick brown fox jumps over the lGzy tloq. 
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fONTS 

lmageWriter fonts on the LaserWriter • automatic font substitution 
{The lines were created using the underline function; notice how awful they look, crowding the words. 
Also notice the awkward word spacing.) 

Geneva !1 0 point) 
Plain: The quick brown fox jumps over the lazy dog's back. 
Bold : The quick brown fox jumps over the lazy dog's back. 
Italic: The quick brown fox jumps over the lazy dog's back. 
Bid Ita/: The quick brown fox jumps over the lazy dog's back. 

New 
Plain: 
Bold: 

York (10 point) 
The quick brown fox jumps over 
The quick brown fox jumps 

Italic: The quick brown fox jumps over 

the lazy dog's back. 
over the lazy dog. 
the lazy dog's back. 
over the lazy dog. Bid /tal: The quick brown fox jumps 

Monaco (9 point) 
Plain: 
Bold : 

The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog. 

Italic: The quick brown fox jumps over the lazy dog's back. 
Bdital: The quick brown fox jumps over the lazy dog . 

Chicago (1 0 Dojntl 
Ploin: 
Bold: 

The quick brown foH jumps ouer the lozy dog's back. 
The quick brown foH jumps ouer the lozy dog. 

Italic: The quick brown foH jumps over the lazy dog's back. 
Bid I tal: The quick brown foH jumps over the lazy dog. 

Veni&e ( 10 point) 
:PI:ai-n: JfJ.e quich- brown fox jumps over the l:azy doc::~'s bach-. 
:8otd.: 'Jhe quich- f>rown fox jumps over the tazy d.o9. 
UaUc: The quick brown fox jumps over the lazy clog's back. 
1JCa Ual: 'The qu£ck brown fox jumps over the Cazy 4tuJ. 

- P't! ,., 
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PostScript (outline) fonts on the LaserWriter ... no font substitution 
(The lines are drawn in, as opposed to using the underline Function) 

Helvetica (12 point) 

Plain: The quick brown fox jumps over the lazy dog's back. 
Bold: The quick brown fox jumps over the lazy dog's back. 
Italic: The quick brown fox jumps over the lazy dog's back. 
Bold Ita/: The quick brown fox jumps over the lazy dog's back. 

Times (12 point) 

Plain: 
Bold: 
Italic: 
Bold /tal: 

Couri er 

Plain: 
Bo1d : 
Italic: 
Bld Itl: 

The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 

The quick browlljoxjumps over the lazy dog's back. 

(12 point) 

The brown fox jumps over the lazy dog . 
The brown fox jumps ove r the 1azy dog . 
The brown fox jumps over the lazy dog. 
The brown fox jumps over the lazy dog . 

Symbol (12 point) 

Plain: 
Bold: 
Italic: 
Bold /tal: 

Trw OutXK ~powv <\>0~ <pU).t1tO' oruep 'tTIE A.a.~"' ooyl1cr ~CX.XK. 
TllE OutXK ~powv <\>0~ <pU).t1tO' oruep 'tTl E. A.a~\jf ooyl1cr ~a.xK. 
Try£ ev[x l( f3pawv cpa~ <pUJ17u.r amt:p 'ITJ£ A.a(VJ 8oy[Ja f3axK". 
T1Jt: ev[xl( f3pawv cpa~ <pUJln:a amt:p 'ITJE A.a(VJ 8ayfla f3axK". 

Palatine (12 point) 

Plain: 
Bold: 
Italic: 
Bold Ital: 
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The quick brown fox jumps over the lazy dog's back. 
The quick brow n fox jumps over the lazy dog's back. 
The quick bmwn fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 



FONTS 

More PostScript (outline) fonts on the LaserWriter 

Avant Garde (12 point) 

Plain: 
Bold: 
Italic: 
Bid Ita/: 

The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog 's back. 
The quick brown fox jumps over the lazy dog's back. 

Boolrman ( 12 point) 

Plain: 
Bold: 
Italic: 
Bld Ital: 

The quick brown fox jumps over the lazy dog's back. 
The brown fox jumps over the lazy dog's back. 
The quick brownfoxjumps over the lazy dog's back. 
The brownfoxjumps over the lazy dog's back. 

New Century Schoolbook (12 point) 

Plain: 
Bold: 
Italic: 
Bldltal: 

The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog. 
The quick brown fox jumps over the lazy dog's back. 
The quick brown fox jumps over the lazy dog. 

Zapf Chancery (12 point) 

Pfai.n.: 'Tfre quicl(6rown fo!(ju.mps over tfre {azy rfog s 6acl(, 
No, this isn't a 
typographic e rror: 

'Bouf: '11re quicl(6rcrnm fo!(jumps over tfre {azy rfog s 6acl(, 
ftafic: 

'BU£ Ita£: 

'Tfze qu.id;_6rown fo!(jumps over tfre {azy rfog s 6acl(, 

'Ifze qu.icl(6rown fo!(jumps over tfre {azy rfog s 6acli:.., 

Zapf Chancery is 
small for its size, and 
doesn 't change styles. 
Neither does Symbol. 

Zapf Dingbats (12 point) 

Plain: **~~ o•*** ooot• *DI >r.-•oo.A O·:·~o Te 
CAPS: **+ ***+* +**** +*'*' 0**** **+* **+ 
Italic: *H~$ o•*** 0001• $0/ .;f<-.00~ 0•:•$0 ..,. 

Olllltliume: **• ld!O*$:·~ @DllJJDO $lJJI -m- <>0016 lJJ<8>.01 \70 

See the ZapfDingbats chart on page 183. 
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Font Sizes Below are two PostScript fon ts shown in several sizes to 
give you an indication of what to expect in a particular 
size. They have been printed on a Linotronic. Times is a 
serif; Helvetica is a sans serif (This book is se t in 10 point 
ITC New Baskerville, with heads in 10 point Futura Bold .) 

TI1is line is set in 6 point Times. 

This line is set in 8 point Times. 

This line is set in 9 point T imes. 

This line is set in 10 point Times. 

This line is set in 12 point Times. 

This line is set in 14 point Times. 

This line is set in 18 point Times. 

This line is set in 24 point Times. 
This line is 30 point Times. 
This line is set in 36 pt. 

This line is set in 6 point Helvetica. 

This line is set in 8 point Helvetica. 

This line is set in 9 point Helvetica. 

This line is set in 1 0 point Helvetica. 

This line is set in 12 point Helvetica. 

This line is set in 14 point Helvetica. 

This line is set in 18 point Helvetica. 
This line is 24 point Helvetica. 

This line is 30 pt. Helvetica. 
This line is set in 36 pt. 
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FONT/DA 
MovER 

A font is a typeface. DA stands for desk accessory, 
the items under the Apple menu on the far left (see 
Chapter 20 for more info on DAs). To move fo n ts or 
desk accessories from one place to another, like from 
a suitcase ico n to your System, or from the System on 
your hard disk to a Syste m on a floppy, you need to use 
the Fon t/ DA Mover. Also use this tool to remove fo nts or 
desk accessories from a System. 

When you buy your Mac, a Fon t/DA Mover is supplied 
on one of the disks. Typically it's stored in the System 
Folder or Utilities Folder, but it can be kept anywhere 
you like, eve n o n a separate floppy for occasiona l use. 

Where do you find the fonts to install? 'Nell , you ' ll 
n otice in your System or L'ti lities Folde r you have a 
little suitcase icon with a big letter A on it (you should 

have one, anyway-it may be in another fo lder or on 
one of your origina l disks). This icon re presents the 
container for your screen fonts; if}'OU do uble-click on 
it you will ge t the same dialog box as if you ope ned the 
Font/ DA Mover. 

Fonts also reside in your S)'Slem., after they h ave been 
installed. A few are installed at the factory, and if you 
bought other fon ts a t the same time as buying your 
computer, the shop may have installed the m for you . 
You cannot double-ckick the Syste m icon to see them, 
though (n ot unless you have System 7) . 

To install or remove fonts or DAs, find the Font/ DA 
Mover icon (as shown at the top of th e right-hand 
column) and double-click on it. You will see the dia log 
box shown o n the fo llowing page. 

1111. 

a=.---==- -====---=::r· 
Sy5tem 7 update: Foni/ DA M over, page 136; wl>ere fonls reside, page /36. 

CHAPTER NINETEEN 

: Font/DA Mover V 
w 

FonUDA Mover 

· Where Fonts ~ 
· Reside Y..f 

Fonts 

Fonts reside in suitcase 
irons or di1·ectly in your 
System icon. 

Using the 
Font/DA Mover 
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foNt/ DA MoV£R 
~ ........ 

7/lis indiwles whether · 
yvu'1·e viewingfonts or DAs. · 

Your font list is 
jJrobably dijfe1mt. · 

This telLv you where 
this list of fon ts or 

DAs is located. 
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•WI mw 

®Font 
Mouer 0 Desk Accessory 

Boston 10 I ( t:opq ] lQ 
:nHte 

Chicago 12 ( Remoue l 
Courier 12 'niT: 
Geneua 9 ~lWi 
Geneua 10 J! 3846 bytes 

Geneua 12 10 selected ~ 
System 

on Hard Disk ( Help ] 
917K free 

( Close ) ( Quit ) (j&ei!::J 
.......................................................................... ................. ........................................ ..... .................. ........ 

Boston 12: The quick brown fox jumps over the 

Font/ DA Mover dialog box Click on the Click this 
name of a button to 
.font. to show find another 
a smnjJle file with fonts 
0 it here. in it. 

The Font/ DA Mover automatically opens to show you 
(in the left-hand list box) the fo nts that are insta lled 
o n the System that is running the machine, or the fonts 
that are in the font file you just opened . Notice the sizes 
listed? T hose are the ones that will show up in your 
applications as the outlined numbers, the sizes that are 
insta lled (as noted on page 67). 

On the right-hand side is an empty box above a button 
labe led "Open." This side is waiting for you to open 
anod1er font fi le so you can transfer d1em back and fordl. 
So ... click on the Open button to get this dialog box: 

1111. 



I [g) Utilities I 
D fonts ~ 
D System Folder 
D Update Folder 

[g) Utilities 

Eject 

Driue 

Open 

New 

Cancel 

The Open dialog box within the Font/DA Mover 

From this dialog box you can find the file that contains 
the other fonts (Note: T he fi le you want may be the System 
on another disk, o r the suitcase fil e named Fonts, as 
shown above, or perhaps it is called Streen Fonts): 

• If the file is on a disk in another drive, click Drive 
to see it. 

• If the file is on another d isk and the curre nt disk 
must be ejected t.o put that one in , cl ick Eject and 
stick the other o ne in . 

• When the file is visible in this dialog box, se lect 
it by clicking o nce on the na me, then click Open; 
or simply double-click o n the name to open it. 

As soon as you open an appropriate file, you get back to 
th e orig inal dialog box (as shown on the pre\~Ous page); 
this time the right-hand box will have a ll the fo nts from 
the fil e you just chose. 

At this point you simply select the foolS fro m either side 
that you want to copy o r remove (select them by clicking 
once on d1 em), the n choose "Copy" or "Remove." You 
can use shift-clicking he re to se lect mo re than o ne font 
at a time to copy-hold th e Shift key clown while clicking 
on or dragging ove r all your cho ices; they can a ll be 
copied or removed simulta neously. 

FoNt/DA MOVER 
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FoNt/DA MovER 

~ Installing or · 
".( Removing · 
Desk Accessories · 

78 

Lm 
Desk Accessories 

A Note About · 
Families,: 

Fonts, . 
and Styles 

A Note About 
Downloadable 

Fonts 

Macintosh desk accessories are also stored in a little 
suitcase icon or in the System. Accessories you buy 
from an outside source often have the ir own icon. 

Installing or removing desk accessories works exactly 
the same as with fonts; just be sure to click the button at 
the top of the Font/ DA Mover dialog box to select DAs 
in stead of Fonts. 

Macintosh uses so me of the typographic terminology 
in a slightly different way than traditionally, particularly 
in the way it defines "fonl." As an example, one of your 
fonts is named T imes. T imes is ac tually a generic family 
name; in the Times family you have regular , italic, bold, 
and bold italic; technically, each one of these members of 
the family is a separate fo nt each with its own separate 
group of characters. In t.he Macintosh environment, when 
you are working with the typefaces installed in the laser 
printer, the family name, such as Times, is considered 
the font name; t.he variations such as bold or italic are 
considered styles. It is important to know, though, that 
this is a Macintosh convention, because ... 

When you buy fo nts that are not installed in yow·jJrinter 
(any font without a city name other than the ones listed 
in the Fo nt. chapter) , you usually cannot change the style 
from th e menu; these o the r typefaces follow standard 
convention and each different style is consirlered a sejJarate 
font and must be treat.ed as such . For example, if you 
are using Futura and want to ita licize a word, you must 
choose the font Fut.ura Italic from the font list-you 
cannot simply choose "Ita lic" from the Format or Style 
menu. Now, this is not always true-font techn ology is 
changing so rapidly and the standards are not defined 
yet and eve rybody is fighting everybody e lse for supreme 
fo nt power. If you wi ll be using typefaces other than 
the standard installed ones, be sure to read about and 
understand them-they are usually t.ermed downloadable 
fonts, as they must be downloaded into the printer in 
order t.o use them. lfyou want to know all about Macintosh 
fonts, read The Macintosh Font Book, by Erfert Fenton . 

System 7 updo1e: installing desk accessories. page I I 3. 



Desk accessories (DAs) are handy little tools found 
in your menu under the Apple, designed to make life 
easier. Access the m like any other menu item-slide 
down the list until it's highlighted, then le t go. They' re 
all windows, so they can be moved around the screen 
from the ir title bars and closed with the ir little close 
boxes. They all work from within the Sys te m , so you 
can open a ny of them while you are in any application. 

You can buy an amazing number of desk accessories, 
many for very low prices. They do all manner of useful 
and useless things. This list explains just the ones tl1a t 
come standard with any Mac. 

The Alarm Clock won 't wake you up in the morning, but 
it will beep at you while you 're sitting at your computer. 
Afte r it beeps once, the a pple in the corner flashes on 
and off; o n the newer S)'Ste ms it flashes from a n apple to 

an alarm clock. T he pro ble m with this alarm is th at it 
doesn 't turn itself off-even if you turn off the computer 
and come back next week, the a larm clock is still fl ash
ing; you have to go get it and turn it ofl yourself. 

When the clock is the active window on your screen, you 
can press Comma nd C and create a copy of the date 
and time; set your inse rtion poin t down anywhe re, even 
under an icon at your desktop, and press Command V; 
the date and time will paste into your document, like so: 
1:38:07 AM 12/5/91. 
0 To change the settings, begin by clicking o n the tiny 

flag on the righ t; it will open up to a little contTol panel. 
After changing a setting, cl ick anywhe re in the clock 
window to put it into e ffect. 

0 To change the time: 
..,. Click on the time clock icon on the bottom left. 
..,. Click on the numbe1· in the middle panel th at you 

v.rish to change (th is will cause li ttle up and down 
arrows to appear on the right) . 

..,. Click on the arrows to move the Lime forward or 
backward or 

..,. You can type in the numbers once you select them, 
eitl1er from the keyboard or the keypad. -· .... -==-----------..,;til-...;;:=--

CHAPTER TWENTY 

Desk Accessories 

· Alarm Clock 

I D 2:02:10 PM 6 

Press on the numbers to 
dmg this clock anywhere 
on youT sCTeen. 

' • 
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DEsK AccEssoRIES 

The switch to turn 
the alarm on or off 

• Change the AM or I'M notation the same way. 
• Note: you can press the Tab key to move the 

selection from hours to minutes to seconds, e tc. 
0 To change the date: 

• Do the same as for the time, after clicking on 
the li ttle calendar icon. 

0 To set the alarm: 
• Click on the alarm clock icon . 
• Change the time to when you want it to go off, 

as detailed above (check the AM or PM no tation ). 
• Click the little switch on the LPft to the up position 

(you ' ll notice the zingers around the icon now). 
• vVhen the a larm goes off, you' ll get a beep and/or 

your menu will flash , and the little apple in the 
menu will flash on and off. 

0 To close up the clock: 
• To just get rid of the control pane l, cl ick on the 

flag in the upper right again. 
• To put it away altogether , cl ick in its close box. 

0 To turn oH the alarm: 
• To turn it off lemfJorarily, but leave the alarm set for 

the next day at the same time, simply get the alarm 
clock an d then click in its close box. 

• T o turn it off pennanently, you must go in and 
reverse the process of turning it on ; that is, click 
on the alarm clock icon and turn off the switch . 

Calculator : The Calculator is a very handy item to have. It operates 
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. j ust like your hand-held calculator , although it has on ly 
the four basic functions. Remember, it's a window so it 
can be dragged around like any o tJ1e r window and put 
away with its close box. Access it in any ap plicatio n. 

• Operate it with the mouse, keyboard, or keypad . 

• If using the keyboard, make sure you use the real 
numerall (one) and not a lowercase I (el). 

• T he division sign is the slash: / ; the multiplication 
sign is the asterisk: * . 

• The answer can be copied and pasted into your 
document using Copy and Paste from the Edit menu. 
Yo u don ' t need to select the numbers first- if the 
Calculator is tl1e active ' vindow, tl1e Copy command 
knows what to copy. You can also copy numbers from 
your document and paste tJ1em into the Calculator. 



DESK ACCESSORIES 

The Chooser is where you choose which pr inter you wish Chooser 
Chooser 
Select o on nter porl: 

to use. If you are working from a hard disk at 
home or at work and are hooked up to o nly 
one printer , or if you always use the same 
System disk in the same computer , you need 
to do this only the very fi rst time you prin t. 

As .. ;!., !!'! 

I 

~ ~ • 
0 Choose the icon for your prin ter: 

.,. In the left-hand box you see the printers 
whose icons are in your System Folder; 

... Click on the icon of the printer you are going 
to use (in this example it's the ImageWriter ). 

0 Click on the name o r the port icon of your printer: 
... Depending on which prin ter icon you choose on 

the le ft, in the right-hand box you' ll see either 
names of the printers available, or port icons (the 
port icons are asking to which port, or jJlug on the 
back of the Mac, your prin ter is connected). In the 
example you see the choice of a pr inter port o r a 
modem port (here the modem port is chosen , as 
my LaserWrite r is plugged in to the printer port). 

0 Adjust the network optio n (a ne twork lets more 
than one computer talk to the same pr inter; in this 
example it's Apple Ta lk): 

... If yours is the only Mac hooked up to an Image
Writer , then AppleTalk will most like ly be inactive; 
if several compute rs are sharing the same printe r 
or ifyou are co nnected to a LaserWrite r, then 
AppleT alk should be active. 

0 If you type your name in the "User Name" box, you 
will then have the pleasure of seeing your name on 
the screen. 

User Nome: 
!RoDin I 

In App leTalk ®Acttve 
0 lnoct lve 

0 Click the close box and continue to print. 
: Control Panel V 

TheControl Panel allows you to customize the Mac ~l:l~!i!!!~i!!}c~ •• ~,,~o•!!•:!••~ciJo ~!i!!!!i!!!!!!!j 
to your own specific p references, such as wha t kind .I ~ D ~ "';:~-::=:.,"" 
of sound to make and how loud it is, how fas t the t Li..J ?k 

IJ~ O• •kt~·r·.;.~ . . 0 ® 0 
insertion point flashes, the patte rn of your Desk- ' 11;: •~w '"' 
top , e tc. Wha t your par ticular Con trol Pane l has in v_... ........ ....... ""' (5) 'I 

~ 7·2632PM ,: 
it depends o n what System you are using and wha t ~ ~ ®,,._0 2.,. ~ : 

is inside your System Folde r. ""'"'"" ~~ o o o® o ••• 1fiJ r 
<1 »'1. !' orr 1 2 • 7/ 21/92 o-

Many of the items a re self~explanatorv-:J·ust click w t 
• / '""' ~ RAMCK .. I!K] m o... ... .. w 

on the radio buttons or on the numbers o r o n the ®orr "' ..... 

System 7 ma(or update: Control ponels. poge I 23. 81 
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Click here to view 
pc11tems I I 

D o,,,,,,: .. \ .. ........ 
.. .. .. .. .. .. .. 
.. .. .. .. .. .. .. . 

Deskt op Pattern 

Click here to 
change JOU1' screen. 

Double-click to save a 
newpauem. 

M CI&Jil 

words in a scroll box to alter things to your fancy. Here are 
a few specifics for areas that may not be so obvious: 

0 Desktop Pattern 

• O n the "Desktop Pattern" click on the tiny right 
and left arrows-th is will take you through a variety 
of pa tterns; whe n you like on e, click on the pattern 
under the arrows and your Deskto p will change . 
When you fi nd the b lank pattern, draw in it with 
the mouse to create your own-clicking on a white 
pixel turns it black; cl icking on a black pixel turns 
it white, "erasing" it. All pattern s can be edited. 

0 Clock & Calendar 

• Setting the time and date here will change the 
Alarm Clock desk accessory also, and vice-versa. 

0 Keyboard 

J<t v Rtput ~~. 

000®0 
Slow r.tst 

O.l.~,t lkltfl R:,put I 
0 0®00 
Off loo9 Shor't 

• Every key on the Macintosh keyboard will repeat, 
meaning if you hold the key down it wi ll continue 
typing tha t character across the page. With the Key 
Repeat Rate panel you can contro l how fast it types 
that character across the screen. 

7-
6 -
5-
4-
3-
2 -
1 
0-

Speaker 
Volum~ 
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• With the Delay Until Repeat you can turn off that 
function , so the keys will not repeat when you press. 

• Long to Short gives you con trol over how l,ongyou 
can hold your fi nger on a key before it starts to 
repeat. T his is wonderful for people who are heavy 
on the keys-set it for a long delay so if your fingers 
dawdle on the keys you won't end up with extra 
characters all over the place. 

0 Sound 

A l ~rt Sound S~tting 

Boing 
Clink- Klank 
Monkey 

• Just click on one of the sounds in the list box on 
the righ t and you 'll hear it at the level that you set 

Q 

[) 

your volume control. Whichever sound 
you choose last will be the one you hear 
whenever Mac wan ts to beep at you . If 
you don't want to hear an)' sound, set the 
speaker volume to zero-your menu bar 
wi ll flash instead. 



0 Mouse 
"' The slowe r you set your mo use tracking speed, with 

Tablet be ing the slowest, the farthe r you have to 
move the mouse in connection with its response on 
the screen. In othe r words, if you have a very sma ll 
space for your mouse to move around in , the n set 
this to the fastest speed-the pointe r will move 
farther on the screen with the minimal amount 
of movement on the mouse pad. 

This is a most wonderful tool. The re is 
Find File who will find you anything you 
want, even if you have no idea where it is 
or its exact na me. The fi le may be in a 
folder which is in a folde r which is in a 
folder. Well, this guy will go get it-he' ll 
look in every fo lder on your hard drive or 
only in the folde r o r disk of your choice. 
He won't loo k in your refTigera tor o r 
under the sink. 

He' ll no t only find your fil e, but if you a 

a li ttle man in 

c::::::J Hnrd Disk 

~earcn ror: I resume 

" 
DR•~ [X(·I 

0 nul ~nYN> 

CTut...S fri,.J~3. 19'92 ; 2 .43 AM 
Mo41Nd " Vf'd, Jtn22,1'"2,l 2 1 M-1 
Sizto EIGtMJt.-s, 

O ~Ot!C:Uk 

sk him nice ly he 
will put it on the Desktop for you. Then when you' re all 
through and do n ' t re member where it ca me from,just call 
him up and he will come right over and put it away for you, 
right back whe re it came from. Wha t a guy. 
0 To locate a file: 

"' The insertio n p oint is fl ashing; you need to typ e 
a t least three letters of the file name you want 
(actually, you can search with only on e le tte r, but 
if there are too many files with that le tter in it yo u 
will get a message telling you to be more specific). 

"' If necessary, click on the na me of the disk shown in 
the upper left o f the window to search another d1ive. 

"' Click on the litt le man or press Re turn. 
"' Stop the sea rch at any time by clicking on the 

stop sign with the hand o n iL. 
"' The names of any fi les found with those consecutive 

letters in the name wi ll be listed in the window. 
"' Click on the n a me of th e file you want (if the scroll 

bar is gray, press the arrow to see more fo un d files). 
In the bo ttom right you will see exactly where the 
selected fi le is located. l'via ke a no te o f whe re it is. 

0 Put the file on the Desktop: 
"' You can now e ith er close Find File and go ge t you r 

DEsK AccESSORIES 
. II< 

... ......._ 

len Click on this icon 
~ to get to its controls. 

111!1! 
Mo\l.w Tr .U:Wo.) 

r11 il 4va 
(T~ltl) (M ouu) 

0 000 ® 
V~ SIQ'OI' Slov t n t 

+ + 
• o + ® t o 

Oo\blt..(;hck ~·d 

Find File w 
nod me • I~ 

I e<1 Work Somples 
O Works 
es1 Programs 

llnrd Disk 

The particular file 
selected here L in. fo""' wlkd 
Works Samples, 
which is in a folder 
called Works, which 
is in a folder called 
Programs, which is 
on the Hm·d Dish. 

Ill 

lo 
Ill 

In 
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Key Caps 

~ 
Key Layout : 

This is the icon that must . 
be in your System Folder 

in order to view the 
special characters. 

--~~---84 

file, or go up to the menu bar-notice you have a 
new item: Find File. 

, Choose "Move to Desktop ... " to have the fi le pulled 
out of its fo lder and placed o n the Desktop. 

0 Put the file away: 
, Later , at your Desktop, when you want to put that 

particular file away and you don't remember where 
it came From, select it (click once on it) and choose 
"Put Away" from the File menu; the little man will 
come and get it and put it away for you. 

0 From inside an application: 
, If you 're working on a job inside a program, then 

pull down Find File and enter a name in the box. 
, Click on the little man, then click on the name 

of the file you want. 
, Close the Find File window. 

, Now when you go to the File menu in your applica
tion to Open a document, the file you fo und will be 
waiting for you! 

If the icon Key Layout is in your System Folder, then Key 
Caps can show you the keyboard layout fo r every font in 
your System. On a Macintosh keyboard you actually have 
four separate sets of keys, two ofwhich you know already 
and two of which on ly a few people know about. You are 
about to become In The Know. 

, After you open up Key Caps, you have a new menu 
ite m on the far right: Key Caps. 

, Pu ll down the Key Caps menu-this is a list of the 
fonts that are installed on your System; 

, Select the font you want; the characters of that 
fo nt will appear on th e keyboard (these are the 
characters everybody knows about). 

, To see the Shift characters, press the Shift key 
(everybody knows these, too). 

, To see the Option characters, press the Option key 
(Ha! You are now In The Know). 

, To see the Shift Option characters, press the Shift 
and Option keys simultaneously. 

Diffe rent fonts have difTerent characters in the o ther two 
keyboards-some have more, some have less. Most of the 

System 7 updCJte · Key Caps, pelge 108. 
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Option key characters are consistent in every font, so 
you can always find, for instance, the accent marks or 
copyright, trademark, and monetary symbols, etc., in 
the same place. 

Key Caps is only for finding the fJlacement of all the available 
characters on the keyboard. Hold down the Option key, 
for instan ce, and note where the ¢ sign is located. Once 
you discover that it is found under th e 4 (the$ sign, 
logically), then you can go back to your document and 
press Option and 4; the ¢will appear. It's exactly the 
same idea as pressing Shift 8 to get an asterisk! 

It's p ossible to type the characters on the Key Caps 
keyboard, copy them (se lect the characters first, th en 
choose Copy from the Edit me nu), and then Paste the m 
into your document (they will paste in wherever the 
inser tion point is flashing). This works fine as lo ng as the 
font you are using in your document is the same font you 
chose from Key Caps, or at least that they share the same 
character. Otherwise whe n you paste the ch aracter it will 
take on the format (type font, size, style) of the character 
to the left of the insertion po int, which may no t be what 
you want at all. 

,. At the Key Caps keyboard, find the ch aracter you 
want to use; 

,. re member ·what font and what keys to press to get 
that character; 

,. go back to your document, select the font you want, 
and press the appropriate keys; 

,. can you find the apple? 
Also see pages 48- 50 for more info. 

The Note Pad is a nice li ttle feature that allows you to 
write up to eight pages of notes. This is a great place to 
leave prearranged messages, notes about particula'r 
formatting used in a d ocumen t, reminders, or more love 
notes. They are automatically saved (they will not be 
destroyed on rebuilding the Desktop, as Get Info notes 
will, page 31) . 

The insertion point is flashing; type into it just as you 
type anywhere else in the Macintosh. You can backspace/ 
delete, cut, copy, paste, e tc. Turn the pages by clicking 
on the little turned corner on the bottom left; click on 
the vet)' bottom corner to turn the pages backwards. --

DEsK AccEssORIES 

Use Key Caps for 
finding characters 

Copy& Poste 

Vmy i11tcrestiug
tili.< aNJ!e won 't print 
ou a11 mwgeseller. 

Note Pad 
0-NotePod 

Esseys to be wrl t ten 
• The tnree rules or li fe : 

1. Yo ur Olt itUd8 IS SOUr h fe . 
2 . Mox1mtze your options 
3 . Never toke cnythtng too 

senously 
• Cre~:~tlng momon es fer cur 

children. 
• Every home should hove c 

s tege ond donee floor. 

'

Click here to tum 
the page 
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Scrapbook 

See fJages 46-4 7 . 
if you wa11t more . 

information 
on the ClijJboard. 

The Scrapbook is a place where you can store text or 
graphics permanently from virtua lly any program; then 
in any other program you can take a copy of it back out 
from the Scrapbook and paste it in to your document. 
Once you put something in th e Scrapbook it is saved to 
your disk automatically. T he Scrapbook holds the entire 
oqject or text, even though you can't always see all of it 
in the window. 

You must go through the Clipboanl to put items 
into the Scrapbook and to take them out. 

0 To paste something into the Scrapbook: 
.., From your document, select and wpy the item you 

want to place (this puts a copy on the Clipboard) . 
.., Open the Scrapbook . 
.., Paste the item into the Scrapbook (from the Edit 

menu choose "Paste")-it wi ll be pasted onto the 
page that is visible, and everything else will move 
over one; nothing is being replaced . 

.., Close the Scrapbook to get back to your document. 
0 To copy an item out of the Scrapbook: 

.., Open th e Scrapbook . 

.., Scroll through until the item you ·want is visible . 

.., Copy it (from the Edit menu choose "Copy") . 

.., Close the Scrapbook . 
.., Go to your docume nt and paste it in (usually any 

text that is pasted, and sometimes graphics, will 
insert itself wherever the insertio n point is flashing; 
in some programs it will just be pasted into the 
middle of the page). 

0 To delete an item from the Scrapbook: 
.., Scro ll through until the item you want is visible . 
.., From the Edit menu choose "Clear" (Clear removes 

it fro m tl1e Scrapbook without putting it on the 
Cli pboard ). 

Scrapbook Document 



A FEW 
EXTRA TIPS 

This is a collection o f the tips or important notes that 
are imbedded in the rest of the book, as we ll as any other 
hints or fascinating bits of information or shortcuts that 
haven't been mentioned. Again , nothing is software
specific; it all relates to the general Mac environment. 

CHAPTER TWENTY-ONE 

Caps Lock does not act like a typevvriter Shift-Lock in that · Compendium 
you can sti ll type numbers while Caps Lock is down. p.20 · of Tips 

To move a window without making it active, hold 
the Command key while pressing-and-dragging in its 
title bar. p.22 

To align all icons horizontally with no empty spots, 
hold down the Option key while choosing "Clean Up" 
from the Special menu. p.25 

To close all the windows on your Desktop, hold down 
the Option key while clicking in the close box of the 
active window. p.25 

On Systems 6.0 and above, you can also clo:r;e all the 
by pressing Command Option W. p.25 

To close all windows on the Desktop before you 
even get there, hold down the Option key while 
choosing "Quit" from any program. p.25 

To make the previous window close instantly, hold 
down the Option key while ope ning folders. p.25 

To print the contents of the active window on the 
ImagevVri ter , press Command Shift 4. p.26 

To print the entire screen on the ImageWI'iter, press 
Caps Lock down and Command Shift 4. p.26 

To bring the window belonging to a gray icon to the 
front, simply double-click on the gray icon. p.29 

To avoid the dialog/alert box asking if you really want 
to throw away that application , hold down the Option 
key while trashing th e icon. p.30 

After trashing an icon, "Empty Trash" from the Special 
menu in order to free that space on the disk. p.30 

The page nu mber 
indicates where m()re 
information on tha t tip 
can be found . 
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To create a MacPaint file (a screen dump) of anything 
on your screen , press Command Shift 3. p.30 

T o write notes on a file, use the Get Info box. p.31 

: To throw away a locked file, ho ld down the Option 
key. p. 32 

Use folders to organize your Desktop and a ll your 
d isks as you would your filing cabine t. Chapter 9 (p.33) 

Create a new folder at your Desktop before you begin a 
prqject and save all your related parts into that 
folder, preventing them from getting misplaced. p.35, 52 

To select more than one icon at a time, press-( in any 
. blanh area)-and-drag the pointer; a marquee wi ll appear. 
. Anything enclosed in this marquee wi ll be selected . 
. T0 move all the items at once, press in any blt1ch area 

(except on th e name) and drag; all the outlines wi ll move 
simul taneously. p.38 

Ano ther way to select more than one icon, especially 
when the icons are not near each other, is to 
press the Shift key wh ile clicking on icons and every one 
you click wi ll be selected. Conversely, any icon 
by pressing the Sh ift key-only the o nes you click wi ll be 
deselected from the group. p.38 

To copy an icon into another fold er on the same disk, 
press the Option key while moving the icon. p.38 

Never hit the Return key while typing unless you 
really do want the line to e nd at that word. p.42 

If you are going to center a line, don' t use tabs or inden ts 
or spaces be fore or after the line or they will make it 
appear off-center. p.44 

While typing, the insertion point picks up the 
formaHing of the character to its left-font, style, size, 
alig nment, and rule r settings. p .44, 45, 49 

To remove all the styles a ttached to characters (bold, 
italic, shadowed, e tc.), simply select the text and choose 
Pla in or Normal. p.45 

To change the type style (to ita lic, bold , etc.) o f the 
next word(s) to be typed, use the keyboard commands 
Repeat the comrnand to take change the style back to 



normal. This avoids having to select the word(s), pick up 
the mouse, use the me nu, and set the insertion point 
again to continue. p .45 

Don't forget about Undo! If something happens tha t you 
didn' t want to happen or don ' t like, before you do anything 
else, UNDO (from the Edit me nu, or Command Z) . p.48 

To place accent marks over letters, use the Option 
characters. p.50 

Use only one space between sentences! p.50 

Never use a typeface with a city name on a PostScript 
laser printer. p.66-67 

Whe n saving, be sure to save directly into the folder 
you created to store your work. p.35 , 52 

Make several versions of your work using "Save As .... " 

p.53 

If you change your mind about the changes you just 
made, close th e document and d on ' t save those changes; 
whe n you reope n it, the document will have reverted to 
the last-saved version. p.S~ 

To avoid wasting paper and toner eve'l' time you turn 
on your laser printe r , pull the pa per tray out a bit before 
you turn it on. p.57 

When ejecting disks at your Desktop, rather than 
ejecting them with the menu command it is preferable 
to drag them o ut thro ugh the trash can. Or select the 
disk icon and press Command Option E. This doesn' t 
destroy any data on the disk, and removes the memory of 
that disk so the computer doesn't ask for it again . p.62 

If a disk is stuck in the computer after the compute r 
has been turned off, hold the mouse button down while 
you turn the machin e back on ; th e disk ~,~11 pop out. p.62 

As a last resort to eject a disk stuck in the computer , 
unroll a papercl ip and push it in the tiny hole to the 
right of the drive slol. This wi ll release the mecha nism 
and pop the disk oul. p.62 

To find a file/ document/ application that somehow got 
misplaced but you know it 's in there somewhere, use 
Find File from the Apple menu. p.83 

A FEW EXTRA TIPS 
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A Few ExTRA TIPS 

Real 
Quotation 

Marks! 

'' and '' 

' and ' 

not 11 and 1 

Return Key 
Shortcut 

Replacing 
Highlighted Text 
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Ellipses ••. 
in the Menu 

Tab Key in 
Dialog Boxes 

Using inch and foot marks in p lace of the real quotation 
marks is an easily made mistake. Yes, on the typewriters 
we grew up with we used th ose marks, but we are no 
longer on typewriters. Also, we a rc atte mpting to co me 
close to professiona l type, and you never see inch an d 
foot marks used as quotatio n marks in pro fessional type . 
Unfortunately, they arc not located in an o bvious spot, 
so you won't know they' re there unless some body te lls 
you. So I'll tell you: 

To type this mark: Pre ss these keys: '11u:y wan 't always be 

" Option 
these big muncl marl!s; 
Pach f ont has its own 

" Option Shift 
'I notes designed for it. 
See the font lists 011 

' Option 
jJages 70-73. 

' Option Shift 

A d ouble border around a button (such as the OK 
button shown below), is a visual clue that means you 
can press th e Re w rn or En ter keys to do that function , 
instead of picking up the mouse and clicking o n it. 

[ OK D ( Cancel ) 

Whe n text is highl ighted, you don ' t need to delete it 
first in order to type in what you want. Whe n text is 
highlig hted , simply type; your typing will replace the 
highlig hted word(s) . T his is true anywhe re in the Mac
all dialog boxes, all programs, even on the Desktop whe n 
changing the name of an icon. 

: Three doL~ (the e llipsis: .. . ) afte r a n ite m in the menu 
is a visual clue th a t means you' ll ge t a d ia log box if you 
choose th at ite m. Anything that doesn ' t have the ellipsis 
will j ust activa te as soon as yo u choose it. 

In any dia log box that contains boxes for you to fill in, 
you can press the Tab key to move the selection from 
box to box. If there is data already in the box, that data 
will be high lighted a nd anything yo u type will replace it 
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(you don't have to d ele te it first). If there is no data in 
the box, the Tab key will set the insertion point there, 
ready for you to type. 

On the front of th e Macintosh, ifyou slip your hand 
right under the rainbow apple you' ll find a little ro ller 
switch that will dim or brighten your screen. It's a good 
idea to dim the screen if you ' re going to be away from 
the computer for a length of time, as it 's possible to bu rn 
an image into the screen, just as on video games. 

There are several varieties of "screen savers" avai lable to 
help avoid screen burn . A screen saver usually turns th e 
screen black and has images that constantly move, like 
shooting stars or geometric shapes or flying toasters. As 
soon as you click the mouse it disappears. Some screen 
savers are desk accessories that you access through your 
Apple menu; some you put in your System Folder and 
they automatically turn on after a certain period of time 
if the keys or mouse have n ' t been touched. 

Several of the paint programs allow you to create a 
StartupScreen. Once you have a StartupScreen installed 
in your System Folder, every time you boot (start th e 
computer) v.rith that System, this image will show on the 
screen for a minute or two . This is quite fun! Simply 
create a paint document, or use clip art, and save the 
document with the name "StartupScreen." It doesn ' t 
matter what letters are capitalized, but it does have to 
be one word. Put that file into the S)'stem Folder. The next 
time you boot, you'll see it! 

If you need to copy some thing from one floppy o nto 
another floppy but your machine has only one floppy 
drive, do this: 

.,. Insert the disk you want to copy onto. \Nhile it is 
selected (click once on it if it isn't), from the File 
menu ch oose "Eject." Remembe1·, th is ej ects the 
disk but leaves it in RAM (p. 5 1). You should see 
the gray icon on the screen after the disk ejects . 

.,. Insert the disk with the informa tio n to be copied 
f rom. Ope n it and select the fi les to copy: pl·ess
and-drag them over to the gray disk (or just drag 
the icon of the entire disk to the other disk, which 
will replace everything). -continued 

A FEW EXTRA TIPS 

Dimmer Swikh 

. Screen Savers 

StartupScreen 

· Copying From 
· One Floppy to 
· Another Floppy 
: with Only One 

Floppy Drive 
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Rebuilding 
Your Desktop 

NOTE: 
This process will . 
also destroy the 

WDEF virus! 

lllllli.:: 
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Checking Your 
Fonts at the 

Desktop 

nm:;f)'ll' mmtl TIP .. 

• As Mac reads info from one disk and copies it onto 
the o th er, she will spit out disks and tell you wh ich 
ones to insert next Just follow the directions; th is is 
called disk-swapping. It will eventually end . 

• If you end up with a gray disk icon on the screen, 
just drag it out through the trash. 

If you have a hard disk, you may start to notice that it 
slows down after a few months. This is because there is 
an invi sible fi le that keeps track of all the icons that have 
ever been seen on your Desktop, even if you just loaded 
them on to see what they looked like ! There is a way to 
rebuild your desktop and remove all the unnecessarily 
stored information. Fo llow these steps: 

1. Turn ofT the Mac (or from the Special menu 
choose "Restart"). 

2 . Hold down the Command and Option keys. 

3. Turn the Mac back o n (if you turned it off), 
still hold ing down those keys until you see this 
dialog box: 

~ Are you sure you wont the desktop 
ill rebuilt on the disk " liard Disk "? llhls 

may take o few mlnutes.l 

4. Click OK (or, if you read the tip on the previous 
page, simply hi t the Re turn key). 

• Rebuild floppy disk desktop files the sam e way: 
hold the Command and Option keys down while 
inserting a disk, until you see the above dialog box. 

Mac wi ll rebuild the desktop fi le for you and it should 
now open and close files and folders much faster, plus 
rid it of the rude and evi l \VDEF virus. (I-I a! System 7 is 
immune to \VDEF!) 
The only problem with rebui lding is that it also destroys 
any messages you put in your Get Info boxes. Darn it. 
(See page 31 for info on Get Info.) 

T o see what fonts are in the System while you are still a t 
your Desktop, from the Apple menu choose "Key Caps." 
A new menu item will appear in your menu bar: Key Caps. 
Press o n it to see your font list. 



This list doesn't pretend to be an all-inclusive re ference 
for every sort o f catastrophe that may befall; rather, it is 
just a compilatio n of the most common, simple problems 
one may encounter when first beginning to work on a 
Macintosh. 

If the computer doesn't turn o n, check all your switches 
(when the switch is labe led I or 0 , the I means On): 

.., If you have a noor surge-protector bar wit.h an 
on-ofT switch, it may have been kicked to the 
o.ffposition-make sure it is on 

.., If your hard disk is external, it has its own on-off 
switch that must be turned on first so it can boot 
up; the n the Mac must still have its own switch 
turned on also. 

"If your computer has a fan unit on top with 
buttons to push, those buttons still won ' t work 
unless the switch on the back of the computer 
is also o n. The button on the le ft of the hm unit 
typically sta rts the Mac, while the button on the 
right will SLart your hard disk (hut the hard disk 
itse lf should be turned on first) . 

.., If you have any other devices attached to your 
computer, such as a scanner, hard disk, or CD-ROM 
player, sometimes t.hey must be turned on first. 

You're trying to start your computer and Mac just spi ts 
out your disk and/ o r gives you a big X. This usually 
happens because Mac can ' t find the System Folder. If 
you are using an externa l hard disk, make sure the ha rd 
disk unit itself is turned on, as well as any extra switches. 
If you are using a noppy disk, the disk you are inserting 
does not have a System Folder on it. Or it may h ave a 
System Folder, but the System Folder doesn't contain the 
Syste m icon and/ or the Finder icon. Both icons must be 
on t.he disk; and actually, bo th icons must be in the same 
folder and Lhe fo lde r really should be named "System 
Folder" or confusion may result (eve n on a hard disk). 
Also, if there are any other devices attached to the 
computer, they sometimes have to be turned on first. 

CHAPnR TwENTY-Two 

What To Do If: 

: The Computer 
Doesn't Turn On 

· You Get the 
: Flashing X, or 
. the Disk 
· Gets Spit Out 
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HELP I 

The Screen Occasionally the computer screen just up and freezes. 
Freezes The pointer may move around, but you can ' t click on 

anything and it doesn ' t respond to the keys. Most often 
this is the resu lt of static e lectricity. You can try pressing 
Command Period, but it usually doesn 't help. Frankly, 
you just have to turn tl1e machine off. Yes, you '~ill lose 
everything that hasn' t been saved, which is one of the 
reasons you should SOS (Save Often, Stupid! ... er, 
Sweetie!). 

Can't Find In the beginning you may very often save a document 
Your Document dutifully, but then when you get to your Desktop you can't 

find it anywhere. T his is because when you saved it you 
weren 't paying attention into which disk and/or folder you 
were saving the document. Be sure to read tJ1e chapter on 
Saving (pages 51-53, as well as 35-36), and carefully look 
at the dialog boxes pictured there so you understand 
how to save fi les where you can find them again. 
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Can't Open 
a File 

i 14 itt-ms 

This symbol indicates . 
the dish is loched. 

"Not enough 
memory". 

to opm a file? 
See jJage 140. 

Anyway, at the moment you can 't find it. Never fear , Mr. 
Find File can take care of it! Read about this guy on page 
83-he' ll go get your file and hand it right over to you. 

When you find your document, put it in a fo lder you 
have created (page 33),just as if you were going to put it 
in a fi le folder in tl1e fi ling cabinet. Press-and-drag the 
document icon over to the folder or disk of your choice. 
T he folder/ disk should turn black; whe n it's black, let go 
and the document wi ll drop right in. 

Sometimes when you click o n an icon you get a message 
that tells you the fi le is locked or in use, or maybe that an 
application couldn't be found. 

If the disk is locked, you ' ll see a little lock symbol in the 
uppe r le ft of its window. When a disk is locked you can't 
save to it, nor can you print from a locked Syst11m disk (if 
you are one who sti ll works from a floppy System disk). 
To unlock a floppy disk, first ej ect it. In one of tJ1e corners 
is a little black tab that covers or uncovers a hole. When 
the hole is open, tJ1e disk is locked (seems backwards, 
doesn't it?). So to unlock it~ switch the tab back so the 
hole is closed . (.\1ore info on page 9.) 

If the file is locked, click once on it and choose "Get 
In fo" from the File menu. In tl1e upper right corner 
there is a little box called "Locked" that may be checked . 



If that box is checked , then click in the box to unchcck 
it and thus unlock the file. 

If the file is in use, the n it's in use. Usually you get 
this message if you try to open an icon that looks like 
a Macintosh ; Mac icons are part of the System. 

If it tells you an application can't be found, the n o n e 
of two things is happening: 

• The software application in which you created the 
document is not in the computer . Even thoug h your 
document icon may look like SuperPaint, in o rder to 
view the documen t it has to go into the application 
SuperPain t to create itse lf. 

• Some fi les can not go straight from the Desktop 
to the application , even if the ap plicatio n is in th e 
compute r a lso. In this case, if you know the docu
ment was created in a certain application and you 
know that particular application is in your machine, 
then you must. go into the afJfJlication itself (do uble
click o n its icon) and open tJ1e file you want from 
inside, choosing "Open " from the File menu. 

When trying to view clip art, often you will get the 
message that "An application can't be found," eve n 
when tJ1e program it was generated in is on the disk. You 
need to open the actu.al afJfJlication itself, then open each 
individua l docume nt through the File menu, ch oosing 
"O pen" (such as MacPaint, or SuperPaint '"~th the 
MacPaint butto n selected in the Open box). 

If you are experi encing system bombs too regularly, 
the most common reason is that you have more than 
one System in your computer . One System is essential; 
two Systems is too many. Even though you don 't see 
something called System Folder right there on your 
Desktop d oesn 't mean you don't have one tucked away 
in the depths of several other folders somewhere. 

If you have a hard disk, don' t use a floppy that also has 
a System on it. If the document you need is o n a fl oppy 
that also con tains a System Folder , copy the document onto 
your Izard dish, tject the floppy, and open the document from the 
hard disk; you can copy the revised fi le back onto the 
floppy wh en you ' re done. 

HELP I 

: Viewing 
Clip Art Files 

· System Bombs 
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HELP I 

Find any · An easy way to find all the Systems on your hard disk and 
extra Systems · on any floppy disks you are using is to ask Mr. Find File 

(read all about him on page 83). Move them all (except 
one- save the latest version!) to the Desktop and throw 
them in the trash. If you ho ld down the Option key while 
trashing them, you can avoid the nice dialog box that 
asks if you're sure you want to do this. Yau wan't be able to 
throw away the System that is booting the machine. That's good. 

Understand, though, th at each System has its own 
collection of fonts and desk accessories. If you have 
customized a System Folder, save that one. 

Out of memory : Running out of RAM is another prime cause for System 
crashes. RAM (Random Access Memory, page 51, 138) 
is the area in your computer where all the information 
is temporarily stored while you are working on it. When 

· you Save, you send that information permanently to the 
disk and thus free up tl1at much space in RAM. If you 
don't save very often, RAM gets full and the Mac just 
checks out (crashes). If you have a lot ofiNITs (page 148) 
or fonts, remember that those get loaded into RAM as 
soon as you turn the computer on. Then your application 
gets loaded into RAM. Then as you work, there is not a 
great deal of room left. So the moral is: Save often. If you 
run out ofRNvl often, buy more (in the form ofSIMMS, 
page 158). Also decide whether you really need all those 
INITs and fonts and eliminate any unnecessary ones. 

Desktop File is full : If the invisible Desktop File gets too large, you may run 
out of memory (and your computer will work slowly). 

INIT conflicts 

Text FormaHing 
Unexpectedly 

Changed 
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At least once a month you should 1·efmild your Desktop 
(it's very easy; see page 92). 

If you uses I NITs (page 148), keep in mind that it is not 
unusual for them to be buggy, unstable, corrupted, etc., 
especially the free ones. It's a well-known fact that they 
can cause problems, including System crashes. If you 
think one of your !NITs might be a catalyst for bombs, 
take them all out and put them back in one at a time, 
using your computer for several days between adding 
each one. 

It's not uncommon to open you r document on another 
System and find major formatting changes. If you created 
a document on your hard disk using tl1e fo nt Palatino, 



then gave a copy of the docume nt on disk to a co-worker 
who opened it up and found it had transmogrified itse lf 
into the fo nt He lvetica and a ll your formatting was thrown 
off, that's because Pa latino was not in the co-worke r 's 
System. If the document can ' t find the font in which it 
was created, the n it has to choose ano ther from what 
is available. T he solution is to make sure both Systems 
have the fo nts. 

Misformatting may happe n occasio na lly eve n if the fo nts 
are the same in bo tJ1 Systems. An othe r possible reason 
for this is that some progra ms create a fi le in the Syste m 
Folder that holds the formatting for th e documen t. When 
you open up the document with a different System Folder, 
it can 't find that document's formatting. If you know you 
are going to be taki ng the documcm to anot.her compulCr, 
as soon as you quit creating it, go into the Syste m Fo lde r 
and find the formatting file; e.g., Word Settings ifyou arc 
using Microsoft \No rd . Rename t.ha t fi le to correspo nd 
v.rith the fi le you just created (th ough not exactly th e 
same name), and pu t them both in the same folder. 

... One of the most commo n reasons why prin ting wo n ' t 
work is because th e ap propriate printer icon wasn ' t 
chosen. Go to Chooser fro m the Apple menu and 
choose your printer (see pages 56 and 81 ) . 

... Make sure th e p rinte r is o n, th at it has paper , and 
tha t the paper tray, if there is one, is firmly a ttached . 

... :\1ake sure any networking cables are connected . 

... On a n Image Writer, make sure the Select light is on. 
It must be o n in o rder to print. 

... AJso on an ImageWriter make sure the lever on the 
hand rolle r correspon ds to the way you are feeding 
paper-tha t is, friction-feed for single sheets (that's 
the symbo l with two rollers, towards the back) ; a nd 
pin-feed for pin-fed labe ls and pa per (tha t's the 
symbol with o ne roller and li t lle p ins, pulled towards 
the fro nt) . 

... If the disk tha t the System Folder is on has less than 
about 15K ava ilable, Mac cannot print. She needs 
some free space to send over the messages for 
printing. Yo u will have to free up some space o n 
that disk by re moving a file or two. 

HELP! 

Printing 
Doesn't Work 
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HELP I 

Can1t Form-Feed 
or Line-Feed the 

lmageWriter 
Paper : 

There1 s Garbage · 
Hanging Around · 

Outside the · 
Trash Can 

"'Sometimes gremlins prevent printing properly. If 
you have checked everyth ing and there really seems 
to be no logical reason for the file not to print, go 
away for a while, let someone e lse print to that 
printer, shut down, come back later, try agajn. This 
sometimes works. One never knows. 

"'Unusual printing problems are a common symptom 
of a virus attack. See page 163 for a brief explanation 
of viruses. If you think you have the vVDEF virus, read 
about rebuilding your Desktop to destroy it, page 92. 

If you want to form-feed or line-feed the paper, the 
Select light must be off. Be sure to turn it back on again 
before you try to print! 

Notice that the line-feed button will feed the paper 
through one line at a time for four lines, then it turns 
into a contro llable form-feed; as soon as you le t go it 
stops. Form-feed itselfwill roll through an entire page 
length (generally 11 inches). 

If garbage piles up around your can, it's because you 
didn ' t put it inside the can, but set it down outside, just 
like the kids. When the very tip of the pointer touches the 
can and turns it black, that's the time to le t go. It doesn't 
matter if the icon you are throwing away is jJositioned over the 
can-it's the pointer tip that opens the lid. 

A gray disk icon can mean one of two things, e ither 
it is open or it is in RAM. 

Gray Disk Icon 
is Left on the 

Screen . If the disk itself is still in the floppy drive, then the 
gray shadow only means that you have already double
clicked on it and its window is open somewhere on the 
screen. If you can' t see the disk's window because there 
are other windows in the way, simply double-click on the 
gray shadow and it will come forth as the ac tive window. 

-

· If the disk itself is not in the floppy drive , then you 
: ~ost likely ejected th~t disk by choosing "~ject" from the 
. File menu or by pressmg Command E. Thts procedure 

Gray disk iconlejl o1ttlte . does eject tJ1e disk, bur also leaves its information in the 
screen after being ejected · Mac's memory'. Read page 61 for an explanation of what 

happened and how to avoid it. 
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You've heard about it. Do you want it? Do you need it? 
You may have it. If you don 't, should you get it? Is it 
worth it to become, as they say, System 7-savvy? 

System 7 
Savvy? 

PART II 

\<\'he ther you should make the upgrade to System 7 
depends o n what kind of Yfac you have and what you 
want to do with it. You need a Mac with a hard disk and 
(they say) 2 megabytes of RAM . That includes the bigge r 
machines like the SE/ 30 and the Mac n family, and it can 

include even a Mac Plus or a Classic. (RAM is different 

Do You Have 
: What It Takes? 

than your hard disk storage space! A typical SE has a 20 
or 30 meg hard disk, but on ly I meg ofRAM. For RA!vl 
info, see pages 51 and 138.) 

How can you te ll how much RAM you 've got? Use the Apple : 
menu and choose "About the Finder" (if you' re running 
System 7, it' ll say "About This Macintosh"). You 'll see 'Total 
Memory"; if it says 2000 or more, you've got the RAM you 
need to run System 7. If you happen to want to run apjJlica
l ions as we ll , such as your word processor or page layout 
program, you need more RA.M . With 2 megabytes you can 
run System 7 and probably th e Calculator desk accessory. 
Realistically, yo u need a minimum of 4 megs of RA!vl. 

As for whe ther you want it rig ht now, conside r these Do You Want It? 
questions: Do you have a hard disk v.rith at least 4 megs of 
RAM? Do you understand and enjoy using MultiFinde r, 
where you can run several programs at the same Lime and · 
switch between them? Are you part of a work group that · 
shares docume nts on a ne twork? Do you have several 
computers in your home o r offi ce that you would like to 
network (share fi les)? Do you like being able to customize. 
your Mac and tinke r v.rith how things look on the screen? 
Do you have fun with sounds? Are you fanatical about 
keeping up lvith the latest, even if it's not really necessary 
and even if it means you 'll have some inconvenience for 
a while until all your applications, ! NITs, CDEVs, and desk 
accessories make the upgrade? If you answer yes to all of 
these, System 7's probably for you. It's actua lly not that 
much differen t-just a few mo re bells and whistles. 
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PART II • System 7 

Are Your Current 
Applications 
Compatible? 

System 7 comes wi th a "compatibili ty checke r"-a Hyper
Card stack that wi ll check your hard disk and report back 
if you have any programs that aren't compatible with it 
(which means, of course, that you must have HyperCard 
installed on your hard disk to run the checker). 
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Apple classifies programs into three categories: 

• System 7-dependent programs need System 7 to 
run. They won't work if you're using an earlier System. 

• System 7-friendly programs can run under either 
System 7 or an older System, and they have some new 
features like Balloon Help that work only if you're 
running System 7. 

• System 7- compatible programs run under either 
kind of System, but they don ' t have any of System 7's 
new features. 

How to Get It · You can get System 7 from your computer dealer, usually 
for about $99, wh ich includes documentation. You can 
also get it (cheaper) from a user group like BMUG 
(Berke ley Macintosh Users Croup) at (415) 549-2684 
or the Boston Computer Society/ Macintosh (BCS/ Mac) 
at (617) 625-7080. If you' re not near the East or West 
Coast, call Apple at (800) 538-9696 for the number of a 
user group near you . You can download it off a bulletin 
board service, if you don ' t mind tying up your phone for 
hours. If you don 't pay the $99 you don ' t get the docu
menta tio n, but you can get The Little System 7 Book for 
o nly $12.95, by Kay Yarboroug h Nelson , which is be tter 
than the documentation anyway. 

What To Do System 7 comes on an in timidating ten disks, but two 
With It · of th em are previews of what you get. The "Before 

. You Install" disk will give you a tour o f System 7's new 
· features (via a HyperCard stack) and will also check your 

hard disk and report whether you have any programs 
that aren ' t compatible with System 7. The "Networking 
Basics" disk is an overview of (you guessed it} networking 
concepts like fi le sharing; if you aren ' t on a network, you 
don ' t need it. So you' re left with only eight disks to deal 
with, and the Installer program will take care of most 
of that for you. Just put the Installer disk in your floppy 
drive, double-click the Installer icon, and choose Easy 
Install. 



BRIEF 
OvERVIEW 

System 7, of course, has a number of interesting features 
that earlier Systems don't have. T his chapter contains 
a brief overview of the main features. The following 
chapters elaborate on some of the biggest and most 
important of these. 

Although a lot of the new features aren' t visible at first, 
you will see some differences immediately on the Desk
top screen . For instance: 

The men u bar isn ' t quite the same;see page 113. 

ti File Edit Uiew Lobel Specl81 (1) (!l!l ) 

Mud Dhk , ..... ., ..... ,,.. , ...... ,. ---------
Windows, when viewed in a list, 
offer more information. If your 
windows don 't look exactly like 
this one, it's because the 
viewable info is customizable; 
see page 123. When you view a 
window as a list, you see little 
triangle icons; see page 109. 
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The System Folder has 
many new and impor-
tant folders, plus some 
new icons for o ld 
favorites; see page 119 . 

•

- Icons get a box around their titles when they 
are ready to be renamed; see page 112 . 

LJ becomes -~ 
Robin • Robin 

Icons can be customized , 
like this one; see page 11 2. 

You may see aliases of any 
sort of fi le; see page 127. 

C HAPTER TWENTY· THREE 

Several 
Immediate 
Visual 
DiHerences 
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BRIEF OvERVIEW • System 7 
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Switching 
Programs 

(MultiFinder) 

The ApplicatiO?l 
menu. 

Aliases 

Label Menu 

Find File 

Help Menu 

C1) 

· In System 7, you are always running under Multifinder. 
: This is probably the biggest single change for users, 

especially those who have never used it before. On 
earlier systems you can choose to run under MultiFinder, 
but on System 7 you have no choice. 

MultiFinder allmvs you to open mo re than one program 
at a time. For instance, you can open PageMaker to 
create a publication , then bounce into SuperPaint to 
make a graphic for the publication , without having to 
qui t PageMaker. 

The little icon in the upper right corner of the menu bar 
· is the Application menu. When you press on tl1a t icon, 
: you will see a list of all the programs that are open at tl1e 

momen t, and you can choose to go to another one. See 
Chapte r 31, page 1137, for details. 

An Alias is a Tej.rresentalion, or fake duplicate, of an 
original fi le. Aliases let you store items where they're 
easiest to get at, ra ther than having to dig deep into nests 
of folders. You can put represen rations of your word 
processing program in several differen t folders or even 
in the Apple menu. (Yes! System 7 lets you customize tlle 

: Apple menu. ) See chapter 28, page 127, for full details 
o n aliasing. 

The Label menu provides labe ls you can apply to icons 
that a llow you to organize projects or group files even if 
they are not in the same fo lder. You can search for all 
the icons that belong to a particular labeled category, 
like "Love Letters" or "Business Correspondence" or 
"Top Secret Star Wars," etc. See Chapter 25, page 11 4. 

Find File is in the File menu now as "Find .. . " (instead 
of "Find File " on the Apple menu) . H e doesn 't tell you 

· where your file is; he actually gets it for you . He has some 
· great new search capabilities. See Chap ter 29, page 131. 

The Help menu is on tlle far right of the menu bar, 
identified by the question mark icon. When you choose 
"Show Balloons" from the Help menu, you will see little 
balloons filled lvitll in formation as you move the pointer 
across the screen. T here is a separate balloon for each 
item you point at. See page 11 6. 



System 7 .., BRIEF OVERVIEW 

T he Trash Can does not empty automatically as soon as · The Trash Can 
you do something else, like copy a fi le, ej ect a disk, or ({fj))()) 
shut clown your Mac. ·whateve r you put in the can stays ~ 

there, even ifyou turn ofT the computer, unti l you choose Trash 

to empty the trash . 

You can double-click on the Trash Can icon to see what's 
in there. just d rag a trashed fi le back ou t if you decide 
that you really want to keep it a fter all (or select the icon 
and press Command Y to have it Put Away for you). 

When you choose Empty Trash from the Special 
menu, you ' ll see a warning dialog box. It asks if 
you ' re sure you want to empty the trash and te lls 
you how much stuff is in there. 

~ Tho Trnsh conlalns 8 Items. which use 
~ 4StJK of disk space. Are you sure you 

want lo permanently remoue lhese 
Items? 

If you don't want to see this dialog box, ho ld down 
the Option key while you choose Empty Trash. O r you 
can suppress the warning pe rmanently (until you choose 
to lllrn it on again): 

.., Select the Trash Can icon (cl ick once o n it) . 

.., From the File menu, choose Get Info. 

.., Click the "Warn before emptying" checkbox 
so there is no check in it. 

.., Close the Get Info window (click in its close box 
or press Command W). 

Desk accessory icons can be kept anywhere you want, 
notjust listed in the Apple menu. If you double-click o n 
a sui tcase that contains desk accessories, you 'II see that 
in System 7 each desk accessory has its own icon. You can 
double-click an icon to use that accessory. T o install it in 
the Apple menu, j ust put the icon in the Apple Menu 
Items folder , found in the System Folde r (tha t's right
you don 't have to use the Fo n t/ DA Mover). See page 11 3. 

T o install the Truelype fonts th at come with System 7, 
or to install any othe r type of font, just drag the ir icons 
into your System fi le (like desk accessories, each size fon t 
now has its own icon; the icons just appear whe n you 
do uble-click the suitcase while in System 7). T rue Type 
fonts look good on the screen at any size, and they look 
good in your printed documents, too, eve n when printed 
on an ImageWriter or an inkjet printer. For the detai ls, 
see Chapte r 30, page I 35. 
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B RIEF O VERVIEW ... System 7 

Desktop 
(Finder) · 

W indows · 

Dia log Boxes 

Saue publlca llon as Gill 

System 7-style windows are di rleren t a t the Desktop. If 
you' re viewing by Name (or by any othe r choice except 
Icon or Small Icon) , you' ll see a little triangle to the left 
of each fi le. You can click o n the little triangle to see 
what's in th e folder withou t opening a new window. This 
lets you find fi les without having to open a lot of windows 
on your Deskto p and getting lost in the clutter. It also 
makes copying and moving fi les from folde r to folde r 
a lo t easie r because you can pu ll items out of seve ral 
d iffe rent folders at once. Sec Chapter 24, page l 09. 

System 7 dialog boxes often display a downward
poin ting arrowhead in the ti tle above a list to indicate 

00 tha t a pop-up menu is lurking underneath 
~...,_ {Dosk lop ) I C~:~ncol ) (in addition to the standard visual clue of 

11 1.1 1 
0 7.1 1.1 
{) .... , 1.1.'b011 
f" i'.l 1.1 :mrn u 
0 lJ · I.1 :m•nu(t) 
D 2l · l.~:eppM .. nu 

] ~"'"'"'" Snutl at: 
® Publication 
Q l emplal e 

a shadowed border). 

There is a button in dialog boxes called 
"Desktop" instead of "Drive." To view th e files 
that are on the Desktop level (also known as 
level, see page 13) , cl ick the "Desktop" button Notice the arrow, 

dicatin g this tWe 
is also a menu, 

as shown below. 

-0 Copy lin ked documenh 

the Finder 

once . At th is level you see the T rash Can , the icon for 
your hard disk, any fi les you have stored ouL~ide o f a 
wind ow, and any fl oppies in your fl oppy disk drive. To 

rr=====~=======9 get into the floppy disk, J·ust double-click on 
Saue publica lion., ~ CE:J 

_ ,_ the name of the disk shown in the lisL You can 
[De U:Iop) I Cance l I 

g ~ ~ - : . ~ ~~~~~c~~~~~:ot.2e ~ •tud Dht choose to Save a fi le directly onto your hard 
g ~~ :: :::::.~;· •• ., chi ve's Desktop, which means it will not be in 
~ ~~ : :,~ ••• ,........ l<>J o;:~!:::~· any folder, but right there on the screen. 

ll tii!HQf.lllb!ii 

Snue publlcntlon ns 

!ell ort '"'I 
Ll 23· 1 
0 23·1.} 
[: 23 · 1.~!bDII 

0 Copy llnted documenh 
Many dialog boxes will also have a button called 

"New Fo lder." This is wonderful! If you forgot to create a 
file folder before you started working on the project (as I 
explained on page 35) , you can create a folder from within 
the application, then save your files right into it. 

•
' T he list box itself gets h igh ligh ted wi th a double 

borde r whe n you click in it, press on its menu, or 
o press the Tab key. Whi le the list box is selected like 

this, you can type the first lene r (or first couple of 
ll2J · 1.'1 .-nu·nu 1 ·r· ) r· " I • 1 h 
0 zj t A! m•uu!ll e tters, 1 necessaJ) ' o a 11 es s name to se ect l at 

~~.o.._..z.._.i ·-•,.-~_'•,.P.-PM_..•·•,.•u_....~..ao fi le. Press the Tab key again to highlight the name 

j.llttleMoc/ port3 ed it box so you can type a name to r a new fi le. 

Notiu the dottbh'-bordt!r Notice tl1at the dark-bordered button changes from "Save " 
around tlte list box. to "Open " or "OK ," depending on wha t is selected. 
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OK, so maybe this isn ' t a change in a basic technique, 
but it's fun. 

• To switch the Puzzle from the Apple logo to the 
numbers, choose "Clear " from the Edit menu whi le 
the puzzle is active. Choose "Clear" again to get the 
Apple logo. 

• To view the finished puzzle, choose "Puzzle" 
from the Apple menu . 

• From the Edit menu, choose "Copy." 

• Put the Puzzle away by clicking in its close box 
(or press Command W) . 

• From the Edit menu, choose "Show Clipboard" 
to see the comple ted puzzle. Press Command \o\1 

to close the Clipboard. 

• To paste different new pictures in the Pu zzle 
to entertain your kids or yourself: 

• Create a graphic in your painting or drawing 
program, or open some clip art or the Scrapbook. 

• Se lect the graphic and copy it. 

• Quit the graphics program or close the Scrapbook. 

• Open the Puzzle . 

• From the Edit menu, choose Paste. Zap. A whole 
new Puzzle. 

• To get the original Puzzle back, choose "Clear" 
from the Edit men u. 

You can print the contents of the active window or of the 
entire Deskto p to any printer. Both of these techniques 
listed below are great for when you want to keep track 
of the contents of a folde r, of the Desktop, o f )'Our filing 
system, rather than writing it all down by hand. You can 
open the window o f a fl oppy disk, print that window, 
then cut out the printed list and attach it to the disk. 

• Print the contents of the active window (th e o ne 
with stripes in its title bar): Click on th e o pen window 
you wan t to print. T hen from the File menu, choose 
"Print \o\1indow .. .. " 

• Print a picture of the entire Desktop: Click on the 
Trash Can or on any icon that's at the Desktop leve l 
(or press Command UpArrow) to select the Desktop . 
From the File menu, choose "Print Desktop .... " 

The Puzzle 

7 15 ' ' 6 5 12 14 
I • " z • 10 II 

17te complelell 
Af>j>le logo 
fmzzle. No, I 
didn 't cheat; 
I really did it. 

The numbers 
puzzle. 

When )'O!t 

solve a fmvle, 
a little man 
congratulates 
you, shouting, 

"TaDa!" 

• 

A mstom-made 
puzzle. 

• 

Print the Window 
or the Desktop 
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Stationery Pads 

[I Q 
FaxCover FaxCover 

O il the 1ight is a . 
stationny jJad made f rom . 

the original PageMaker . 
document on the left. 

~ faMt ouer l nro _. 

[I f •:.tCto¥w 

IC .... : P•1"f'l .. rt401*""'-t 
8 lu: ~- •M'tt2J.2'6~ trt~n..l) 

~: tW"4 Pt•• RWft: 

te--utM: 'hru, .M t:S, .,'J1,12.GIP't1 
ptMif'W: lhu, .M 11, 19't1,12.ot,., ........ ,,.,. 

c:-.-t. : 

I I 
Ot.-b 4 r .h . ....._,,.. 
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Click this 
button to 
create the 
I em p wte. 

A few 
Extra Tricks 

' • 

You can make a template out o f any docume nt System 7 
calls it a stationery pad. When you make a stationery 
pad out of a document, the icon looks like a sheaf of 
pape rs, as shown on the right. When you double-click a 
pad to open it, you ' ll first ge t the dia log box shown he re 
so you can give the new file 
a narne and choose \Vhere ~:~ hdeouc~:~~8!1~1 :~a!~~:~~:ad, so a 

you want to store it The 
origina l template, or 
statio nery pad, remains 
unchanged, so you always 
have a clean master copy. 

Type e nome ror the new document: 

) dll( 0111'1 . I UIJII 

I Soue ln ... ) I 

Yo u can create a stationery pad fo r any document 
through its Get Info d ialog box. At the Desktop , select 
the documem, p ress Command I, and click the checkbox 
at the bottom of the Get Info window. The document 
itse lf turns into the statione ry pad. If you don 't see the 
checkbox, then you can 't make a template out of that 
fi le. You cannot make templa tes of applications, folders, 
e tc. Just documen ts. 

Eventually all programs wi ll h;we 1he opl ion to 
create a stationery pad buil t right into the Save 
dialog box. It will look like this one shown here, 

( Sou~ ) 

ol:J ®a 
from T eachText. To create the pad , click the icon that 
looks like a sheaf of papers. 

If you hate to turn on a Mac and see open windows lying 
all ove r the place, then hold down the Option key as you 
start the computer. All windows will be closed when 
you get to the Desktop. 

IN ITs and CDEVs often cause problems with Systems. If 
yo u have a suspicion one may be giving you grief, disable 
all extensions (!NITs and CDEVs) as you turn on the Mac 
by ho ldi ng down the Shift key as you start. O r hold the 
Shift key as you choose "Restart" from the Special menu. 

This is terrific: eject a disk with a keyboard shortcut and 
leave no thing in memory (see page 61 if you do n't know 
wha t I'm talking about). 

,. Select the disk (click once on it) 

,. Press Command Y. This is ac tually the keyboard 
shortcut for the menu command "Put Away." 



• System 7 • BRIEF OVERVIEW 

Some of System's 7's features a ren' t visible, and some of Pubs and Subs 
them have to be added to programs by the software 
manufacturers the mselves. So t.he features you see will 
depend o n the programs you use. For example, some 
programs can take advamage of a great fealure called 
Publishers and Subscribers t.hat will auto matically find 
and appro priately update othe r re lated documents. Say, 
for example , you created a spreadshee t showing the 
April expenses for the bed-and-breakfast inn that you 
run. Yo u want to put the spreadshee t. data in a letter to 
your bank lo show them what a great fin ancial manager 
you are and thus gel a bigger loan. You also want to put 
it in a letle r to your cousin Ralph to convince him that. 
right now is not a good tim e fo r him to move in wil.h you. 
If your spreadsheet. program and your word processing 
program have Publish and Subscribe in t.he ir File menus, 
you can "publish " the spreadsheet. and t.hc n "subscribe" 
to it in a ll the diO'erentletlers. ff you later go back imo 
your spreadshee t program and change lhe origina l 
numbers, the data will automatically change in the letters 
that subscribe lo il. Wow. 

If you're part of a network, sharing files with other Sharing Files 
people on the network is much easier . Yo u can store a 
program on one compu ter, yet someone on another 
computer can use it (read your license agreement). Yo u 
can decide exactly who gets 1.0 see which files. You can 
lock fi les so no one can snoop. You can set up "drop" 
folders, like a message drop, 1.0 exchange messages with 
everybody on the net You can access your own compute r 
from som eon e e lse's. You even gel to use passwords. 

If you have two o r more Macs in your home or office, 
take advantage of t.he Mac's buill-in net.working fealure. 
Just get a Loca1Talk kit (or the Phonel'\et. substitule) 
from your favorite mail-order ho use, and plug in the 
cables. Then gel The Little Syste-m 7 book and let Kay 
walk you through t.he steps of seuing up and operating 
your network. 
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Virtual Memory With virtual memory, your Mac can use extra space o n 
your hard disk as though it were RAM (see pages 51 and 
138 for info o n RA:'v1). It means you sudden ly have more 
space for opening more programs simultaneously 
(MultiFinder, page 137), for working with large graphics, 
e tc. Only certain Macs can take advantage of this. 
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End of Brief That's the fifty-cent tour of System 7. Keep on reading 
Overview for a closer look at its biggest new features, but remember, 

this is just an inu·oductio n. Peach pit Press has a great 
book, Tlu' Lillie System 7 Booh, that you might want to read 
if you really want to get to know System 7 in greater depth . 



System 7's Desktop, at first glance, looks just like any 
other System version's Desktop, especially ifyou're 
viewing windows "by Icon" ("viewing" info on page 25). 
You will see fancy new three-dimensional icons, though, 
if you have a color or grayscale monitor. And if you view 
any window "by Name," you 'II see some big changes. 

The format for viev.ring the contents of windows when 
you choose some sort of list (by Name, Kind, Size, etc.) is 
called outline view. There's a tiny triangle next to each 
folder's name, and if you click on that tr iangle you will 
see what's in that folder. The items contained within a 
folder are indented just a little from the left, as in jimmy's 
folder shown here. 

You can just keep opening folders v.rithin folders until 
you are a ll the way to the bottom of your filing system , 
with everything displayed in the same window. (If you 
accidentally double-dick on the folder's icon instead 
of single-clicking on the triangle, you '11 open a new 
window showing what's in the folder, j ust as in earlier 
Systems o r just as in the Icon view.) 

You can see at a glance exactly how your files are organized. 
You can move items from one folder to another, even if 
the folders are several levels apart. You can Shift-click 
(page 38) to select items from any number of different 
folders. 

To expand, or open a folder, single-click on the little 
sideways-pointing triangle (or select the icon and press 
Command RightArrow). 

To compress or close a folde r, single-dick o n the 
downward-pointing triangle (or select the icon and 
press Command LeftArrow). 

CHAPTER TWENTY-FOUR 
. ~r .. .-m,..a~ .... aaw.ullla 

System Clipboard 
: Fancy gra)•scale icons. 
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Selecting Icons 

' • 

Zoom Box 

Scrolling 

Active Windows 
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Window 
Shortcuts 

· While viewing a "'~ndow in one of the list views (by Name, 
· Date, Size, etc.) , you can drag to select files that are next 

to each other. Press in a white space in the window next 
to a file name and start to drag. The selection marquee 
will appear when·you drag, and any item that is even 
partially enclosed within the marquee will be added to 
the selection. 

To select any icon (no matter how you are viewing 
the window) , just type the first letter of the name of 
the file and you ' II be taken right to it. If there are 
several files with the same first letter, quickly type the 
first couple of letters. This makes it a lot easier to find 
your Word folder in an alphabetized list, for instance. 
Or a fil e that starts with Z. Or any icon in a crowded 
folder. You can also use the arrow keys to select files. 

When you click in the zoom box (upper right of the 
window, see page 22), the window "'~ II only zoom open as 
large as it needs to be to display all the files. If you want 
to open the window to as large as can possibly fit on the 
screen (yet still see the trash can), hold the Option key 
down as you click in the zoom box. 

The '1-\~ndow will scroll as you drag an icon \vi thin it. When 
you let go of the mouse button, the icon will pop into 
the nearest space in the window. Press the arrow keys to 
select icons, which will in turn scroll the window as well. 

When you click on an item in a '1-\~ndow that is not active, 
the window doesn ' t become active until you re lease the 
mouse button while the pointer's still in the window. This 
subtle change makes it easier to move and copy items 
that are in different windows; that is, you can grab an 
icon from an inactive window and drag it into anothe r 
window without the first window popping up to the top 
layer. (Make sure you press on an icon, though; if you just 
click in any blank space in the window, the \'Iindow "'~ll 
immediately become active and pop to the top.) 

There are a great number of tticks you can use to 
manipulate the windows at the Desktop (Finder). In fact, 
there are so many that Apple has provided several H elp 
screens describing them, including more keyboard 
shortcuts than you can remember. 



To view these Help screens, press on the Help menu (the 
question mark in the far right of the men u bar) . Choose 
''Finder Shoncu ts." 

If you don't see the "Finder Shortcu ts" command, it 
is because you are not at the Finder, or Deshtop, level. 
To get to the Finder, press on the icon in the top far 
right of the menu bar, next to the question mark, 
and choose "Find er." Or, if your n·ash can is showing, 
click once on it. Or press Command UpArrow. 

Here's an example of a Finder window shortcut: 

To clean up aJtd. sort icons Option+ Clean Up .................................................................................................................................. 
This means: If you want to clean up (align) a ll 
the icons that are in the active window and sort 
(alphabetize) them, then press the Option key 
while you choose ''Clean up" from the Special menu. 

Actually, there's a tricky little thing that happens here. 
As you probably already know, you can only clean up a 
window that is showing "By Icon" (whether large or small). 
Option plus Clean Up wi ll sort the icons according to the 
last list view you chose ! That is, if you choose "By Date" 
and then choose "By Icon ," whe n you Option Clean Up 
the icons will be lined up by date! Try it. 

If you are viewing the \Vindow by one of the lists 
(Name, Size, Labe l, e tc.) , you can switch views 
simply by clicking once on another column header 
in the information bar. 

You can also customize the information d isplayed in 
these columns; that is, you can choose to show just the 
labels, or just the dates they were last modified, etc. You 
can also customize the size of the icon that shows in a list 
view, as well as the font. Use th e Views control pane l for 
customizing (see page 123). 

To view the hierarchy af a nested folder, hold the 
Command key down and press on the title of the window 
(not the stripes in the title bar, but the actual title itself) . 
This displays a pop-up me nu, as shown to the r ig ht. 
Choosing another level wi ll open that window. 

Cleaning up 

• • 

Change the View 

• • 
· Click here to change 

the view to Size. 
10 lmmy 
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Renaming Icons To rename any icon-a folder, a document, a program, 

Creating Your 
Own Icons 

~a 
Robin MacP aint 2 .0 . 

No longl!l· · 
boring ol 'folders! · 

Click here 
to select the icon. 

Scorlett lnro --

klM: foUtor 
Olil• : 3K (Jfl <ttdo: (2 ;544 t~~,~tn lotJed), 

(Of' 21tH711 
~ere : HwdOblc ; 

Cru letl : Vt4!,.J.il l,1991, 4 JO PM ....,.,,•411: ~t,.AII 27, 1 991 , 4~1 PH 
c-•••tr: 
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a disk-just click once on the icon's name, not on the 
icon's graphic; then simply type the new name. A box 
appears around the name so you know you're changing 
it. Or instead of clicking on the name, you can select the 
icon and press Re turn to get that box around it. (The 
box and the insertion point do seem to be annoyingly 
slow to appear; be patient.) 

Ifyou rename something by mistake and you notice it 
before you press Return or click the mouse, press 
Command Z to Undo and get the original name back. 

You can create your own icons and apply them to any 
existing icons. This is too cool. Fairly useless, but cool. 

"' Open a graphic program like SuperPaint or MacPaint. 

... In the graphic program, create the little picture that 
you want as your icon, oryou can use any clip art or 
Scrapbook image. No matter what size you make it, 
the Mac wi ll reduce it to an appropriate size as it 
becomes the new icon. (If you create it too large, 
though, it will be unrecognizable when reduced.) 

"'Se lect the image you just created or found; copy it 
(from the Edit menu) . 

... Quit the graphics program. Go back to the Finder 
(press the Application menu in the far right corner 
of the menu bar; choose "Finder") . 

... Click once on the icon you want to replace. From the 
File menu, choose "Get Info" (or press Command I). 

... Select the icon that appears in the upper left of the 
Get Info window (cl ick once on it). 

... From the Edit menu, choose "Paste" (or press 
Command V). 

... Close the Get Info window (press Command W). 

To change an icon back to the original, select its 
tiny icon in the Get Info window and choose Cut 
(Command X) or Clear. 

P*ffi M* t&WM'''MS'*'M*PD'M¥1 1Q!P 



System Ts menus have a few new and interesting features. 

[ • File Edi t Uiew Label Special 

T he Apple menu has tiny icons that attempt to g ive you 
some kind of visual clue as to th e nature of the ite m . You 
can customize your Apple menu by adding items to it 
that you use li·equently. DocumenL~, fold ers, programs
stick 'em in the Apple menu . 

If you place a fo lde r in the Apple menu, selecting it from 
the me nu wi ll open the folder for you . If you place a 
program in the Apple menu, selecting it wi ll ope n the 
program for you. Desk Accessories: You n o longe r need 
the Fon t/ DA Mover to install desk accessories. Your DA 
suitcase 'Nill open to d isp lay each desk accessory as an icon. 

Follow these ste ps to insta ll any fi le, including desh 
accessories, in the Apple menu. 

• To customize your Apple me nu, ope n your 
System Folde r. 

• T he re is a fo lder in the System Folde r called 
Apple Menu Ite ms. 

• Find and select th e item you wan t to a ppear in 
your Apple me n u ; d rag its icon in to the "Apple 
Menu Items" folder. The ite m V\~ 11 appear in th e 
men u instantly; you don't need to restart the 
computer for it to take effect. 

T he Apple me nu disp lays items alphabe tica lly, as I'm 
sure you 've no ticed. 'When the :viae alphabetizes, blank 
spaces and pu nctuation are sorted in fro nt of any other 
charac ter. So if you add a blank space or a pe riod as 
the firs t ch aracter in a name, that fi le will be first in the 
Apple menu list. T he more blank spaces, the higher o n 
the list it will be located . 

You don ' t have to move the actual fi le into tl1e Apple Menu 
Items folder, since you may need it elsewhere- you can 
move an alias so the mi~:,rinal will stay in its own fo lde r. 
See page 127 for an explana tio n of aliases and more 
suggestions for using them. T hey are really coo l. 

CHAPTER TWENTY- f iVE 

The Apple Menu 

0 fi le Edit llh' w Lobo 
Rllout This Macintosh ... 
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~ Alar m Clock 
.t) Art Brow s er 
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Put ite ms in this folder. 

· Trivia: !-lold the Option key 
· as you press on the Apple menu. 
· Choose "A bout the Finder" to 
· sPP an interesting graphic (it 's 
. actually thegmfJhic for thetJI!I)' 
. first Macintosh Finder) . Wait 
. a minute or two for the secret 
. message. If you hold down the 
. Of!lionan d the Command keys 
. btifm-e you clwostl it, you'll get a 
. rmy intl!l·esthlg cursor in midi
. lion to the secret message. 
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THE MENUS • System 7 

----------------------------
The File Menu 

New Folder lieN 
Open 11€0 
Print ':w 
(lose Ill ill dOW :J::IJJ 

Get Info 11€ 1 
Shoring ... 
lhll>lll:d 1 (~ (:0 

Moke Alios 
Put Awoy lleY 

Find... aJF 
Find ngoln :I!G 

Poge Setup ..• 
Print Desk t op •.• 

The Edit Menu 

The View Menu 

The Label Menu 
, . 

./ None 

114 

Presen1o1ions 
TrueType fonts 
PostScript fonts 
loue l e tters 
Business letters 
l ectures 
TopSecre t 

A couple of new choices have been added to the File 
menu. If you 're on a network, you ' ll be able to use the 
"Sharing ... " command , which le ts you share your fi les 
with other folks on th e ne twork. System 7 comes has all 
sorts of networking features built in to it. lf you' re not on 
a net\vork, the Sharing command may be dimmed so you 
can't use it. See page I 08 for brief information on sharing. 

There's also a "Make Alias" command that lets you make 
an alias of th e item you've selected. See Chapter 28, page 
127 fo r full de tai ls. 

And the re are two hot new "Find" commands on the 
File menu, replacing the desk accessory "Find File ." 
See Chapter 29, page 131. 

The Edit menu looks just like it does in earlier Systems. 
As more and more programs are developed especially to 
run with System 7, you wi ll be able to use the Edit menu 
to cut and copy text even if you have a dialog box open. 

The View menu itself may not look diflerent, but there 
are a couple or new tricks. T here is a new Views control 
pane l that lets you custo mize how you want your Desktop 
windows to look. You can choose a different typeface for 
the icon names, for instance, or a larger type size. You 
can choose what information you want displayed in the 
window, such as folder size and comments. See page 123 
for more d e tails, and page lll for some good tricks. 

T h e Label menu lets you assign labels to icons. A label is 
in {U/dilion to the icon 's name (it doesn't even show up 
un less you choose it to be displayed in a list; see "Views 
Control Panel" on page 123). Labels a llow you to set up 
an alternate syste m of grouping icons that are related to 
each other, but which may be stored in different places. 

For instance, le t's say you are organizing a fund raiser 
and you have a couple of word processing docu me nts, a 
spreadsheet, and a database file all relating to the project. 
You can give each one a label of, perhaps, "Fundraiser." 
Once you have assigned labe ls to icons, you can choose 
to view your window by Label, which groups the icons of 
like labels together. You can also search by label, using 
the Find command (page 131). 



The labels in the menu can all be changed; you certainly 
don ' t have to use the names Apple provides. To set up 
your own system oflabels, use the "Labels" control panel. 

... From the Apple me nu, choose "Control Pane ls" 
(or double-click on the "Control Pane ls" folder 
that's in your System Folder). 

... Double-click on the fi le "Labels." 

... Select an existing label (you can p1·ess Tab to se lect 
each one), then type the name of tl1e new labe l. 

... Close the control panel windows (click in their close 
boxes, or press Command W twice) . The revised label 
list will instantly appear in the Labe ls menu . 

... To apply a label to an icon, simply select the icon or 
group of icons. Then choose the label ti·om the menu . 

... Note: If you apply a label one day and then later 
change the name of that particular label in tl1e 
control panel, all icons with the previous label 
attached will change to me new label! For instance, 
say I labeled 12 docume nts with the labe l "Love 
Letters." If I go to the control panel and change 
"Love Le tte rs" to "Dog Food," every document that 
had the label "Love Letters" will now have the label 
"Dog Food." 

If you have a color monitor, you may notice that there's 
no more Color menu to assign colo rs to icons. Use the 
Labels control panel instead (see the sectio n above). 
Single-click on a color and the n pick a new one from the 
color wheel that appears. 

To assign color to highlighted text and to your window 
borde rs, use the Color control panel (page 124 ) . 

The Special menu looks pretty much the same, but you 
may notice th at the Set Startup command is missing. 

... To choose a diHerent startup disk, use the Startup 
Disk control pane l: e ithe r ch oose "Control Pa ne ls" 
from the Apple menu, or double-click on tl1e "Control 
Panels" fo lder, found in your System. Folder. See 
Chapter 27, p age J 23, for de tails on control pane ls. 

... To have an applicatio n or pa rticula r document open 
on startup, put the file (or a n alias, page 127) into 
me folder "Startup Items," found in the System Folder. 

D IPrutnt,. tlons 

1-llr.-...Typo fonts 
1-IIPostScrlpt font. 

1- IILovt Ltt1trs 

1-lleusinus Lttttrs 

1-IILtcturos 
1-llropS.Crot 

The Labels conlml panel. 

The (Missing} 
Color Menu 

The Special Menu 

• •••• 
Clean Up Window 
[tn(l tq IrllSh 

Ejec t Disk :ICE 
Erase Disk ... 

Restart 
Shut Down 
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Clean Up 

' • 

The Clean Up command on the Special menu has several 
neat tricks. As always, "Clean Up" only works when you 
are viewing "By Icon" or "By Small Icon." 

.. Clean up selected icons by pressing the Shift key as you 
choose "Clean Up" from the Special menu. Selected 
icons will snap to the nearest available spot on the 
invisible grid . 

.. Clean up all icons in to alphabetical order by pressing 
the Option key as you choose "Clean Up." Icons will 
snap into alphabe tical rows with no extra spaces 
between (System 7 does allow space be tween icons 
with long names). 

Actually, it is not always in aljJhabetical order that the 
icons ge t sorted when you do this trick. They will be 
o rganized according to how you last viewed th em in 
a list. Tha t is, if you choose "By Label," then choose 
"By Icon" again, when you Optio n Clean Up the 
icons will be organized by label. Cool. 

.. If you click on one of the items on your Desktop, such 
as your hard disk icon or the trash can (or if you press 
Command UpArrow), then the Special menu will show 
"Clean Up Desktop ." Choosing d1is comman d will 
make all d1e icons (not open windows) on your Desktop 
snap to the nearest spo t on the underlying invisible 
grid. If you press the Shift key first, then o nly the 
selt!cled items will snap to the grid . 

' ... If you press the Option key before you choose "Clean 
• Up Desklop ," then all the icons on the Desktop 'v\rill 

snap over to the far righ t and will line up in alpha
betical order (your hard disk always be ing first and 
the trash can always being last, though ) . 

.. No ma tter where you are or what is selected, if you 
hold the Command key down while you move an 
icon or group of icons, they will jump neady to the 
nearest li ttle cubby in the un derl}ring invisible grid. 



System 7 provides an online Help feature . This is useful 
when you come across something you 've never seen 
before-a strange-looking icon , for example. To get 
Help, press o n the H elp menu, (the questi on mark 
inside the balloon on tl1e far right side of the menu bar) 
and choose "Show Balloons." 

While "Show Balloons" is on, a new balloon appe ars on 
ilie screen as the pointer touches an item. You d on't 
need to press or click to see the balloon- it just appears. 
The text inside the balloon will explain what the item is, 
but not necessarily how to use it. Programs that were 
written especially for System 7 will have their o·wn balloon 
help, so you will be able to point to an item in a program 
to see find out it is, like find out what a particular tool 
does in a drawing program. 

Balloon help can be useful if you 're looking for info rma
tion about a specific item. And it's a nove lty when you' re 
first beginning to explore System 7. But because those 
balloons obscure wha t you ' re looking at and because 
they're so visually distracting as they pop on and o ti the 
screen, you 'll probably want to go back to the Help 
menu and choose "Hide Balloons" as soon as you've 
found out about your unidentified object. The informa
tion they p rovide is pretty wimpy anyway. 

r~ File Edit IJi ~~w Labt~! Spf 
~~'' ''' '' ' '''''' '''' ''' ' ''' 
: ::~ 

Apple menu 

Use this menu to open an item in the 
Apple Menu Items folder , or to see 
information a bout the active 
application or program. You can 
customize the items in this menu by 

1-

I= 

adding or removing items from the F 
Apple Menu Items folder. 

~------------------------~~ 
This is an examfJle of the balloon tha t appears when 
you fJoin t to the Apple menu. 

System 7 ... THE MENUS 

Help Menu 

(1) 

About Bolloon Help •.• 

Show Balloons 

Finder Shortcuts 

W'lum "Show Balloons" 
is on, then this menu 
changes to "H ide 
Balloons." 
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· The tiny icon at the far r ight of the menu represents 
· the Application menu. If you have never used 
: Multifinder before, please be sure to read Chapte r 31, 
. beginning on page 137. T his feature is the single most 
· visible d ifference· with System 7, and it can be incredibly 
· confusing if you don ' t know what's go ing o n. If you are 
· accustomed to using Multifinder, this part of System 7 
· will be very comfortable for you. 

MultiFinder allows you to have more than one applica
tion open at a time, provided you have enough memory 
(tha t's RAM, not hard disk space; see page 138) . The 

. Application menu lists the applications that are open, 
and you can switch back and for th be tween them and 
the Finder. 

For those of you who have used MultiFinder in System 6, 
the re ar e a couple of subtle changes: You must ac tually 
choose the application fro m this menu; you can no longer 

· just click on the icon in the menu bar. Nor are your 
: open applications listed in the Apple menu anymore . 
. You can choose to hide all othe r windows except the 

ones you need at the moment. 



System 7 has reorganized what you see in your System 
Folder--the folder that's in charge of running your Mac 
(see page 11 ). Before using System 7, you didn't have to 
pay much attention to what was in the System Folder as 
long as your Mac was working right, but with System 7 
you need to know just what these new folde rs are and 
what they do because you install a lot of items (like fonts, 
desk accessories, sounds, prin ter resources, INITs, and 
CDEVs) simply by dragging them to your System Folder. 
Each item goes in a particular folder within the System 
Folder, but the Mac will usually take care of that for you 
(see "Installing Items" on page 12 1 ). 

These are some of the icons and fo lde rs you will see in 
your System Folder: 

~0 System Folder 0 § 
32 iloms 61 .9MB in disk 14.9MB avai1ablt 

LID ~ ~ ~ LiJ 
~stom Findt r Scr opbook Filt CUpboord Apple M•nu 1toms 

Preftrtnon Startup lt•ms Control P.a n~ls E>< teons ions 

The System file (the file that actually runs your 
Macintosh) is a little different in System 7. You can 
actually double-click on it to see tl1e list of fonts and 
sounds you have installed in your System. Each font is 
represented by a document icon. You can double-click 
on tile name of a font to see a sample of what it looks 
like, or double-click on the name of a sound to hear it. 

Melue tlc:o--

>~M :=J "-·~,.......,~c... .. -... tl· ........ .,....., 
-------
tt:.•~-psrprg togsantt'ld SJK 

I pq.a:J gyrrmsc1 

, __ ---J 
L _______ _ 

[
,.,..,_ ----
How rozortlack·Jumplng 
frogs can level six piqued 
gymnaslsl 

-- -----· 

77tis is what you will see 
when you open the System file 
(double-dick on it) and then 
double-click on a fontname. 

~ 

1! 
I 
0 

CHAPJER TWENTY-SIX 

System Folder 

llJ 
Sy stt>m Folder 

The Blessed System Folder 

The System File 

• Systt>m 

The System file that 
actually runs the show. 
It must stay in the 
System Fouler. 
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----------------------------The Clipboard 
and the 

Scrapbook 

~ ~ 
Clipboard Scrapbook File 

Control Panels 
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El 
Contro 1 Panels 

Apple Menu 
Items Folder 

w 
Apple Menu Items 

Startup Items 
Folder: 

LillJ 
Startup Items 

The Clipboard and the Scrapbook are stored in your 
System Folder, just as always, although the looks of their 
icons have changed. See page 86 for information about 
the Scrapbook, and pages 46-47 for information about 
the Clipboard. 

The Control Panels folder holds all your control panels 
(yes, there's more than o ne Conu·ol Panel in System 7.) 
These control panels le t you customize your Mac, as in 
changing your Desktop patte rn and setting the mouse 
speed. Because there are some new control panels in 
System 7 and some of the old ones have changed, there's 
an entire chapter devoted to them. See page 123. 

The Apple Menu Items folder contains the icons of 
every item on your Apple menu (the menu on the far 
left of the menu bar). You can put documents, programs, 
folders, desk accessories-anything you like-on your 
Apple menu by dragging their icons to this folder. (No 
more Font/ DA Mover for this!) 

When you double-click o n a suitcase that contains desk 
accessories, System 7 opens the suitcase to a window, and 
each accessory has its own icon. You can double-click the 
icon of any desk accessory to open and use it, whether 
it is stored in the Apple Menu Items folder or not. See 
page 113 for details. 

Any documents or programs that you store in the 
Startup Items folder will automatically open each time 
you start your Mac. This is very handy, for instance, if you 
are busy for weeks on the same project-every time you 
turn on your computer, you can have your proj ect open 
automatically for you. Or you can put your hard disk 
icon in here and then every time you turn o n your Mac 
your hard disk window will open . It's best to put aliases 
into this folder, rather than the originals (see page 127). 
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The Extensions folder holds certain System-related 
icons that he lp run your Mac or your pe ripheral equip
ment. Your printer icons (page 56} are stored in this 
folder. If you have a PostScript printer, you should sto re 
your printer font icons here (page 68}. Most !NITs (see 
page 148} sho uld be stored in the Extensio ns folder. This 
folder also contains utilities that le t you share fi les on a 
network. See "Installing Items," below. 

The Preferences folder con tains files that have settings 
about how your programs think you want them to work. 
You can 't open the icons in this folder because they' re 
created by your programs. Don't worry about putting 
anything in here-the program and System 7 '~'.rill take 
care of that. 

When you're ready to add, or install, something to your 
Mac's System, like a font or a desk accessory or a new 
control panel device (CDEV; see page 144} or an !NIT 
(see page 148},just drag its icon to your System Folder. 
The Mac '\'.rill ask if it's OK to put th e item in the appro
priate folder. Yes, it's OK. Let the Mac figure out which 
folder it belongs in so you don ' t have to. 

!.\ EHtenslons need to be stored In the 
ill Eutcnslons folder In order to be ouolloble 

to the Moclntosh. Put "DislcDoubler'M IN IT" 
Into the EHtenslons folder? 

[ conccl) QO 

Important Note: "''hen installing items, drag the 
new item to the closed fo lder icon (even if it's gray) 
of your System Folder, not to the open window of the 
System Folder. 

LiJ 
Systeom Foldeor 

Drag the icon to the cwsed 
Sy5tem Folder. 

~lt.J 
Syst eom 

Do not drag the icon 
to the Sy5tem filet 
(except. Jonl.s) 

Extensions 
Folder 

LQ] 
Extensions 

Preferences 
Folder 
~ 
LQ=..J 

Preferences 

Installing Items 
into the 
System Folder 
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In System 7 you have separate control panels that let 
you customize the look and feel of your Mac. They're on 
your Apple menu; just choose Control Panels and you' ll 
see icons for them al l. Double-click each separate icon 
to open each control panel. You can also access each 
one directly from the System Folder: double-dick on the 

"Control Panels~ folder. 

The control panel called General Controls is a little 
different than in earlier System versions (see page 81) 
in that the Keyboard, Sound, and Mouse settings are on 
control panels of their own now. Everything e lse that is 
left in this panel works the same as shown on pages 81-82. 

T he Views control panel lets you customize the look of 
your Desktop (Finder) windows. You can pick a different 
font and a d ifferent size in stead of the standard 9-point 
Geneva. (Nearsighted? Try a bigger size.) As soon as you 
make a choice, the Mac immedia tely shows you how it 
looks. You can also choose whether you want your icons 
lined up in rows or staggered. 

To see both lines 
of the infonnation 

• bar (as in the 
• exarnj>le in the 

right column), 
click this checkbox. 

Ulews 

ront tor viows: Ll _;6:.::e.::.ne::U:.::D:.__ __ _:..,.._..I [JEJ 

[

··loon v; • ..,, --·-·--------·----···---·--·--- - -·--- -·-·--····-·-··---] 

D D D D ® s tr.t9ht 9rld 
0 A1Vli,IS ~~to grid 

a 0 a a o s t099 .... .,.,. 

----·-----------·--··-·-·-------------------
-·List Yl~vs -----------·-·---·--- - ·-- ·-·-·- ----·- -·-··----·-·· 

<31 ~ ~ 181 Show,,,. 
~ 181showklnd 

0 0 @ 181 Show ,, .. , 
[8) ShoW' d<~~tt 

0 Cilouhllt.1o1dtr Jtz.u 0 Shov Vtr'sion 

-------;--;-I L...;:::i=i~--~=-~-~~-':..':':_ _____ o_SI>o_:~:::~-----

The bottom portion of the Views control panel lets you 
choose the information to display when you're vie,v;ng 
a window by one of the lists (Name, Size, Kind, etc.). 
It also lets you choose how big you want the icons to be 
when you are in a list view. That is, now you can choose 
to view a window as a list of alphabetized names, yet still 
have each item's ico n attached, as shown on the right. 
I did this by clicking on the button for the largest icon, 
as shown above. 

CHAPTER TWENTY-SEVEN 

Control Panels 

~ 
Control Pan.:>ls 

General Controls 

m 
General Controls 

Views 

Views 

=- Hor d Disk ~ 
12 ttM'II 62 .4 HJII'IIidc 

lima 

~o AWIIo.ll loM 

[I ii'S/p.vll 

II l/'6/p.yt:; 

ll ii"#J1uri.T 

~o ~Kc,lbtl 

~ ~ ... ~ 
~o ..... 
~o So.M-ltn 

~o '""" 

~I]] &lrt"'foldtr 

A r.uJUJ, 

Disk 
info i n 

er head 

This is great- / can have 
. files listed alphabeticaUy 

b)• name, yet still see their 
individual icons. 
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Labels 

[iJ] 
Labels 

Sound 

~ 
Sound 

Startup Disk 

~ 
Startup Disk 

Color 

~ 
Color 
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. ---
· The Labels control pane l is where you set up your 
· labeling system (see pages 114-11 5 for deta.ils).Just type 
. whatever you want as a name for each label. If you've got 

IJD~ Lobels ~ a color monitor, you can choose 

D IPr"utnbtions 

1-J ir...,.Typt fonts 
1-JIPostSulpt fonts 
1- IILovt L•ttws 

1-llsusinus l et1t>t"s 

1-JlLtol~rH 
1-llropStertt 
~------------~ 

different colo rs for each label, too. 

Once you 've set up labels here, they 
immediately appear on the Label 
me nu. Once you have applied labels 
to fi les, you can search for them, and 
you can view a window "by Label." 

To apply a label, simply select the icon or group of 
icons and choose the labe l from the menu. 

10 - Sound -
..... H "'ltrtSculc!s 
y, ..... .. ... :!! 

'I CllniH:Iri ·- Oropl•t ·- "'"'' ·- ........ 
·- """" 2 !!!£." ..!!!!2. 
1 -

VOd[tp 0- {} 

Use the Sound control panel to 
de termine what noise you want to 
hear instead of the beep. System 7 
has some new sounds in its repertoire. 
Click on the name of a sound to hear 
it. The last one you choose before 
you close the control panel is the 

sound the Mac will use when you need to be beeped. 

If you have more than one hard disk attached to your 
Mac, use the Startup Disk control panel to de termine 
which hard disk to use to start your computer_ 

The Color control pane l only works, of course, if you 
have a color monitor. You can choose a color for high
lighted text, and you can choose another colo r to display 
your Finder window borders. Use the Labe ls control 
pane l to change the color of your icons (see pages 
114-115) . 
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The Monitors control panel lets you choose how ma ny 
of the available shades of gray or colors your screen will 
display. It also lets you determine which mo nitor should 
function as your main monitor, if you have more than one. 

Mouse a nd Keyboard haven ' t changed in System 7; 
they' re just separate con u·ol panels now. Sec pages H~-83 
for hints about how you might like to set the m. 

Easy Access lets you use the keys on the num eric keypad 
to move the cursor, instead of using the mo use. lt 's 
designed for people who have problems wi th two-handed 
typing or with using a mouse. It also comes in very handy 
in programs where you want to nudge an o l~jectjus t a 
pixel or two. 

This world map lets you see what time it is anywhere in 
the world and sh ows you the distance between cities. T o 
find a city, just type its name in the box and then click 
Find. You can add your own city to th e map, too. 

Use the Memory control pan el to set a disk cach e for 
your Mac. A disk cac he is a part of the memory your Mac 
uses to hold information abou t the most recent things 
it's done on your disk, like going out and getting fil es 
and saving them. The Mac will set itself to whatever it 
thinks is right, depending on how much memOI)' is 
avai lable. 

You can also use this Memory control pa nel to turn on 
virtual memory and 32-bit addressing if you have a "big" 
Mac like an LC, Ilci, Ilsi, o r Ilfx. 

Monitor 

[g 
Monitor s 

Mouse, Keyboard, 
and Easy Access 

~'''"''''' ~ = 
Mousl' Keyboard 

Easy Accl'ss. 

Map 

~ 
Map 

Memory 

~ 
11emory 
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Networking 
Control Panels 

m 
Sharing Setup 

• Users & Groups 

File Sharing Monitor 

Portable 

~ 
Portable 
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System 7 has several bui lt-in networking features, and 
the re are three control panels that le t you change those 
settings: 

Sharing Setup lets you set your user name, choose a 
password for yourself, and turn on your Mac's ability 
to share fi les over the network. 

Users & Groups le ts you restrict access to your 
computer to specifi c people or le ts everybody see 
what you've been working on. 

File Sharing Monitor shows you what's being shared 
and lets you know just who's looking in your folde rs. 

: The Portable con trol panel is of use only if you have 
a Mac Por table. In fact, you can ' t even open it if you 
have any othe r type of Mac. T his control pane l lets you 
chan ge settings for things like memory, the screen, and 
your modem. 



Aliases are one of the greatest features in System 7. An 
alias is a duplicate icon (not a duplicate file) that represents 
the real thing. O nce you create an alias, you can put that 
alias icon wherever it's easiest for you to use. 

Some applications have to be in the same folder as the ir 
supplemental fil es, like dictionaries or preferences, to 
open or to function prope rly. When you double-click 
on an alias, the Mac actually goes to the original fi le and 
opens the original. Having an alias hanging out o n your 
Desktop just gives you a quick path to th e original fi le. 

Say you have a program you use frequen tly- yow· word 
processing program, for instance. You can make an alias 
ofMacWrite or WriteNow or What-Have-Yo u and put it 
just about an ywhere. H mv about in your Apple menu? 
No problem. Out o n your Desktop? Sure. 

Store an alias of your hard disk icon inside the "Startup 
Items" folder within the System Folder. Then whenever 
you turn on your Mac, the window to your hard disk will 
automatically open. Or put an a lias of the document you 
are always working on into the folder so you instantly 
open to it. Leave an alias of the Chooser on your Desktop 
if you have to change printers often. Leave an alias of the 
"Apple Menu Items" folder open on the Desktop also, so 
you can double-click to access any desk accessory without 
having to go into the menu. And since you can make 
almost any number of aliases of any one tl1ing, you can 
store aliases of your word processing program in folders 
all over your hard disk so you can locate it quickly, no 
matter where you are or what you 're doing. 

You can make a liases of programs, documen LS, desk 
accessories, disks, folders, control panels, e tc. Aliases 
open up a whole new way of organizing your filing 
system; anything you want to use can be o nly one click 
away from wherever you are. 

CHAPTER TWENTY-EIGHT 

Aliases .. 
~ 
AOl. NHl 

This alias sits on my 
Desktop so I can quickly 
pop in to check my mail. 

D 
About This Moclnt osh ... 

t:J UllleMocoook.2e 
~ Alarm Clock 
1m Colcula tor 
~ Chooser 
Q;J Control Panels 
~ DeskPalnt '" .. 
~ Key Caps 
~ Mlcr otek B&W 
~ Moire Idle 
[J Note Pod 
Elll Puzzle 
Ill Scropbook 
~ Sullcose I I !CK 
~ TouchDRSE 

This ApjJle menu has an 
alias of the PageMaker 
document I use for 
invoices; the original 
is nested deejJ within 

· folders. There is also an 
alias of the folder for this 
book I put a blank space 
before its name so it wiY!tld 
appear first in the list. 
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Making Aliases 

0 
Word ~11as 

Making an alias is really easy. 

.., Select the item you want to make an alias of 
(click once on it). 

.., From the Edit menu, choose "Make Alias." 

.., The new alias icon will look the same and will be 
named the same, with the word alias added. An 
alias name is in italic so you can always recognize 
the file as an alias . 

.., Just drag the icon to wherever you wan t to keep it. 
Rename it if you like. The new file does not have 
to have the word "alias" in its name . 

... To put the alias in your Apple menu, drag the 
alias icon to the "Apple Menu Items" folder in 
your System Folder. 

Fine Points Making aliases is easy, but there are a couple of fin e 
points you sho uld understand. 
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"'An alias isn't really a duplicate of anything but the 
icon; it's justa represent.ationofthe real thing. If you 
double-click on an alias of Word, you' ll start your 
original Word program running, even if the original 
Word is stored in a comple te ly different folder. 

... lf you delete an alias of something, you don't delete 
the original: that's still stored on your hard disk. So 
you can keep on revising your filing system as your 
needs change. Don' t want that alias ofMacWrite 
cluttering up your MacDraw folder any more? Fine; 
throw it away. The original MacWrite is still where 
you left it. 

"'You can move an alias and even rename an alias. 
The Mac will still be able to find the original and 
open it whenever you double-click on the alias. 

• If you put an item into an alias of a folder, the item 
actually gets put into the original folder. 

"'Even if you move or rename the original file, the 
Mac can still find it. 

"'If you e liminate the original file, the Mac does not 
automatically eliminate any of the representational 
aliases you created. 
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Here are other ideas for using a liases. 

• If you have a document you use frequently, put an 
alias of it in the Apple menu: just open your System 
Fo lder and drag the a lias into the "Apple Menu 
Items" folder. 

• lfyou have a program or a document that you want 
to open immediately whenever you turn on your 
Mac, put an a lias of it in your "Startup Items" folder, 
found in the System Folder. 

• Put aliases of folders you use often into your Apple 
menu, or leave aliases neatly organized directly 
on your Desktop. 

• Put an alias of a Control Panel that you use over 
and over again out on your Desktop or in your 
Apple menu. 

• Use aliases to store documents in two or three places 
a t once. For instance, you may want to keep budget 
reports in folders organized by montl1s, as well as in 
folders organized by projects. 

Using Aliases 

• Use aliases to find fi les that you keep stored on ' 
floppy disks. Make an alias of an original file; the e 
original file must be on thejlojrpy alread)'. Drag a copy 
of the alias from the floppy to your hard disk (see 
page 37 if you need he lp making copies). When you 
double-click on the alias on your hard disk, you wi ll 
get a dialog box asking for ilie floppy disk iliat contains 
the original file (of course, you have to labe l the 
floppy so )'OU can find it). Since aliases o nly take up 
about 2K, you can keep a folder of all those files you 
use only occasionally but do need to keep track of. 

... Some of the more advan ced uses for aliases aren't 
apparent unless you 're on a network. For example, 
you can make an alias of your file server so you can 
connect to it quickly. And you can make an alias of 
your hard disk, copy it onto a floppy (since the alias 
is only about 2K), and take it to somebody elses's 
computer o n the ne twork. Then you can quickly 
connect back to your own computer just by clicking 
on the a lias on the o ilier computer. The concept of 
this "office-on-a-disk" is another place where you can 
begin to get a glimpse o f the power of System 7. 
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Finding the 
Original File 

If you need to find the original fi le belo nging to an alias, 
follow these steps: 

,. Click once on the alias. 

,. From the File menu, choose "Get In fo," or press 
Command I. 

,. T he Get Info dialog box tells you where the origina l 
is located. 

,. If you want to have Mac go get it and bring it to you, 
click Lhe button "Find O riginal." T he window the 
original is stored in will be displayed and the icon 
will be highlighted. 

:0111111111 ROl Mnlllnfo - ~~~ RmerlcoOnllne iiiiii10 1 

A Aa/'~U 
l:ln~: o~hu 

Slu: 2tc on disk ( 725 b!J h• w.o) 

Cru 'h•d: Vfod, ..Nn 26 , 1991,9:32 PH 
t'bdlfNd: 'V4'd, .Jwt 26, 1991, 9:.~ PH 
Or-f91na1 : • flwllfn : Hrd Did: : 

Nnwk!..ontw.. M.1ilRTo~1l 

0 Loctr:M ( Find Orlglno1 ] 11-::-:-:--:-:-
Click here to have the 
original file displayed. 

,. If you double-click on an alias which has its original 
stored on a fl oppy disk (see previous page ), you will 
get a message telling you which disk to inser t. 

Please Insert the dl sl<: 

OnlineSer uices 
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Remember Find File (page 83)? He's the little guy in the 
Apple menu who finds things for you. Well , in System 7 
he's in the File menu as the "Find ... " command with some 
impressive new powers. 

You can find any file if you know any of this information 
about it: 

"A few characters in the fi le's name, or ·what 
characters start or end its name. 

"Any of the words that may be in the file's 
Get Info comment box (see page 31). 

"The date you last changed the file, or 
when you created it. 

"What label you assigned to it. 

"What kind of fi le it is (an application, 
a folder, an alias, e tc.) . 

"The version number. 

"Whether it's locked or not. 

"Whether its size is greater than or less than 
so many kilobytes. 

Choose "Find ... " from the File menu (or press 
Command F). You' ll see this dialog box: 

Find 

Find: 
~---------------------------J 

[ More Choices Concel J n Find J) 

If you know the name or even part of the name of the 
file you' re looking for , just type the characters in the 
Find box {it doesn 't matter whe the r you use capital 
letters or lowercase le tters). Whe n you click OK, Find 
File will search for the first occurrence of the string of 
characters you typed. When a matching file is found, its 
window wi ll open and the fi le wi ll be highlighted . If no 
matching file is found, you ' II hear a beep. 

CHAPTER TWENTY-NINE 

Good 01' 
Mr. Find File 

Simple Finding 
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If the file he fou nd isn' t exactly the one you want, look 
for th e next occurrence of that string of characters by 
choosing "Find Again '' from the File menu (or press 
Command G) . Keep pressing Command G until you 
fi nd what you 're looking for. 

Instead of searching for something on e file at a time, 
click the button "More Choices" to bring up a really 
sophis ticated Find utility. 

Find 

Find ond sel ec t Items whose 

._I _n_o_m_e ___ •_.l l contolns 

Seorch I on oil disk s 0 oil ot once 

[ r ew er Choices) [ Cancel ) { Find JJ 

Notice the "all at once" checkbox? If you check it, Find 
File will find and display, simultaneously, every occurrence 
of wha tever you've specified so tha t you can see all the 
matching files a t the same time, without searching 
individually for each one. He does this by alphabe tizing 
the view in your h<lrd disk window (if that's where you 
searched) by name, and then expanding the appropriate 
fo lders. If you scroll down th e list, you will see that eve ry 
matching fil e is highligh ted. 

ff Find File has expanded a lot of your folde rs (see 
page 109 for info on expanded and compressed 
folders) and you wan t them all compressed again, 
simply change the view to "by Icon " and then change 
it back to the list you prefer. All th e folde rs ·will be 
com pressed. 



System 7 y f iND FILE 

You can also choose where you want him to search. See 
d1e downward-pointing arrow in the label next to "Search"? 
Normally Find File will search all your di sks, even 
inserted Ooppies. But you can press o n th e arrowhead 
to get the pop-up menu of p laces to search-just the 
Desktop, just your hard disk, just a Ooppy disk, just 
the active window, or just the fo ld ers you 've selected. 
Narrowing your searc h like th is can save a lot of time. 

You ' ll notice there are also downward-
Umii'UHJ sole c: l II urn ~ u.1IWSO 

Restricting 
Searches 

rind 

pointing arrowheads next to "name" 
and "contain s." These pop-up menus 
hold lots more choices. As you se lect 
diffe rent optio ns in the first pop-up 
menu, the options available in the 
other two pop-up menus change. 

I nnme ... 1 r.Di~~-~~~ aM!i!l·r:ll· '1!119···· tOiftrts with 

Try it and see. 

You can get back to th e simple Find 
box by clicking the button "Fewer 
Choices. " 

( fewer Choices ) 

( rewer (hoite\ ) 

ends will! 
h ~en at onu 
h not 
doesn't tontoln 

rtnd 

? I <191 

0 nil at onco 

Search In a search within a search you can look for ite ms that 
mee t one set of criteria. Then search just those selected 
files for the next set o r criteria. For example, suppose 
you have a lo t of fil es that have "C hapter" in their nam es, 
but you on ly want to locate the chapte rs you wrote afte r 
August Hi, 199 1. He re 's how to do that. 

Within a Search 

Y First, search "all at once" fo r all fi les wh ose "name" 
"contains" the word chapte r. Find File will find and 
highl ig ht all the matching fi les. 

Don 't rlt!se!JJct tltejilt!s.' (Don ' t click a nywhere.) 

Y From the "Search" pop-up me nu, choose 
"the selected items." 

y Change the searc h criteria to ''date created " 
a nd "is after. " 

Y 'Whe n you choose "date created ,·· today's date 
will be shown. To change the date to August 16, 
click once on the part of the date you wish to change, 
then cli ck on the li ttle arrows. 

- nmti uul'd 
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Other 
Search Ideas 

• Click the "Find" button, or hit the Return key. 
Find File will display only those files that have the 
word "Chapter" in their names that were created 
after August 16, 1991. It's too cool. 

rind 

rind and se loc lllems Whose 

date created •I r1 '-ts-=offi.to::;r-----,,..;;-,1 OIIE!9t 

Search I on "' lnternnl II o • •I 0 nil nt onr:e 

( fewer Choices) 

Don't limit yourself to using "Find ... " only when you are 
looking for a particular fi le . This feature can also be a lot 
of he lp if you're reorganizing your filing system. For 
instance, you can search by "date created " to see which 
of your files are outdated. Or ifyou' re making backups, 
you can first search by "date modified" to see which files 
you haven' t backed up since the last time. 

This is just the tip of the proverbial iceberg of System 7's 
Find powers . 

.. 



TRUETYPE 
FoNTS 

CHAPTER THIRTY 

System 7 has a different kind or fo nt forma t called : True Type 
TrueType. TrueType fonts look nice and smooth on 
the screen in a ny point size. You don't have to have a 
PostScript printer to take advantage of the m ; they work 
\vith all kinds of printers, even Image Writers and ink:je t 
printe rs. 

TrueType fo nts are called scalable fonts because they' re 
mathematically scalable to any size, thus you only need to 
have one size insta lled in your Syste m to e nable the Mac 
to create a ny size you need. Since True Type fonts do n ' t 
take up a lo t of room , it's easier to store lo ts more [on ts 
on your d isk. (You' ll also hear TrueType fonL~ being 
called outline fonts. Don ' t confuse that wit.h outHne 
stylle, see page 68.) 

vVith TrueTyp e foms, you don 't have to worry abo ut 
city-named fonts vs. non-city-named fonts. You can use 
all TrueType foms, no matter what their name, o n any 
printer that will work with your Mac. 

How can you te ll a TrueType fo nt from any othe r kind? 
Look at its icon , either on the noppy disk it arrived iJll 
on or in the System file within the System Folde r. fi 
True Type font icons look like the one shown here, Helvetica 

with varying letter sizes to indicate that you can use the m 
in any size you like. 

You can a lso te11 TrueType fonts when you are inside an 
applicatio n: Se lect a font and check out the size menu. 
If all the sizes a re in outline style, as shown to tl1e rig ht, 
tl1en the font is T rueTyp e. 

The TrueType fonts that come wit.h System 7 will be 
installed automatically when you run the Installer. If you 
buy any more TrueType fot1ls later (several vendors are 
making the m), you' ll be glad to hear that they're really easy 
to install. .Just dr-ag the ir icons into your System Folder. If 
you have a lo t o f fonts and use a utili ty like Suitcase II , just 
drag the font ico ns into a sui tcase icon ; the suitcase will 
accept them j ust as if it were a folder. 

Scalable Fonts 

City-Named 
Fonts 

How Can You 
· Tell If It's 
: TrueType? 

Other ... 

• • 
~ 

-'Dill 
Dl 
D!l 
DoQ 

DID 
!loQ 
llll 
llll 

TrueType 
fonts show 
all screen 
sizes 
available. 

Installing 
TrueType Fonts 
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Mixing Sixes 
and Sevens 

Installing 
Other Fonts 

LiD 
System Folder 

A closed System Folder. 

en 
LinoCaxton 

A font suitcase icon. 

ld] ld] 
C.XIon Light 10 C.XIoo Llghl12 • 

Font document icons; · 
these represent the 

bitmapped screen font. 

Caxtoli9 

An Adobe printer font : 
icon to match the . 

bitmapped screen font; . 
this is what the fninter . 

needs to print the text . 
(these icons look different . 
from diflerent vendors). 
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The fonts you have been using with System 6 will work 
fine with System 7, too. You can even mix them in the 
same document, and everything wi ll print just fine. The 
Mac will figure it all ouL Just don't use the same-named 
font from two different vendors; that is, if you are using 
TrueType Times, don ' t keep an Adobe Times in your 
font list also. 

To install a new non-TrueType font to your System: 

" Make sure your System Folder is closed, as shown . 

., Double-click on the font suitcase icon. In earlier 
System versions this double-click wi ll take you to the 
Font/DA Mover. In System 7, though, you will see a 
document icon for each font. 

., Drag the icons of the font sizes you want to use to 
your System Folder. If you are using Adobe Type 
Manager, install just the 10-point and 12-point icons. 
The Mac will ask if you want it to put the items where 
they belong (in the System file) . Yes, you do. Then 
close that font window. 

(If you typically store your fonts in suitcases, drag 
the icons right to the suitcase and store the suitcase 
where you always have. You do not need to go 
through the Font/DA Mover.) 

"If the font you are installing is a PostScript font (also 
known as an outline font, or a Typt! I font), it comes in 
two parts: the bitmapped part that you just installed, 
and the printer font (see page 68). You must put the 
printer portion of the font into the closed System 
Folder as well (not the System file) . Drag the icon to 
the System Folder; the Mac will ask if you want it to 
put the item in the proper folder (in the Extensions 
folder). Yes, you do. 

(If you typically store your fonts in suitcases and use 
a font management utility, you still need to store the 
printer fonts in the same folde r as the suitcase.) 

TrueType fonts do not have separate icons for 
each size; all the sizes are rolled into the one icon. 
True Type fonts do not have separate printer 
font icons. 



If you have been accustomed to working in Multifinder 
in previous system versions, you can skip this chapter 
because it works esse ntially the same in System 7. If 
you've never used MultiFinde r, this is probably the 
most important chapte r for you to read . 

MultiFinder al lows you to have several applications o pen 
at the same time, as well as having access to your Desktop 
at all times. These are typical scenarios: 

You open MacWrite II to write a le tter to the Brownie 
troop pare nts. Whe n you decide to save the letter, 
you realize you forgot to ma ke a fo lde r in which to 
save this docum ent and all the re lated fi les. So you 
just pop back to the Finde r (Desktop) , make a fo ld e r 
on your ha rd disk, and po p back into MacWrite. Yo u 
didn't have to q uit MacWrit e to do that. 

While writing th e Brownie leu e r, you decide to spice 
it up with a cute graphic. So you po p back to the 
Desktop, ope n SuperPa int, crea te the graphic, and 
pop right back to \1acWri te to drop in the graphic. 

Or say you' re in PageMaker and you want to make 
a table in the Table Edito r. Yo u can open the Table 
Editor, create and exporlthe table , then drop it into 
Page~·1aker. You print it up a nd you notice it needs 
changes. Since the Table Editor is still open, you can 
pop r ight over the re, fix the table, and the n update 
the changes in PageMaker. You never h ad to quit o ne 
program to open the o the r. 

Maybe you're done with the Brownie troop le tter 
and you want to fin ish that le ue r to Aunt Ethe l. You 
forge t wh ere you left the le u e r. Find File (page 13 1) 

will get it for you , but Find File is no longer on the 
Apple menu (dam it; I wish tluy luulu 't donP that). So you pop 
back to the Finde r (Desktop), use Fin d File to dig up 
the le tter, do uble-click o n it, and the letter opens, 
taking you back to MacWritc . 

Now this a ll seems great. It is great. Exce pt for on e thing: 
you have to be conscious. Yo u have to acllla lly und.ersland 
what Multi Finde r is do ing and what you are doing. 

CHAPTER THIRTY-ONE 

Working in 
Multifinder 
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Multifinder 
and RAM 

In o rder to understand how to work wi th MultiFinder 
e fficiently, you need to understand RAM (Random Access 
Memory). Rather tl1an send you back to page 51 to read 
about RAI\1, I'm going to repeat myself. 

You have a hard disk in or next to your computer (you 
have to have a hard disk to run MultiFinder) . Your hard 
d isk is permanent storage space. Perhaps you have a 30 
meg hard disk, or 80 meg, or 160 meg. All t11at storage 
space is permanent; it is not considered memory. I often hear 
people mistakenly calling their hard disk mernmy. It isn't. 
Yo ur hard disk is like your filing cabinet; you store your 
applications there, your documents, your tools. 

Yo u also have a certain amount of rnernory (RAM) installed 
in your computer , typically from one to four megs. RAM 
is a /,empomry storage place. It is where aU your work hangs 
out until you Save it onto the hard disk. V\'hen the power 
goes off or th ere is a System failure, everything in RAM 
disappears (that's why when you crash, you lose what 
you did n ' t Save to disk). 

\".'h en you open an application , the Mac puts a copy of the 
ajJpiication into RJ\M. It does this because RAM is much 
more accessible; it is much faster for the Mac to go into 
RAM and get work done then to keep going back to tl1e 
ha rd disk. V\Then you quit that application , Mac gets rid 
of the copy in memory. Wh en you open ano ther applica
tio n , a copy of that one goes into RAM. 

It is easy for RAM to get fu ll. If it gets too full , you will 
crash; the Mac just checks o ut-says, "O ops, I've had it. 
I'm gone," and you get the ve ry disturbing bomb. 

System 7 works exclusively in MultiFinder-you can ' t 
tum it off as you can in previous Syste m versions. V\'hile 
wo rking in MultiFinder, you can always see the Deshtop, no 
ma tter what application you are in. You can always see 
tJH: trash can and your hard disk icon (although occa
sionally a document window may be in front of them). 

This is a typical scenario: You work o n a document for 
a while . Perhaps tl1e document window covers up tl1e 
Desktop , bu t when you close the document, it appears that 
the application has gone away and that you are back at 
your Desktop because you see the trash can. So you open 
another appli cation. Afte r a while you close that one. 



When you u-y to open ano ther application , the Mac te lls 
you that you can ' t ; the re's no t e nough m emo ry. Yo u get 
confused; how can there no t be e nough m emory? H ere 
you arc a t your Desktop with nothing o pe n . And that 's 
th e confusing thing- you can have several aPJJ!ications ojJt'n 
at onre and never /mow U. 

Or this m ay happe n: You ' re wo rking in an appli catio n. 
Suddenly yo UJ- me nu changcs-hc1·e you a rc in Mac\Vri te 
but there's no Fo nt menu . O r pe rhaps you want to Shut 
Down but the re is no Special me nu. 

When working in .\1ultiFinde r, you must ron.l'lan lly be 
conscious ofyonr ·menn bar. Th e me nu bar is your o nly 
visual clue as to wha t is going o n. It g ives )'Oil two m aj o r 
indi cations: 

~If you see the word "Special " in your menu bar , you 
are a t the Finde r (Desktop). If you do n ' t sec the word 
"Special," then you are in some sort o f applicatio n. 
Look at the actua l words in the men u bar . If a ll you 
see are "File" and "Edi t,'' yo11 a re probably looking at 
a Desk Accessory (page 79). If you sec "Fo nt," you are 
pro bably in your wo rd processor. 

T he point he re is that you need ro keep an eye o n 
your m e nu bar . Once you arc aware tha t you can 
bounce back a nd forth be tween a pplications, it is easy 
to find ou t exactly whe re yo u are (read on) . 

~ In th e far right corner o f th e me nu bar is a li ttle icon. 
That icon te lls you which applicatio n is artive (which 
o ne you are working in a t the mome nt ). 

In the column to the right arc some of the icons you 
may see in that corner. ( If you arc using Syste m 6, 
you can dich o n that icon to bounce into a ny o the r 
open a pplicat ion.) 

In System 7, that icon in the upper r ight is call ed the 
Application menu· If you Jm'ss o n the icon , you ge t a 
me nu similar to the o ne shown in the right column. The 
bouom po rtio n o f the me nu lists a ll the a pplications you 
have opened, as well as th e Finder (Desktop). (In System 6, 
this list is unde r th e Apple m e nu .) In the exam ple to the 
right , th e c heckmark indicat es that DcskPaint is the 
active applicatio n. If you choose "Finder," The Finde r will 
beco me active and you will sec Special in the me nu ba r, 
but yo1t will still Sl'f' l h l' DeskPainlwindow! 

SvsTEM 7 ~ MuLnfiNDER 

Watch 
the Menu Bar! 

IRl Wh Pn you are 
~ really a/ the 

Findm~ this is the 
icou you will see. 

~ ~ .... ' 
1111 

When yun ttSt! a Desil 
Access()ly, yuu will see 
its icon in the comer. 

This is the Mac Write II 
iron. When you are 
working in MacWrilt!, 
this icon will afifJear in 
the ujifJer 1igh t corner. 

The Application 
Menu 

Hide Others 
<,how ltll 
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139 



MuLnFINDER • System 7 

----------------------------

Hiding the 
Other Windows 

140 

Hl~e DeskPalnt~ 

Hl~e Others 
~h llUJ nu 

_,~ OeskPalnt'" 
~ Fln~cr 

PageMaker -1.01 

! 

"Not enough 
memory". 

messages 

Now, that's a very conscious choice, selecting the applica
tion from the menu. It is also possible to accidentally or 
(preferably) consciously simply click on any open window 
to bounce into that application. For instance, if you are 
at the Finder and you want to work in DeskPaint again, 
you can simply click o n the DeskPaint window that you 
see; this wi ll make DeskPaint active and its menu will 
appear. You will still see all the windows and the icons that are 
on the Finder (that's what gets confusing). 

Since it is a well-known fact that all these open windows 
from the different applications can cause confusion, the 
Mac offers an attempt at a solution. In the Application 
menu you can choose to hide the other windows. For 
instance, if you are working in DeskPaint and you don't 
want all your Finder windows to confuse you, you can 
choose "Hide Others." This does not hide the icons, like the 
trash can or hard dish icons, so you still see what ajJpears to be 
the DeshtojJ. Stay conscious. 

When you are in one application and want to pop 
into another , it is nice to hide the ·window you are 
leaving so you don' t see it all over the screen. A 
shortcut fo r this is to hold down the Optio n key 
when you choose another application from tl1e menu. 

At some point you wi ll probably see a message like one 
of these (I see these a ll the time because I only have four 
megs of RA!\-1): e llu~re h not onough memory to open 

"Amerlcn Online 1.0" (10DK needed, S93K 
euellablo). Closing wlndowi or qul1 tlng 
eppllcetton programs can make more 
memory auelleble. 

ODl 
& ''Microsoft WonJ .. prefers 1,024K of 

mcrnnru. 557K Is: auallablo. no you wnnt 
to open It using the nunllnble mcmoru? 

( Cancel ) CEJl 
When you do, check the Application menu to see if you 
forgot w quit from an application . Too often we just close 
the current document (window), or bounce into another 
application or back to tlle Finder, and don ' t realize we 
left the first application still open. If you see an applica
tion listed that you no longer need open , choose it. Then 
from its File menu, choose "Quit" 



The computer world is full of all kinds of abstruse j argon 
and many of us are too embarrassed to ask what the 
unfamil iar terms mean . And then whe n somebody tells 
us what they mean, half the time it still doesn ' t ma ke 
sense but we pretend it does. For years I pretended I 
knew wha t a Sil'vL\1 was. I've made a list of the most 
common terms you may hear so you can look the m up in 
the privacy of your own room. This isn ' t a comple te list, 
but it should take care of' most n eeds. If you don 't sec 
what you want here, also look in the index. If it's no t 
listed here or in the index, you proba bly don't need to 
know tha t word a nyway. An italicized word within the 
definition means it is also in the list. 

Adobe Type Manager (ATM) is a .wflware program that 
smooths outs th e edges of' type on the screen . Since 
Quick.Dmw printe rs (lmageWriters, HP Desk Write rs, 
Apple Style Write rs, (ax modems, etc.) print what they see 
on the screen, if the type looks good on the screen it wi ll 
look good in print. 

An accelerator board is a mn/ you can buy. You insta ll 
it or have installed into your Mac. It makes th e computer 
work faster. 

An alert box is a message tha t appears on the screen to 
warn you of some imminent d isaster. 

AppleTalk is how yo ur Yl ac talks to your LaserWriter o r 
to o ther Macs or to othe r sorts o f machines (provided 
they are hooked together with cables). 

ASCII (pronounced as/we) stands for An1erican Standard 
Code for Information Interc hange. It's a standard code 
that almost a ll computers ca n read that enables them all 
to understand how to create numbers and le tte r·s, even 
though they use diffe rent programs. For instance, if you 
are working in Fu iiWritc a nd you need to send the fi le to 
someone else, but they usc MacWrite II , you can save the 
docume n t as a n ASC II fi le (which is the same as /t>xt-only) 

and the ir MacWrite II will be able to open th e fil e. 

PART Ill 

· Adobe Type 
·Manager 

accelerator 
board 

alert box 

: AppleTalk 

ASCII 
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askee See ASC!l. 

ATM See Adobe TyjJe Manager. 

baud rate When you use a modem to send information from one 
computer to another , the information goes through the 
phone lines at a certain rate of bits per second. This bits
per-second rate is also called the baud rate . Modems 
most typically send at 1200, 2400, or 9600 baud. 

BBS . BBS stands for Bulletin Board Service, which is a service 
usually set up by organizations or clubs to provide or 
exchange information. You access the BBS through your 
modem. You call up the number for the BBS, and on your 
screen you see the compute r equivalent of a bulle tin 
board. You can post messages, ask questions, answer 
questions, make new friends. 

beta When a piece of software or hardware is in the testing 
stage, it is said to be in beta . Usually beta versions are 
sent out to people to test (called beta testers) who report 
back the things that are wrong or buggy or that need 
improvement. 

bit Bit is short for "binary digit." It's the smallest unit of 
information that the computer works with; it's kind of 
like an on/off electronic pulse. See page 7. 

bitmapped When an image or text is bitmapped, that means it is built 
out of the dots on the screen. Bitmapped graphics can 
be edited dot by dot. They are the simplest form of 
imagery on the computer. 

Other kinds of graphics, EPS, for instance, or PostScript 
fonts, have two parts to them: They have a screen 
representation that is bitmapped so the computer can 
read and produce it on the screen. Then they also have 
a PostScript, or outline version of the same image that is 
not bitmapped ; this is the part that the printer reads to 
produce it on paper. 

bomb I don' t think it's nice of them to use a bomb metaphor 
when the System crashes. It's very disturbing. It lays a 
guilt trip on us, too; we always think it's our fault. 

boot To boot or boot up means to turn on your computer or 
other hardware or to open the soflwm·e application. See 
page 11 . 



JARGON ... CD-ROM 

The B word. If a piece of softwaTe or lumlwam has some- bug 
thing wrong with it, making it act weird, it is said to have 
a bug or to be buggy. That's some thing bela testers d o-
they try to find a nd report the bugs in new products so 
the bugs get exterminated before we pay lots of money 
for the products. T he te rm ac tually comes down to us 
from the real live crawling and fl ying bugs th at used to 
get into those gian t-sized comp ute rs and wreak havoc, 
parti cularly one a t Harvard in 1945. 

See BBS. bulletin board 

A bus is a piece of hardwa re that a ttaches to the back of bus 
th e Mac and lets you plug more things into it. 

A byte is eight bits su·ung together to make a message byte 
that th e computer can in terpret. See page 7. 

CAD stands fo r Computer Aided Design . It actua lly has CAD 
nothing to do with th e sort of desktop publishing design 
proj ects that most of us think of-it is referring to 
engineering and architectura l tasks. 

A card is a piece of p lastic with cltif;sattached to it th at card 
you put inside the com puter box. You can get video 
cards and accele rato r cards and clock cards and prin ter 
cards or whole computers on a card . Some o r th e m you 
can just order thro ug h the ma il and then open th e 
computer and stick 'em in , which I fin d to be a vet-y 
fr igh tening expe rien ce. 

A chip is that tr uly amazing and remarkably tiny piece chip 
of silicon that h as a n enti re integra ted electro nic circuit 
embedded in its surface. Chips are what make the 
computer. Chips a re the computer. A tiny chip is one 
of the biggest pieces o f human-made magic o n eanh. 

CD-ROM stands for Compact Disk, Read-Only Yt cmory. CD-ROM 
A CD-ROM actually looks just like the COs we p lay music 
with . Yo u can get a CD-ROM player for your Mac th at will 
read these disks. T here a re disks with the e n tire works of 
Shakespeare, with d ictiona ries, with history, with images 
of the works in th e Louvre, etc. e tc. etc. You can only 
read from them, you canno t sto re informa tion o nto the m. 
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CDEV A CDEV is a control pane l device. It's a little program (or 
utility) that usually makes life easier for you, like a screen 
saver. You can control some of their functions through 
the Control Panel. CDEVs a re similar to !NITs in that you 

· just stick them in the System Folder and they work. 

CPU The CPU is the Central Processing Unit. It is the one tiny 
little chip in the Macintosh, often called the microproces
sm~ that runs the show. Powerful magic. Sometimes 
people re fer to the circuit board it lives on as the CPU. 

crash There's probably not much question about what a crash 
is. The first time it happens to you, you say, "Oh. This 
must be a crash. I get it now. " When you see the bomb on 
the screen or when the screen freezes or when the Mac 

· just decides to check out, that is a crash. The only thing 
you can do at that point is turn the computer of[ Wait 
several minutes before you turn it back on again. Some
times you may have a clue as to why it crashed (see page 
95); sometimes you just have to accept the fact that you 

· will neve r know why. Yes, everything you did not Save to 
your disk is gone. 

database A database document is like a giant collection of 3 x 5 
cards. Since they're on the computer, though, a click 
of a button can alphabetize those "cards," select just the 
names you want to invite to your party, tell you who owes 
how much money, etc. The term "database" can refer 
either to the software package you create in, or to the 
document itself. A database is one of the most useful tools 
on the Mac, and it acntally is an incredible amount of fun. 
If you've never used one before, read Guy Kawasaki's little 
book, Database 101. Everybody needs a database. 

Desktop : De1idop refers to what you see on the screen when you 
turn on the Mac. See Chapter 3, page 13. 

dialog box I use the term dialog box loosely in this book to avoid 
confusing you. I refer to any of the messages you get on 
the screen that te ll you something or ask you something 
as dialog boxes. Technically, some are dia log boxes and 
some are alert boxes and some are actually windows and 
there are probably a few others, but few people will argue 
and all will understand if you just call them all dialog boxes. 

.. 



This little creature is the Dogcow, His name is ~ 
Clarus. He says Moof! Sometimes he says !fooM. JJ--:0 
A dot matrix printer is a printer that uses coarse dots 
to create the text and graphics on the page, like the 
Image Writer. 

Dots per inch is how the resolutian of a screen, a printe r , 
or a scanner is measured. For instance, the standard Mac 
screen is 72 dots per inch. This means there are 72 rows 
of dots in one inch. The Image Writer II prinL~ at 144 dots 
per inch. A LaserWriter prints at 300 dots per inch. The 
higher the number of dots per inch, the smoothe r the 
image. 

JARGON,. e-mail 

Doge ow 

dot matrix 
printer 

dots per inch 

Download means to send information from one source, download 
like your computer, to another source, like another 
computer throug h a modem. Also, certain fonts must be 
downloaded, or sent to, your printer before they can be 
printed. 

See dots jJer inch. dpi 

The drive is the part of the computer that takes the disks drive 
and spins th em to make them work. T here are floppy 
disk drives, the ones with the little slo ts where you insert 
a floppy disk. T h e re are hard disk drives that are sealed 
inside the computer or inside the box they come in. 
There are removable cartridge hard disk drives that have 
a large slot in which to insert a cartridge hard disk. 

A driver is a piece of software that tells the Mac how to 
communicate with or operate another piece of hardware, 
most commonly a printer. Your System Folder h as a 
printer driver in it. If it doesn ' t, you can't print. 

E-mail refers to the e lectronic mail that you can send 
or receive directly on your compute!". Yes, it actually 
means people can wri te you le tters and send them to 
your computer. You can turn on your Mac and go pick 
up your mail. Many a love a lTair has begun through 
e-mail. I know. It's really fun , too. And useful , of course. 
You do need to have a modem or be on a network to send 
or receive e-mail. 

driver 

Lu~r'f'riter 

e-mail 

The Laser 
Writer printer 
driver in 
Sysl£'11! 7. 

145 



146 

EPS, EPSF EPS or EPSF stands for Encapsulated PostScript File. This 
is a graphic file format. Graphics that are saved as EPS are 
made of two parts. One pan is a simple bitmapped image 
that the computer reads and displays on the screen. The 
other part is a complex Post&-rijJl code that the printer 
reads (if the printer reads PostScrijJt). EPS fi les are called 
"device independe nt" or "resolution independent. " T his 
means th ey will print at whatever resolution the prin ter 
ha ppe ns to be. The same graphic will print at 75 dfJi on 
the Image Writer II , at 300 dpi on a LaserWriter, at 1240 or 
2400 dpi on Linotronics. 

file format A file format simply means the particular structure that 
a document (graphics, text, spreadsheet, etc.) is saved 
in. For instance, in text there are file formats like ASCJJ 
(text-only) or RTF, in addition to the standard file format 
for your particular word processor , such as Mac Write II. 
In graphics there are fi le formats li ke l iPS, TIFf~ PTCT, or 
MacPain t. Differen t programs can read different formats. 

file server A file server is used on a network. O l"ten one Mac and its 
hard disk are dedicated to the job of being a file server. 
Everybody on the network (everybody who is connected 
with cables to this computer) can use the software and 
the hard disk belonging to that Mac, rather than every
one having their own. There is also fi le server software 
tha t controls who gets to read and use what and how 
ma ny people get to do it at the same Lime. 

Finder 

Fkey 
function key 

T he Finder is a nother term for th e Desktop (see Chapter 
3, page 13). There is a lso an icon in the System Folder 
called Finde r, which controls the Desktop. 

The terms Fkey and function key arc used interchange
ably, a ltJ1ough there arc two separate meanings. 

FKey is usually referring to a mini-program, or utility, that 
can be added to your Mac (kind o f like a desk accessory). 
T he litLie FKey program makes th ings happen when you 
press a certain key combination, like Command Shift 7. 

Function key usually re fe rs to the 10 to 15 extra keys 
along th e top of an extended keyboard, numbered F1 
through FlO or Fl5, that you can program to perform 
certain tasks, usua lly with a macro utility . 
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Freeware refers to the software that some nice person 
creates and then puts o ut in to the world at no cost to the 
user for the benefit of humanity and no be nefit to 
themselves. Freeware is often available on bulletin board 
services, through user groujJs, or from friends. See also 
shareware. People who create freeware are diametrically 
opposite to the evi l people who create viruses. 

See Fhey. 

A gigabyte (G) is a unit of measure, measu ring file size 
or hard disk space, etc. It's very large. Technically, one 
gigabyte is 1024 megabytes, which is the same as one billion 
bytes, which is really 1,073,741,824 bytes. Impress your 
friends V\~th this useful knowledge. 

Some Macintosh screens are grayscale, rather than 
plain ol' black-a nd-white. On a black-a nd-white screen 
or on printed material, g ray to nes are simulated by black 
and white dots that give the illusion of gray when seen 
from a slight distance. A grayscale image (a photograph, 
for instance, that has been swnned into the computer) 
on a black-and-white monitor (screen) is bro ke n into 
dots to represent the gray values. On a grayscale monitor, 
though, the same image will display in ac tual gray values. 
It's very beautiful to see. 

Hard copy refers to the printed version of what you have 
in the computer. For insta n ce, this book is a PageMaker 
file stored on a disk. I prin ted up hard copy for editing 
and for producing into the book in your hands. 

Hardware refers to the parts of the computer or of any 
j;eripherals you can bang on . T he monitor, the external 
hard disk, the mouse, the keyboard, the modem, the 
scanner-all those things you can touch are hardware. 
As opposed to software. 

freeware 

function keys 

gigabyte 
G 

grayscale 

hard copy 

hardware 

The Macintosh System originally kept track of items on HFS, or 
a disk ~th the Macintosh File System (MFS). Then the hierarchical 
HFS, or Hierarchical File Syste m was d eveloped, which is file system 
much more efficient at keeping track of what is inside iiD~ 

folders, and fold ers inside of fo lders. \.Yann a know a 11 uoms 

little-known and v_e ry useless bit ~f tri~ria? If a ~isk has r ~ 
been formatted w1th HFS, the re IS a tmy do t n g ht here . u:;u 
· h · d 1 · S ) S.,sl• m Foldor 
111 eac Win ow (un ess you are usmg ystem 7 . . 
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INIT An INIT (accent on tJ1e second syllable) is a li ttJe program 
th at does things like make extra sounds, pictures, bizarre 
cursors, clocks, e tc. Some applications have Ii'\!Ts as an 
adjunct to the main program. !NITs work only if they are 
stored inside your blessed Syste m Folder ; if you put them 
in any other folder, they don't work. 

T hese things are called !NITs because they work upo n 
initialization of your computer; that is, whe n you star t it 
up (they're also known as Startup Documen ts) . When you 
turn your machine on, all these litlle !NITs get loaded 
inw RAM * and start working even before your System 
gets up and running. Those li ttle icons tha t appear in 
the lower le f'l portion of your screen as you boottlfJ 
represent your !NITs (some are a lso CDEVs, which are like 
IN ITs except that you have some conu-ol over Lhem 
through the Conlrol Panel). 

!NITs are a well-known source of trouble to the System. 
If things start acting weird after you install an INIT, take 
the !NIT back out, restart (!'ro m Lhe Specia l menu), and 
see if things are norma l again. Never install more than 
o ne INIT at a time; rathe r, put o ne in , work on your 
mach ine a Few days, th en put another one in. That way 
you will be able to pinpoin t the on e that causes trouble. 
(For instance, l 've heard of' a n !NIT that inadvertently 
affects the column guides in Page:Vlaker. We ird. ) 

*Read up on RAM to unde rstand the e ffect of' having 
!NITs t.'1king up space. See pages 51, 138, and 196. 

initialize When you buy a new fl oppy disk or a hard disk, it is 
unformatted ; that is, it is comple tely blank and doesn ' t 
have any of the tracks necessary in wh ich to lay down the 
data you are going to g ive it. So you have to initialize it. 
Blank ha rd disks come with special software to use for 
initializing the m. Wh en you insert a blank fl oppy disk, 
the Mac asks if' you want to initialize it (see page 8). You 
have to, if you want to usc it. 

If you re-in itialize a ny disk, the process pe rman ently 
erases anything tha t curre ntly exists on th at disk. 

As noted in the section o n !NITs above, the term 
initialization is sometimes referred to as the booting up 
of th e computer. 



Kerning is the process of adjust.ing the fit between 
letters. You can on ly do it in certain programs, like the 
more expensive page layout or illustration applications. 

To launch simply means to stan or open an application. 

Leading (ledding) is the amount of space bet1veen lines 
of text. It is typi cally measured in points. In page layout 
programs and in some word processing programs you 
can adjust the amount of space between the lines. 

A ligature is a typographic nicety; it is o ne characte r that 
is aCLually two single characters combined together. For 
instance, when you type the lette r f next to the le tter i, 
the hook of the fbumps into the dot of the i. The ligature 
for f and i is one character, like so: fi. Every PostScript fo nt 
on the Mac includes the commo n ligatures for fi and f1 
(see the chart of the last page of this book for the key
strokes). Certain o ther fonts, like the Adobe Expert 
collections, contain many more ligatures. 

Lines per inch is very different than dots peri nch. Do ts 
per inch refe rs to the resolution of the screen, the scanner, 
or the printe r, which can get up in to the 2000 dots pe r 
inch range. T he lines and curves of text appear to be 
perfectly smooth because the dots are so small our eyes 
can't separate them. 

But when a graphic that is in gray tones or in color, such 
as photographs or gray bars, goes to the printing press 
or a copy machine, the tones must be broken in to dots 
big enough to print ink or toner. T he princip le is tl1e 
same as in d ots per inch: 85 lines per inch means that in 
an inch there are 85 lines of dots. T he more lines that fit 
into an inch, ilie smaller the dots. The smaller the dots, tl1e 
higher quality the p•int.ing press must be in order to hold 
(print clearly) the dots. Copy machines and newspapers 
need graphics at 65 to 85 lines per inch. Low-cost presses 
(quick printers) need 85 to 100 lines per inch. A good 
press can usua lly print 133 lin es per inch. O nly very hig h
quality art-type books are printed higher than 133 line. 

An Apple LaserWriter has a default for grayscale 
graphics of 53 lines pe r inch , which means that any gray 
image that comes out of the LaserWriter will have the 
gray values broken up into dots in lines of 53 per inch. 

JARGON • lines per inch 

kern 

launch 
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ligature 

fire fire 
flirt flirt 

lines per inch 
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log on, log off These terms re fer to the process o r checking in , o r 
logging on, to a bulleti11 board servire or a network, or to 

the process o r checking out, logging off, Typica lly whe n 
you log on somewhere you have to have a password. 
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macro The te rm macro sounds very arcane and intim idating, 
but once you usc them you get hooked , they are so cool. 
A macro is simply a series or steps (me nu commands, 
mouse clicks, keystrokes, etc.) that arc programmed in to 
one key or one key combin ation . O nce it is programmed 
and you press th at key combination , the entire series of 
steps is executed at high speed. 

For instance, if you' re creating a database of names 
a nd addresses, you can create a macro that will type 
"P.O. Box" for you so you just press o ne key combina
tion a nd tJ1at phrase will appear. Or if you regularly have 
to type the ph rase "Robin 's and .Jane t's Pl-ivate Club for 
the Dissemination a nd Elucidation or Macintosh Magical 
Myste ries," make a macro fo r it. If a t the e nd o f each 
week you a lways gather up a ll the accoun ts e ntered , copy 
the m, ope n another spreadsheet. drop them in , then 
prin t up a re port wi th sums and to ta ls and balances, 
create a macro for il. Anything you do repeatedly, you 
can lighten your li fe by making a macro fo r it. 

Do-it-yourself macros are very easy to create; basically, 
you just say Do This, show it wha t to d o, and th e macro 
Docs It. Some applications, like Microsoft Works, have a 
macro fea ture buil t right into il. Apple provides Macro
Ma ker with it.s System software (which I don 't use because 
it interrupts Dark Castle). Ask around about the m. 

memory Memory is generally re ferring to RAM, which is Ra ndom 
Access Memory. Memo ry is temporary, volatile storage 
space, as opposed to the pe rmanent storage space you 
have on a disk. You shou ld read pages 5 1, 138, and 196 

about RAM Lo ge t a good grasp on this important subject. 

modem A modem is a liule box that sits next. to your computer. 
It has a cable that plugs into your :vlac. Jt has ano ther 
cord that plugs into your phone jack. With a modem 
hooked up, the n , your com puter can call any o ther 
compute r that is also hooked up to a mode m. You can 
sit a t your compute r anu '' talk" to othe r people who are 
sitting at thei r compute rs. You type a couple lines of 
conversa tio n , hit Lhe Return key, and your conversation 
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shows up on bo th of your computer screens. It's really 
addictive. People h ave been known to meet and eventu
a lly marry through meeting online (on the screen). And 
many a one-night-online-stand has ha ppe ned. It's a 
fascinating phenomenon . 

But, practically speaking, an incredible amount of 
business goes on through the modem . You can send any 
file through the phone lines. If you live out in the boonies, 
you can send your publication out for high-level output 
to a service bureau hundreds of miles away; they' lljust 
express the finished product back to you through the 
mail. If your magazine column is due by 12 noon on 
Friday, you can finish it at 11:45 and still have it in their 
hands across the country by noon. You can conduct 
research, make plane reservatio ns, join clubs, play long
distance chess, oh th e possibi li ties are e ndl ess. 

Just so you know, the word modem is derived from the 
terms modulator and demodulator. 

Modifier keys are the o nes tha t have no cha racter modifier key 
attached to the m, but that alter the be havi or of a nother 
key. These are Macintosh modifie r keys: Shift, Option, 
Command, Caps Lock, and Control (if your keyboard 
has it). Always whe n using modifier keys you press those 
keys down and hold them, and then just lafJ the characte r 
key that it modifies. For instance, the keyboaHI shortcut 
for Paste is Comm~U1d V. So hold down the Command 
key and tap the lette r V. If you hold the lette r V down, 
you' ll end up pasting in more than one of the item. 

The term moire refers to the bizarre patterns that result moire 
in photographs (or other graphic images with color or gray 
values), when lines of dots at one angle overlap lines of 
dots at anoth er angle (see lines fJer inch) . It's not easy to 
avoid the m if you're trying to print directly from the 
computer output, rather than high-quali ty separations. 
How to avoid them "is beyond th e scope of this book." 

(I sec stuff a ll the time telling people to prono unce this 
word "mwahr" or "mwah 'ray," but nobody says it like that. 

Maybe if you're French you do, but Amer·ican mouths don 't 
work that way. T his ter·m's been around a lot longer in printing 
and graphics than computer nerds realize. [Me, I 'm no t a nerd; 
I'm a nerdette.].JusL pronounce it "moray," with the accent on 
the second syllable, and you wi ll be perfectly acce ptable.) 
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Moof!T~1 : Moof ! is what the Dogcow says. 

motherboard Isn 't this a nice name? It's also called a "logic board," but 
motherboard sounds so much more earthy and close to 
the heart. The motherboard contains the heart of the 
Mac. It 's the board, or p iece of fiberglass, that con tains 
th e most important chijJS that run the computer, including 
the R.A.J\.1 and the CPU (Central Processing Unit). 

multimedia This was the biggest buzzword in town a few years ago. 
Now it's become the M word, the equivalent of saying 
"Have a nice clay." Multimedia refers to presentations 
that are created using a variety of media, such as sound, 
video, graphics, and text. 

nested When folders are stored inside of folders, they are said to 
be nested. Folders can be nested ad infmitum (well, about 
12 layers d eep in System 6; the Computer God o nly know 
how many in System 7). 

network When you connect computers together, e ither directly 
through cables or e lse through modems and phone lines, 
they are all on the same network. People on a network 
can share files , applications, e-mail , e tc. Also see file 
shm·ing. 

object-oriented Some programs, like MacPaint, create everything bitmaj>jJed, 
where doL~ on the screen are e ither on or off and you 
can edit images dot by dot. O ther programs, like MacDraw, 
are object-oriented and create images as entire objects. 
You can't edit the objects clot by dot; you can only change 
the e ntire obj ect as a who le. Each obj ect is on a separate, 
transparent layer, and is defi ned by a mathematical 
formula rather than bitmappecl dots. Since they are not 
bitmapped, obj ect-01iented graphics p1int much smoother, 
taking advantage of the resolution of the printer. 
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OCR · OCR stands for Optical Characte r Recognition. It's a 
combination of soflwaTe and haTdware that is able to take 
text on a printed page, scan it in to th e computer, and 
have the computer turn the text in to the dzamclers, not 



into a graphic image. That means you can ta ke all the 
typed letters your lovers have sent you over the past te n 
years and input them into your computer without retyping 
them. This opens up incredible possibi lities. 

When you are talking through your compute r to another 
computer or to an information service (see BBS or 
modem), you are online. 

Online help is the file an application provides within 
itse lf where you can find information abou t the program 
or how to work it, without ever leaving the a pplication or 
your computer. It's a manual on screen. Usually they're 
pre tty wimpy, although they can be of use. Syste m 7 h as 
an o nline H elp feature. It's pre tty wimpy. 

Wh en people ta lk about outline fon ts, they are not 
talking about the oudhne !>tyle (gag). Fonts come in 
basically three varieties: bitmapped, outline, and TrueType. 
TrueType is discussed in Chapter 30, so we will ignore it 
he re (it is an altogether different creature). So then: 

Bitmapped fonts are usually named after a city (Monaco, 
New York, etc.). They are stored in suitcase icons. They 
are built out of the dots on the screen . Whe n you print 
a bitmapped font on any printer , regardless of the 
resolution, the letters are sti ll bitmapped and lumpy. 

Outline fonts are made of two parts: One part is the 
screen font (which is exactly like a bitmapped font, stored 
in a suitcase, and built out of th e dots on the screen; 
don't get confused). The screen font is what appears in 
your menu and is what you use to create the document. 
Th e screen font is what the computer reads. 

Th e second p a rt of an ou tlin e font is the printer font. 
Each outline font needs a corresponding prin ter font. 
The printer font is written in the PostScript language. 
'When you print to a PostScript printer, the printer 
ign ores the font you see on the screen . T he printer reads 
the printer font. If you are using 37-point ou tline type 
and it looks crummy on the screen, it will still print nice 
and smooth on a PostScript printer . 

JARGON • outl ine font 

online 

online help 

outline font 

LinoCax ton 

Bitmapped fonts, whether 
they are city-named fonts 
or the screen jJortions of 
an outline font, are 
always stored within a 
suitcase icon. 17le icon 
above stores tile fonts 
in tile Caxton family: 
Caxton Light, Caxton 
Bold, Caxton Light 
lt.alic, and Caxton Bold 
Italic (four fo nts) . 

Caxtolig 

Ouline fonts must have 
a corresponding printer 

· font for each member of the 
· font family; that is, this 

icon above is for Caxton 
Light. In order to print 
the other three font family 
members, I must have the 
printer font for each one. 

153 



periphe ra ls ~ JARGON 

154 

peripherals 

pirate 

pica 

PICT 

~ 
Pict 

pixel 

point 

Any hardware that is attached to the computer is considered 
a peripheral. Modems, scanners, CD-ROM players, 
printers, external hard disk drives, etc. , are all peripherals. 

In computer jargon, pirate is a verb that describes 
making a copy of commercial software without permis
sion and without paying fo r it. It is essentially stealing. 

A pica is the unit of measure that typesetters have used 
for many years to measure type and line lengths. There 
are six picas in one inch (one pica =.167 inch), and the re 
are 12 points in each pica. 

A PICT is a graphic file formal, generally used for object
oriented graphics. They don't take up much disk space, 
and most programs can read Lhem. They're rather 
undependable, though (in fact, I hate them). Ifyou 
are saving a graphic as a PI CT, make sure there are no 
bitmapped graphics within it, and don't use any download
able fonts. Even then, they ofte n decide to change their 
appearance without warning you. 

A pixel (picture element) is the smallest dot that the 
Macintosh can display on the screen or that the printer 
can print. On a standard Mac screen, each pixel (each 
dot) is Y12"'1 oF an inch (remember, the dots jJer inch is 72). 
On the Apple LaserWriter, each pixel is V10o'11 of an inch . 

A point is th e unit of measure that typesetters have used 
for many years to measure the size of type and the space 
between the lines. It is th e unit of measure on the Mac to 
measure type and the space between the lines. There are 
72 points in o ne inch. T here are 72 dots fJer inch on the 
standard Macintosh screen. That was not an accident. 

(For type aficionados: you will be interested to know that 
72 po in ts o n the 1\-lac equals exactly one inch.) 

port Port is just another name fo r a plug (a socke t, actually) 
on the back of the Mac where you plug the cords and 
cables in . You can ' t go wrong with plugging things in
there is e ither a picture above the port giving you a clue 
as to what should go in the socket, or the port is shaped 
in such a way that only one kind of plug wi ll fit. 

Port also refers to rewriting software so it works on 
another kind of computer. 



PostScript is a programming language developed by 
Adobe Systems that has become an industry standard. 
It's a language that PostScript-compatible jJTinters read 
(as opposed to a language that your comfJUterreads). It is 
PostScript that enables complex graphics to be printed at 
any resolution (wha tever the resolution of tJ1e prin ter). 
Also see PostScript f})inter. 

A PostScript printer (or PostScript-<:ompatible p rinter) 
is a printer that can interpret the graphi cs and fonts that 
are written in the PostScript programming language. 
Not all laser prin ters can read PostScript. J ust because 
a printer has a high resolution does not mean it is Post
Script. For instance, the Apple StyleWriter prin ts at 
400 dots jJer inch, but it is not PostScript. Usually if a 
printer is not PostScript, it is a QnicllDmw printer. 

Once you start usi ng keyboard commands, in stall a few 
IN17's and CDEVs, create a mat:ro or rwo, and start throw
ing around words like RAM and PostScrijJt, you can 
consider yourself a power user. Say the word SIMJvl, 
motherboanl, or CPU in mixed company and you will 
really get respect. 

Public domain is an adj ective d escribing any kind of 
work, not just computer software, for which the public has 
every right to copy and use in any way they see fit. The 
author has retained no rig h ts no r liabilities. Usua lly cuz 
they're dead. Public domain software is differe nt than 
software that is copyrighted to tJ1e author yet distributed 
publicly. See freeware and shareware. 

QuickDraw is the computer code that lives in the Mac's 
ROM (read-only memory) and is used for drawing graphics 
on the screen and o n the printe r. 

A QuickDraw printer is generally almost any printer 
that can't read PostScript. If a prin ter canno t read Post
Script, then it has to just recreate wha t it sees o n the 
screen . That's the big deal about ATM (Adobe Type 
Manager) . ATM makes certain typefaces clear and 
relatively smooth on the screen; thus when they print 
to a QuickDraw pri nter, they are much clearer and 
smoothe r on the page. 
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Wh en a fi le or a disk is read-only, that means you can 
look at and print the fi le or disk, but you cannot save 
changes onto it. Often you think you can , because th e file 
le ts you select and edit text, but when you go to Save it, 
you won't be allowed. Locking a disk or fi le (page 94) will 
make it read-on ly. GD-ROMn 1re read-only. A certa in part 
of the Mac's inn er workings are read-only. 

You wi ll usually sec a ReadMe fi le on a disk when you get 
a new software package. It's a good idea to read the m 
(how can you resist?) because they describe the product 
and often give you the details on any last-minute changes. 

·when you move an object across the screen, scroll , 
change windows, etc., all or part of the screen has to be 
redrawn. The Ylac has to figure o ut ·where everything 
has moved to and redraw them in their new places. 

How q uickly a screen is n•dmwn is called the refresh rate. 
Faste r is better, of course. 

The resolution o f a computer screen or printer is 
measured in dots j;er inch. The grea ter the number of dots 
pe r inch, Ll •c higher the resolution. The highe r the resolu
tion, the smoother the graphics and text will be. The 
standard Mac screen has a resolutio n of 72 dots per inch. 
T he Apple LaserWriter has a resolution of 300 clots per 
inch. The Apple Style\Nritcr has a resolution of 400 clots 
per inch. 

T he initials ROM stand for Read-Only Memory, which 
usually refe rs to the System information that is built into 
the chifJs inside the compu te r, the info rmation that gets 
the System up and runn ing. Also see r('([rl-only. 

RTF is Rich Text Format, another fi le formal in which 
you can save text. It holds onto a little more formatting 
information than does an i\ SCJJ file. 

A scanner is a piece of hardware. \Vhat it does is scan an 
image: You put a photograph or a piece of drawn art or 
sometimes a three-dime nsional obj ect on the scanner. 
You close the lid a nd push a button , the machine views 
(scans) the image, and sends a copy of it to the computer. 
It's sort of like making a xerox copy, but instead of 
coming out the other end, the copy comes out in th e 



compu ter. (Not all scanne rs work like I d escribed here; 
some a re hand-held and you roll the liule machine over 
the top of th e image . There arc also video scann ers that 
can input live stuff. ) T he image to the right was scanned in . 

When you scan images, the scanning software usually 
offers you several file fonnat o ptions. Un less you have a 
clear idea an d a good reason as to why you wou ld save it 
in any o ther forma t, always save scanned images as T IFFs. 
TIFFs were invented for scans. 

., If the image is straig ht b lack-and-white with no 
gray areas, save it as a line a rt TIFF . 

., If the image has gray tones, such as a p hotograph 
or pencil or charcoal drawing, save it as a gray
scale or con-tone T IFF. 

Halftones: Halftones only apply to gray or color 
areas. A ha lftone breaks the gray area into dots 
tha t a prin ter can print (sec lines jJerinch). If' the 
image is solid b lack-and-wh ite , you do n ' t need 
any sort of halftone . 

., If you r scanning software can create special e ffect 
halfton es tha t you want to usc (or if your printer is 
IIUL PostSaij;l-cumfmlible) , save i t as a halftone T IFF . 

., If there is no special effect halfto ne you need, the n 
don 't both er saving it as a halftone-le t th e Post
Script pr.inte r halftone it o n the way out. (Yes, a ll 
PostScrip t printers will do that; they take a ny gray 
or color image a nd break it in to lines per inch. T he 
number of lines per inch varies depending on th e 
printer. An Ap p le LaserWritc r halftones at 53 lin es 
per inch ; a Lino tronic 300 halftOnes a t 105 to 150 
lines per inch .) 

If you leave a n image o n the scree n for an extended 
pe riod of tim e, it will eventually burn in and leave a 
pe rman ent sh adow. A screen saver is a little program 
(a utility) tha t prevents burn in by creating interesting 
animated effects when you arc not working. Effects range 
from simple firewm-ks to moving patterns to flying toasters 
v:i th wings that you can hear beating if you listen closely. 
Some screen savers activate automatically if th e keyboard 
or mo use h aven' t been touched in a cer tain number of 
minutes (those bug me; I hate to be interrup ted while I'm 
thinking). Oth ers you must turn on yourself. A good o ne 
le ts you choose e ither. 
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SCSI SCSI, pronounced scuzzy, stands for Small Computer 
Systems Interface. SCSI is a connecting system, an interface, 
that allows computers and their peripheral devices (scanners, 
prin ters, etc.) to exchange information. T hose big cables 
with the little pins in them (usually 50 pins or 25 pins) are 
SCSI con nectors and they plug into SCSI jJorts on the 
back of the Mac. 

scuzzy See SCSI. 

shareware Shareware is copyrighted software that somebody went 
to the trouble to create and then distributed through 
user groups, bulletin boaul seroices, and fr iends. You can try 
the software for free, but if you like it yo u should pay for 
it Shareware is generally pret ty cheap ($5 to $20) and 
you really should pay it to encourage othe r people to 
create nice things for us. 

SIMM H a. Now I know what a SIMM is. It 's a Single Inline 
Memory Module. Well , that's what techies say it is. I say it 
is a little piece of plastic with chips on it. These particular 
chips are memory ch ips. When you wan t to add more 
memory, more RAM, to your computer you buy SIMMs. 
T hen somebody installs the SIMMs into your compu ter . 

software HaTdware is the stuff you can knock on. Software is the 
invisible stuff, the programming, the energy coursing 
through the chips that makes the computer work. Soft
ware is in the form of afJjJlications, or programs, in the 
memory stored inside the Mac, it's on th e disks, it's in 
the System that runs the machine. It's the big magic. 

spooler A spooler is software (or some times a combination of 
softlvare and hm·dwm-e) tJ1at allows you to work on your 
screen while your printer is pr inting. Typically what 
happens when you print without a spooler is that the 
computer sends the pages to tJ1e p rin ter. T he computer 
can send tJ1e information much faster than the printer can 
deal witl1 il. So the computer has to hang around and wait 
while the printer processes all the in formatio n. Then it 
sends a li ttJe more info and wai ts. Sends a tittle more and 
waits. Meanwhile, you are also wai ting because the com
puter is busy and won't let you have your screen back. 

But when you use a spooler, the compu ter sends the 
info rmation to the spooler instead of to the printer . T he 



spoole•- takes it all , says thank you very much, and then 
funnels the informa tion to the printer. Since the com
puter did its j ob of sending ofT the info, you get your 
screen back and you can work merrily along while the 
spoole r finishes telling the printer what to do. 

Some times whi le using a spooler your screen may get 
interrupted for a minute here and there while the com
puter takes care of detai ls. But in general, it's painless. 

Spreadsheet is another one of those te rms that intimi
dates us a t first. A database is for making a list of items 
that you can then manipulate; a spreadsheet is generally 
used for number-crunching. You can do your home 
budget o n a simple spreadsheet (I hire my tee nager to 
do it) , create invoices for your small business, proj ect 
your mortgage payments, etc. etc. etc. They are so cool. 
It's quite a feeling of power to set one up, plug in some 
numbers, and watc h it work. Most spreadsh eets also have 
a method for applying borders (lines) on the page, 
which means it is so incredibly easy to make great, instant 
forms: As you widen the page , the li nes get longer; if you 
de lete a row 0 1· a column , the lin es will also be deleted; as 
you ma ke the paint size bigger, the space between the 
lines gets bigger. It's terrific, even if you don 't have a 
single numbe r on the page. 

A stack is a document that has been created in the 
applicatio n HyperCard. HyperCard is a very interesting 
and provocative program that is difficu lt to explain in a 
few sentences so I'm not going to try. The biggest single 
difference between someth ing created in Hype rCard and 
something created in almost a ny o ther program is that 
the document, or stack, that you create in HyperCard 
never leaves the computer. In almost every other program 
you create something on the computer and the n print it 
up and you hand out the printed piece. In HyperCard , 
what you create is meant to be viewed by other people 
directly on the compute r. It works in a series of cards 
(hence the term slach, as in stack of cards). As you flip 
through the cards of information, you may find sounds 
and animation and music and interactio ns. I t's really an 
exciting and addictive program to work in, but you must 
keep in mind that for anyone to use your final prqject, 
they have to have a Macintosh. 
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Some people have more than one hard disk attached to 
their computer. Sometimes more th an one of those hard 
disks has a System Folder (be careful ! don't do that 
unless you know why and how to deal with two System 
Folders). The hard disk tha t is running the machine at 
the moment is the startup volume. Or you could call it 
the startup disk, but usually people refer to it as a volume 
if it is a hard disk. The startup volume boots the computer. 
The startup volume will always put its icon in the top 
right corn er. 

The te rm suitcase gets confusing because two very 
important, closely related, but not connected items both 
refer to it: suitcase icons and the fo n t management 
program called Suitcase If. 

Suitcase icons represent screen fonts or deslt accessories. 
In System 6 you can't open these suitcases, really. If you 
double-click on a suitcase to try to see the fonts or DAs 
inside, you wi ll go straight to the Fon t/ DA Mover (see 
page 61). While in the Fo nt/DA Mover you can click on 
the name of a fon t to see it displayed. [In System 7, if you 
double-click on a suitcase it opens up to a window with 
an icon for each font size and you can double-click each 
o ne to take a look at it; see page 119 and 136.] 

The re is a lso a wonderful program called Suitcase II 
which he lps you work more efficiently when you have a 
large number of fonts. It also resolves font conflicts, or 
identity crises, which is what happens regularly when a 
lot offonts get together. If you're a font freak (meaning 
you like and collect them), it is absolutely indispensable 
to use a program like Suitcase II or Master juggler to 
manage your fonts (even with System 7, no matter what 
they tell ya). 

But th e confusion occurs because people banter 
around the word suitcase referring to eithe r the screen 
font icon ono the font management p1·ogram, and a 
beginne r doesn't see the difference ye t. 

You'll know a system crash, or bomb, when you see 
one. Either you get a very polite yet disturbing notice on 
your screen with a picture of a bomb about to explode 
(cute, very cute), or things will just stop working. Your 
keys won 't work, the mouse won 't work. The only thing 
you can do is turn the computer off. See pages 195-196 



for a couple o f reasons why you might crash, how to 
avoid crashing, and wha t to do abou t it whe n it does 
happen (which it will). 

TeachText is a tiny little word processing program (it 
only takes up 36K of disk space). Often when you get 
new software you will see an icon called ReadMe. This fil e 
has the latest info on the software, or maybe some tricks 
you should know a bout. To make sure you can read the 
file, since the software company has no idea what word 
processing program you use o r even if you have one, they 
write the ReadMe fi le in TeachText, and then a lso send 
along the Teach Text ap plication on the disk so you can 
open ReadMe . 

The term telecommunications refers to communicating 
over the phone lines through a modem as opposed to 
using your voice. It's even faster tha n overnight mai l. 

A document that is formatted (saved) as is able 
to be read by almost any word processing or page layout 
program. It h as no formatting, like font size or style o r 
columns, etc. Text-only is synonomous with ASCII, so you 
should take a quick moment to look up that term (it's on 
page 141) . 

TIFF stands for Tagged Image File Format. It is a format 
used for saving or creating certain kinds or graphics. 
Graphics in TIFF are always bitmajJped, but the b itmap 
resolution can be very high , depending on the prog ram 
you are working in . TIFFs can be black-and-white li ne art, 
or they can be grayscale images. They were invented for 
scanning, so you might want to also read the scanning 
information (page 156) . 

Some me nu commands and keyboard shortcu ts a re 
toggle switches. This means if you ch oose it once, the 
command is turned on; if you choose the same command 
again, it is turned off. Someti mes a comma nd that can be 
toggled shows up wi th a checkmark next to it (although 
a checkmark d oes not mean it is necessarily a toggle 
switch!). Sometimes a command that can be toggled 
changes the name of tl1e command whe n you choose 
it (e.g. , "Show Clipboard" becomes "Hide Clipboard") . 
See "Changing Styles Mid-Su·eam" o n page 45. 
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Type 1 font There are two* distinct formats for type, Type 1 and 7)pe 3 
. (there really isn ' t a Type 2 format) . The corporation 
. Adobe Systems, Inc., had a monopoly on T ype 1 fonts; 

they used a secret formula to produce them and wouldn 't 
le t anybody else have the fo rmula. So everybody else had 
to make Type 3 fonts. 

Type 1 fonts are PostScript, and th ey are especially 
designed to print well at "low" resolutions (like 300 dpi). 
T hey print fast and clean on PostScrip t printers, and they 
can be scaled with Adobe Type Manager (A TM) to appear 
very smooth on your screen. In 1990 Adobe decided to 
publicize the secre t formula so everyone ("everyone" 
meaning font manufacturers) can create Type 1 fonts. 

*System 7 in troduces a new font format called 
. TrueType . If you 're interested , read Chapte r 30. 

Type 2 font Type 2 was a proposed font technology that never made 
it, so there are no Type 2 fo nts. 

Type 3 font Type 3 fonts are the typefaces that are made without 
Adobe System 's proprietary fon t technology. They tend 
to be less expensive, and they often don't print as clean 
and smooth, nor as fast, as T;•pe 1 fon ts. They also tend 
to be more graphic in nature; that is, many Type 3 fonts 
are very decorative, with gray shades and elabora te fills 
and fancy shadows. 

upgrade Whe n a company improves their software or hardware, 
that improvemen t is called an upgrade. T he upgrades 
are indicated by the version number; e.g., Page Maker 4 is 
in its fourth maj or upgrade since it was inven ted. Minor 
little fix-its are no ted by poin ts (well, tlwt's the only woni / could 

think of) . For instance, PageMaker is currently in version 
4.01 (pronounced four point oh one) . Ifyou are a 
registered owner of the software, you can usually purchase 
an upgrade at a significantly reduced cost, and sometimes 
you even get the upgrade free. If your hardware goes 
through an upgrade, you just have to buy the new piece. 

upload \Vhen you use your modem to copy informatio n off of 
another computer and put it on yours, you are down
loading (taking it down from the other computer). When 
you use your modem to put informa tion onto another 
computer, you are uploading (putting it up onto the 
other compute r). 
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A utility is an application, general ly a very small applica- utility 
tion , that has a very limited fun ction . Util ities don ' t 
create docume n ts; th ey just make things work bette •- or 
add a bit of sparkle or convenie nce to your computer. 
The Fonl/DA Mover (Chapter 19) is a uti li ty. Adobe 
T)tJe l'vlanager is a uti I it y. 

When a company announces that their software is about · vaporware 
to appea r on the market and the n it doesn ' t appear 
when it is supposed to, that software is considered 
vaporware. The term eve n gets loosely applied to 
books that don' t appear o n time, o r b lind da tes. 

A video card is the card ( the piece of plastic with chijJs video card 
attached to it) tha t con tro ls the d isplay on your screen. 
You can get di ffe rent kinds of video cards for diffe re nt 
kinds of monitors that allow the monitor to display 
d ifferent levels of gra)'scale or colors. 

Viruses a re very interesting things. A virus is a program virus 
that a very intelligent, very skilled, and very evil, sick 
person writes. It is '"'Titten to do such things as destroy 
the data o n your computer, corrupt your System , lock 
you out o f your own machine, eat you r programs. They 
can wipe out an enti re ha rd disk. Viruses travel from 
computer to computer th rough flopp)' disks, networks, 
and even modems. You do n ' t always know you have a 
virus; they ofte n have a de layed reaction time, so you usc 
the sick program for a while unti l one day it eats you. It 
seem s that a person who can write a program to do so 
much evil is certa inly brigh t eno ugh to g·et a real j ob and 
direct that ene rgy into making people happy instead. 

This is a virus scen ario: You have a disk that is infected. 
You put it into yo ur Mac. As you use an application o n 
that disk, the virus gets into your Syste m. You ta ke that 
disk out and insert another one. T he virus jumps from 
your System o nto an applicati on on the floppy disk. You 
take that disk o ut, go to another computer in the office 
and insert it. The virus jumps from that disk onto the 
other person 's Syste m. Ad infin itum. The \•VDEF virus is 
so contagious that simply inserting an infected disk into 
a computer infects the computer. It's sort of comparable to 
somebody with a social d isease getting on a bus and eve•)'
body on th e bus automatically getting the disease. T hen 
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the stores and everybody in the stores gets the disease. 
Fortun ately \VDEF is not a terribly devastati ng virus, just 
very irri tating. See page 92 for an easy way to get rid of 
this pest (System 7 is immune to WDEF and to CDEF). 

How do you know when you have a virus? Things start 
acting funny on your computer. Windows may not 
fu nction properly, prin ting might not \Vork righ t, files 
may be changed, programs may be "damaged." If anything 
starts acting weird , you can suspect a virus. (Actually, fi rst 
you should suspect any INI1s or CDEVs you may have in 
your System folder, since they are a much more likely 
cause of little troubles. Take them all out and pu t them 
back in again, one a t a time, over a period of a cou ple of 
days. T hat way you can pinpoin t the offensive creature 
and remove it.) If you think th e problem really is a virus, 
then get virus-protection software and d isinfect your 
hard d isk and every singfe disk in )'OUr entire house and office. 

: And never again le t anyone put a disk in your computer 
with out checking it first. 

Everyone should own virus-protectio n software as a 
normal part of computer life. T he best package is one 
called Disinfectant. It has an applicatio n that will locate 
and kill any virus, and it comes with an !NIT that will 
quietly check any d isk you put in your machine. If an 
infected d isk is inserted, Disinfectant sets off bells and 
whistles (literally) . It is freeware, written by a wonderful 
man named j ohn Norstad a t Nor thwestern University. 
He spends time to write this program and is constantly 
upda ting it to catch new viruses. Can you believe that? 
He does this out of th e kindness of his heart, an intrepid 
soul battling the forces of evil. Write him a nice thank
you letter and tell him how wonderful he is. 

Disinfectant is available on severa l of the bulletin board 
seruices, from user groufJs, or from friends. You do need to 
be on the lookout at all times for the latest version of it, 
since those evil minds are constantly striving to ou tsmart 
the current virus-protectio n sofuvare . 

Viruses have the potential to cause catastrophic damage; 
however, most Macintosh \~ruses have been held in check 
by virus-protection software, an d with a little knowledge 
you can easily protect yourself and you r loved ones. 



See ~WS/1t\IYC, just below. 

WYSIWYG stands fo r What You See Is Wha t You Get, 
which means that what you see on the screen is what will 
print out on paper. If you arc just beginning to use a Mac 
and you have never used any o the r computer , you may 
wonder what the big deal is about v.rysiwyg because of 
course that 's the way it is and that 's the way it should be . 
But it is actually a re la tively new concept, a nd o ne where 
the Mac excels over those other mach ines. 

T hese num bers designate differe nt chifJs (designed by 
Mo to ro la). T h ese particular chi ps run the computer s, 
and the higher t.he number the faster a nd more powerful 
the machine. For instance, the 68000 chip is the on e in 
the o lder Macs, like the 128, the 512, the Plus, and the 
SE. The Mac II has a 68020 a nd runs about five times 
fas ter than the 68000. The 68030 was a big deal and was 
installed in th e SE/30, Ilx, and Ilcx. And th e 68040 is of 
course eve n faster a nd does more tricks. 

Othe r impo rta nt chips have these o ther numbers and 
do things like increase the fl oating point math em atics 
speed by about LOO times, whatever that mean s. 
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"About the Finder" 
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interesting item s in , 11 3 
Accelerator board, 14 I 
Accent marks, 50 

a l ist of common, 50, back page 
Adobe Systems, Inc., 162 
Adobe Type Manager, 141, 162 
Alarm Clock, 79 

changin g the date of, 80 
changing the se ttings of, 79 
changing the time o f, 79 
closing up, 80 
creating a copy of date and Lillie with , 79 
setting the alarm of, 80 
turn ing ofT, 80 

Alert box, 14 I 
Aliases (System 7), 127-130 

finding orig ina l file be lo nging to , 130 
how to make, 128 
ideas for using, 129 

Alignment of text, •Hi 
as it affects entire pa ragraphs, •I() 

changing, 46 
"All" (print command), 57 
"all at once" (System 7 "Find File"), 132 
American Standard Code for Information 

Interchange, 14 I 
Apple key, 19 
Apple LaserWriter 

fon lS installed in , 66 
halftones with, 157 
lines pe r inch o n, 149 

Apple menu, 13 
changes to in System 7, 11 3 

Apple Menu Items (System 7), 11 3. 120 
a liases on, 11 3 

Apple StyleWriter, 65 
AppleTalk, 56, 8 1, 14 1 
Application menu (System 7), I I ll, 13!.1 
Applications, 28 

checking the ir compati bili ty for Systc111 7, 
100 

icons for, 28, 39 

INDEX 
W:· M i'F ....,. 

in System 7 
h ow to open on startup , 11 5 

in System 7 MultiFinder 
selecting, 139 

openi ng, 39, 39-40 
opening 39-40, 39 
quitting, 59 
synonomous with program , 39 
System 7-compat.ible, 100 
System 7-<lependent, I 00 
System 7- friendly, 100 
wh en one can't be found 

wha t to do, 95 
ASCII, 141 
Askee, 141 
ATM, 141 , 162 
Automatic font substitution 

on the LaserWriter 
exa111ples of, 71 

B 
Backing up 

documen ts you create, 10 
often, 10 
software applications, l 0 

Backspace, 41 
key, 19 

Backspace (delete/clear), 48 
Backup Disks, I 0 
Balloon (System 7 online Help), I 17 
Baud rate, 142 
BBS, 142 
BCS/Mac, I 00 

"Before You Install" 
Syste m 7 cl.isk, I 00 

Berkeley Macintosh Users Group, I 00 
Beta versions, I 112 
Binary digit, J 42 
Binary system, 7 
Bit, 7, 142 
Bitmapped 

definition o f, 142 
T IFFs as, 161 

Bitmapped fonts, 65, 66, 68, 153 
on th e lmagcWritc1· 

examples of, 69 
on the l .aserWriter 

examples of, 70 
examples of with automatic font 
substi tutio n, 71 
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Black icons, 29 
Blank spaces 

as represented in menus, 20 
in text, 43 

BMUG, 100 
Bamb, 12 
Bombs 

definition of, 142 
possible JNlT responsibility for , 96 
when running ~1ultiFinder without 

enough RAM, 138 
Baoting up/to boot, 11 , 12, 142 
Boston Computer Society/Macintosh, 100 
Bugs, 143 
Bulletin Board Service, 142 
Bunny rabbit, 49 
Bus, 143 
Byte, 7, 143 

c 
"C" with Command key, 48 
CAD, 143 
Calculator, 80 

how to operate, 80 
"Cancel," 18, 40 
Caps Lock key, 20 
Cards, 141, 143 

video, 163 
CD·ROM, 143 

as read~nly, 156 
CDEF, 164 
CDEVs, 144 

disabling in System 7, 106 
Centering text, 44 
Central Processing Unit, 144 
Changes in a document 

saving versions without, 53 
Changing the name of a folder, 33 
Chips, 143 

in cards, 143 
numbers designating Motoro la, 165 

Chooser, 28, 56 
how to use, 56, 8 1 
printer icons in, 56 

City named fonts, 65. See aLso llitmapped fon ts 
on a PostScript printer, 67 

"Clean Up," 25 
"Clean Up" (System 7), 11 6 
"Clean Up Desktop" (System 7), 116 
"Clean Up Selection," 25 
"Clean Up Window," 25 
Cleaning the mouse, 16 
Cleaning up 

Desktop 
in System 7, Ill 

Clear (backspace/delete), 48 
click·and·drag, 15 
Clicking 

double, 15 
in the scroll bar, 23 
single, 15 

Clip art files 
viewing, 95 

Clipboard, 46 
Backspace/ delete/ clear and, 48 
icou for, I 20 
in relationship to the Scrapbook, 86 
in System 7, 120 
showing, 46--47 
visual represenu·uion o f, 86 

Clock & Calendar, 82 
"Close," 13, 59 
Close box, 2 1, 23 
Closing, 59 

a document, 59 
folders 

in System 7, 109 
vs. quitting, 59 
wi ndows, 25 

as you go alo ng, 25 
Color 

assigning to highlighted text (System 7) , 11 5 
Color control pane l 

icon for, 124 
Color control panel (System 7), 115, 124 
Color menu 

lack of in System 7, 11 5 
Command C, 48 
Command key, 18, 19 
Command key symbal 

typing, 20 
Command V, 48 
Command X, 48 
Command Z, 48 
Command Z XCV, 48 
Commands 

black, 17 
grey, 17 

Compact Disk, Read·Only Memory, 143 
Compatibility checker 

in System 7, 100 
Compressing 

folders 
in System 7 "Find File," 132 

Compressing folde rs 
in System 7, 109 

Computer Aided Design, 143 
"Computer Paper" (print command), 57 

Control key, 20 

==========~~========= 
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Control Pone l, 8 1-82 
Clock & Calendar, 82 
Desktop Pattern , 82 
Keyboard, 82 
Mouse, 83 
Sound, 82 

Control pane l device, 144 
Control Panels (System 7), 120, 123- 125 

Colo •·. 124 
Easy Access, 125 
File Sharing Monitor, 126 
General Cont rols, 123 
Labels, 124 
Memo ry, 125 
~1onitors, 125 
networking, 126 
Portable, 126 
Sharing SeiUp, 126 
Sound, 124 
Stanup Disk, 124 
Users & Groups, 126 
Views, 123 
World map, 125 

Control pane ls (Syste m 7), 123- 125 
Copies of disks 

as back ups, I 0 
"Copy of _./' 37 
Copying, 46 

characte rs on Key Caps, 85 
how to, 47 
items from the Scrapbook, 86 
special chan1cte•·s, 49 

Copying files, 3 7 
more than o ne at a lime, 37 
to another disk, 37 
to same disk, 37 

CPU, 144 
Crash. See also Bo mb 

what to do when you , 14'1 
Create your own new, e mpty folders, 33 
Creating project-specific folders, 35 
CuHing, 46 

how to, 47 

D 
DAs, 13, 75, 79- 86 

Alarm Clock, 79 
Calculator, 80 
Chooser, 81 
Control Panel, 8 1 
Find File, 83 
Installing or removing, 78 
Key Caps, 84 
Mouse, 83 

INDEX • disk swapping 

Note Pad, 85 
Scrapbook, 86 
System 7, 11 3 

installing, 11 3 
Database, 144 
De lay Until Repeat, 82 
Delete, 19, 42 
Delete (clear/backspace), 48 
Deleting 

from the Scrapbook, 86 
Dese lecting 

all files, 38 
one file , 38 

Desk Accessories. See DAs 
Desktop, 13 

a.k.a. Finder, 13 
checking your fonts at, 92 
definition of, 144 
file 

what to do if it gets too full , 96 
in System 7, 10 1 

custo mizing windows in, 123 
printing, 105 
window, 105 
witl1 Mult.iFinder, 138-139 

~1enu, 17, 59 
organ il.ing, 14 
rebuilding, 92 

"Get Info" notes when, 3 1 
"Desktop" (System 7 buHon), I 04 

Desktop Pattern, 82 
"Device independent," 146. See also PostScript 

language. See also PostScl'ipt 
Dialog boxes, 18 

definitio n o f, 144 
ejecting disks throug h, 62 
Find File, 83 
Fonl/DA Mover, 76 

"Open," 77 
in System 7, I 04 
moving around in using Tab key, 90 

"New Fo lder" button in System 7, 104 
"Open," 40 
"Save as ... ," 18, 35, 52 
statio nery pads (System 7), 106 
T rash Can warning (System 7), 103 
11rarning, 30 

Dimmer switch, 9 1 
Dingbats, 66 

Zapf, 99 
chan of, 99 

Disinfectant, 164 
availab il ity of, 164 

Disk size, I 0 
Disk-swapping, 92 
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disks • INDEX 

Disks, 8 
"Before Yo u Install " System 7, 100 
caring for , 8 
ejecting 

thro ugh the menu, 62 
thro ugh the trash, 61 

lloppy 
cop}·ing with one lloppy d rive, 9 1 
icons for, 8, 9 
rebuilding desktop Iiles o f, 92 

formatted , 9 
formatting, 9 
gray 

left on scree n after being rej ected, 61 
memory of sti ll in Jti\M, 6 I 
what to d o if le ft on the screen , 98 

hard, 9- 10, 12 
and shutting doh·n, 63 

high-density d ouble-sided , 8 
ini tialized , 9 
initializing, 9, 148 
locking, 9 
"Ne tworking Basics" for S)·stem 7, I 00 
nom tal double-sided , 8 
re-initializing, I 48 
spitting out 

wha t tO do about, 93 
un locking, 94 
various ways 10 eject, 62 

Documents 
closing, 59 
icons for , 28, ::19 
in relationship with Scrapbook and 

Clipboard 
visual represent.a tion of, 86 

in System 7 
finding and updating, 107 
how to open o n swrtup, I 15 
making templates o m of, I 06 

lost 
wha t to d o. See Find File 

making several versions of, 53 
" ew" vs. "Open," 40 
o peni ng, 39-40 

Dogcow, 145 
Dot matrix printer, I 45 
Dots per inch, I 45 
Double click, 15 
Double-spacing, 43 
Downloadable fonts, 66 

changing style of, 7R 
Downloading, I 45 
Dragging 

items togethe r. 38 
the scroll ba r, 23 
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Drive, 12, 145 
externa l, 12 
inte rnal, I 2 

"Drive," 40 
Driver, 145 

"Duplicate," 37 

E 
E·mail, 145 
Eosy Access (System 7), I 25 

icon for , I 25 
Edit menu (System 7), I I 'l 

"Eject," 40, 62 
Ejecting disks, fi I, 62 

from the exte rnal drive, 62 
from the internal drive , 62 
in a power ou tage o r a ~)'st em e r ror , 62 
in System 7 

ancl leave no thing in memory, 106 
on a Mac with " YO imernal drives and an 

external, 62 
th rough d ialog boxes, 62 
th rough the menu, 62 
using a dialog box, 18 
with a paperclip, ()2 
With the ITIOIISe, 62 

Ellipses 
meaning o f in menus, 90 

Ellipsis, 18 
"Empty Folder," 33 
"Empty Trash," 30 

Encapsulated PostScript File, 146 
Enter key, 20 
EPS, 1•16 
EPSF, 1<16 
Error (System) 

~jccting sw ck disks after , 62 
1'esc," 20 

Escope key, 20 
Extended keyboard, 19 
Extensions (System 7), 12 1 

icon for, 121 
Externol drive, 12 
External hard disk, I I 
Eye-beam. Sfp 1-bcam 

F 
Families 

Font, 78 
Fenton, Erfert, 78 

"SO% Reduction," 57 
File format, 146 
File menu 

in S)·Stcm 7, I I o1 



INDEX • fonts 

----------------------------------~ 
File server, 146 
File Sharing Monitor control panel 

(System 7), 126 
icons for , 126 

Files 
in use, 95 
localing, 83 
locking, 32 
opening 

what to d o when you can't, 911 
p utting away, 84 
putting on the DeskLOp, 83, 83-84 
System 7 

dragging to select, II 0 
finding, 13 1- 133 
installing, 11 3 
restricting searches when fi nding, 133 
sharing, 107 

throwing away when locked, 32 
unlocking, 32, 94-95 

Filing cabinet, 33 
Find File, 83-84 , 94 

dialog box, 83 
System?, 13 1- 133 

"all at once," 132 
"Find Again," 132 
"Search ," 133 
search wi th a sear·ch , 133 

using from inside an application, R'l 
using to lind an extra System, 96 

Finder, II , 13 
a.k.a. Desktop , 1<16 
aka Desktop, 13 
icon, I I 
the concept, I I 

"Finder Shortcuts" (System 7), I I I 
example o f. I I I 

Fkey, 146 
Flashing X 

what to do when you ge t, 93 
floppy disks. See also Disks 
Folders, :13-35 

changing the name o f, 33 
creating proj ect-specific. 35 
creating your own . 33 
icons for, 27 
labels for , 40 
me nu for. !>2 
menus fo r, 40 
naming a new, 33 
openin~;, 34 
organizing }'Ollr disk using, 34 
puuing something inside, 34 
pmting something inside o f, 34 
removing something fro m, 34 

vs. copying something from, 34 
saving into, 35 
System 7 

compressing, 109 
compressing in "Find File," 132 
c reating, 104 
expanding, I 09 
viewing hie rarch ies of, Il l 

Font/DA Mover, 75, 75- 78 
dialog box 

"Open ," 77 
how to nse, 75 
icon fo r, 75 

Font/DA Mover dialog box, 76 
Fonts, 65-68 

a no te about fontlinnilies and styles, 78 
automatic substitution 

examples o f o n the LaserWrite r, 71 
bitmapped , 65, 66, 68 

examples of o n the Image Write r, 69 
examples of o n the LaserWr ite r, 70, 71 

chang ing, '14 
a lignment o f, 46 
size of, 45 
style o f, 45 

checking a t the desktop 
how to, 92 

c ity name, 65 
associatio ns with , 66 
o n a PostScript printer, 67 

downloadable, 66 
chan,;ing s[yle of, 78 

from d ifferent vendors 
preventing m ix-ups with , 136 

installed, 66 
monospaced , 65 
moving. 75 
name associations with, 66 
no n-TmeT ype 

installi ng in System 7, 136 
ou tline, 65, 68. See oLw True Type fon ts 

(System 7) 
outline style in size menu, 67 

determining True T ype throug h, 135 
PostScript, 66, 68 

examples o f on th e LaserWriter, 72 
printe r (o ml ine), 68 
remo"ing. 75 
scalable. Srr TrueType fonts (System 7) 
screen sizes, 68 
size of, 74 

and screen resolution, 67 
printed examples, 74 

System 6 and System 7 
mixing, 136 
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fonts (continued) ~ INDEX 

Fonts (continued) 
System 7 

seeing in System file, I 19 
TrueType (Syste m 7}, 135-136 
Type 1, 162 
Type 2, 162 
Type 3, 162 
whe re to find ones to install, 75 

Form-feed button 
o n an lmageWriter, 58 

Form-Feeding paper 
problems with, 98 

Formatting disks, 9 
Freeware, 147 
Freezes (screen) 

what to do ;tboul, 94 
"From _ to _, (print command), 57 

Function key, I 46 

G 
G, 147 
General Controls (System 7), 123 

icon fo r , 123 
"Get Info," 3 I 

notes, 31 
Gigabyte, I 47 
Good housekeeping, 63 
Gray icons, 22, 29 
Gray scroll bar, 21, 22 
Gray vs. black commands, 17 
Grayscale, 1'17 

H 
H E L P I, 93-98 
Halftones, 157 

with scann ers, 157 
Hard copy, 147 
Hard disk, 9-10, 12 

and shuuing down, 63 
exte rnal, 11 
in ternal, II 

Hard return, 42 
innuen cing a lignment, 46 

Hardware, 14 7 
HD, 8 
Header. See Informa tio n Bar 
Help (online) 

de fini tio n or, 153 
Help menu (System 7), I 17 
Help screens (System 7), I I 0 

viewing, I I I 
HFS, 14, 34, 147 
Hidden Icon, 2 1 

"Hide Balloons" (System 7), 11 7 
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"Hide Others" (in MultiFinder), 140 
Hierarchical Filing System, 14, 34, 147 
Hierarchies 

o f nested rolde rs in System 7, I ll 
High-density, double-sided disk, 8 
Highlighted 

tex t 
assigning color to (Syste m 7) . 115 

Highlighted icons, 29 
Highlighted text 

sho rtcut ro r re placing, 90 
Highlighting text, 42 

unhighlig h ting, 42 
Hot spot (in the pointer), 16, 37 
HP DeskJet, 65 
HyperCard, 159 

S>·stcm 7 compatibility checker in , 100 

1-beam, 33. 41 
Icons, 21, 27- 32 

alias (S>·stcm 7), 127 
applicatio n , 39 
application men u. I 18 
assign ing labels to (Syste m 7), 114-1 15 
blac k, 29 
chan~ing back to original (System 7), I 12 
cleaning up a ll alpha betically (System 7), 

I 16 
cleaning up selected (Syste m 7), 116 
Clipbo ard, 120 
Colo r control pane l, 124 
con trol panels, I 2:3 
creating your own (System 7}, I I 2 
DAs, 78 
document, 39 
duplicate. SreAiiascs (Syste m 7) 
Easy Access (System 7), 125 
Extens ions (System 7), I 2 I 
File Sharing Monitor control pane l 

(System 7). 126 
Finder, I I 
fl o ppy d isk 

unlocked, 9 
floppy d isk, 8 
folder, 27 
Fon t/ DA Move r, 75 
fo r station ery pads, 106 
Genera l Con tro ls (Syste m 7). I 23 
g ray. 22. 29 
hidden, 21 
HyperCard, 159 
importance of in .\'htl tiFindc r , I 39 
in S}·stcm 7, I OY- I I 2 



----------------------~INDEX~ leading 

Key Layout, 84 
Keyboard , 125 
labeling (System 7), 11 5 
Labels control panel (System 7) , 124 
Memory con trol panel, I 25 
Monitors contml panel, I 25 
Mouse, 125 
moving, I 5, 32 
networking contro l panel (Sy-stem 7) , 126 
Portable control panel (System 7) , 126 
Prefer·ences, I 21 
printer, 56 
printer fo nt, 68 
printer port, 56 
question mar·k (System 7) , 5 
renaming, 32 

undoing an accidental, 32 
renaming (System 7), I 12 

undoing, I 12 
Scrapbook, I 20 
screen dump, 30 
selecting (System 7), I I 0 
Sharing Setup contro l panel (System 7) , 126 
Sound co n tro l pane l, I 24 
Startup Disk, 124 
sui tease, 68, I 60 
System, I I 
system, 27 
System file (S)'Stem 7) , I I 9 
System Folder, I I , I I 9-12 I (System 7) 
Trash Can, 29 
Users & Croups contml panel (System 7) , 

126 
Views control panel (System 7), I 23 
windO\\' 

cleaning u p in System 7, I I I 
world map (System 7), I 25 

lmagesetters, 65 
lmageWriter 

a ligning pin-led paper o n, 58 
as a dot matrix printe r, 145 
city named fonts on , 67 
form-feed button on , 58 
Resolutio n 

example of, 68 
troubleshooting for, 97 

Information Bar, 21, 23 
Initializing disks, 9, 148 

m-initializing, I 48 
INITs, 148 

as cause of bombs, 96, 148 
conflicts among, 96 
disabli ng in System 7, 106 
effect on RAM, 96 
unfortunate qualities of some, 96 

Inserting a disk, I 2 
Insertion point, 15, 4 I 

formau ing, <14-45, 49-50 
Installed fonts, 66 
Installing 

items into the System Folder (System 7) , 121 
Installing fonts, 75 
Internal drive, I 2 
Internal hard disk, I I 

J 
Jargon, 14 1- 165 
Justified type, 46 

K 
K, 7 
Kerning, I 49 
Key Caps, •19, 50, 84-85 

copying and pas ting characters on , 85 
how to access using the option key, 50 

Key Caps entry bar, 49 
Key Layout icon, 81 
Key Repeat Rate, 82 
Keyboard, I 9 

icon fo r, I 25 
on Control Panel, 82 

Keyboard command shortcuts, 18 
Keys, 19-20 
Kilobyte, 7 

L 
Label menu (System 7), 114 
Labels 

in System 7 
applying, 121 
applying to icons, I 15 
assign ingto icons, ll4-1 15 
changing, I 15 
globally changing from control pan el, 115 
se tting up your own system of, I 15 

Labels control panel (System 7), 11 5, 124 
icon for, I 24 

Laser printers 
and screen font resolution , 67 
how to save toner and paper o n, 57 

LaserWrite r, 65 
bitmapped fon ts on 

examples of, 70, 71 
PostScript fonts on 

examples of, 72, 73 
Resolu tion 

example of, 68 
Launch, 119 
Leading, I 49 
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ligature ... INDEX 

Ligature, 149 
Line-feeding paper 

problems with , 98 
Lines pe r inch, 149 
Linotronic, 55, 65 

halftones with, I f\7 
list views 

in Sytcm 7, 110 
The Little System 7 Book, 100, 107, 108 
LocaiTalk, I 07 
Locking disks, 9 
Locking files, 32 
Love notes, 31, 85 
Logging on/off, 150 

M 
Macintosh Basics, i i 
The Mac is not a typewriter, 50 
The Macintosh Font Book, 78 
MacPaint, 28 

screen dump/ shot, 30 
Macro, 150 
MacWrite II, 28 

"Make Alias" (System 7), 11 4 
Making a window active, 22 
Map (System 7), 125 
Megabytes, I 0 
Megs, 10 
Memory, 150. See also RA\1 

messages about not enough , 140 
running out of 

what to do abom . Sef also RAM 
Memory control panel 

icon for, 125 
Memory control pane l (Syste m 7), 125 

turning on virtual memory from, 125 
Menu, 17-18 

choosi ng comrnancls from, 15 
pop-up. 17, I 04 
pull-down, 17 
selecting an item, 17 
System 7, 113-11 7 

Me nu bar 
in MultiFinder 

two major indications of, 139 
Modems, 161 

accessing BBS th rough, 142 
baud rate of, 142 
definition of, 150- 15.1 
downloading to, 1·15 
uploading to , 162 

Modifier keys, 15 1 
Moire, 15 1 
Monitors control panel (System 7), 125 
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icon fo r, 125 
Monospaced type, 50, 65 
Moofl"', 152 

"More Choices" (System 7 "Find File"), 132 
Motherboard, 152 
Motorola 

chips from, 165 
Mouse, 15-16 

adjusting from the Comrol Panel, 83 
cleaning, 16 
hm,· to use, 15 
icon for, 125 
using LO e ject disks, 62 

Moving 
an icon.32 

on same disk, 34 
to a different disk, 34 

as opposed to copying, 34 
objects j ust a pixel or two (System 7), 125 
windows, 21 

with out making them active, 22 
Multi 

RAM , 138 
MultiFinder, 1::17-1 40 

"Hide Others," 140 
hiding wincJm,·s while in (System 7) , 140 
menu bar in 

being especially consc ious of, 139 
rn essagcs about not enough memory 

while in , 140 
RAM necessa ry for running, 138 
using with System 7, 11 8 

unique qua lities of, 102, 138, 1::19 
Multimedia, 152 

N 
Naming folders, 33 
Nelson, Kay Yarborough, 100, 107 
Nested, 152 
Network, 152 

using System 7 aliases on, 129 
Network buttons, 56 
Network option, 8 1 

"Networking Basics" for System 7, 100 
Networking control panels (System 7), 126 

11New," .:JQ 
\ 'S. "Open," 40 

"New Folder," 33 
buuon in System 7, 104 

Normal, double -sided disk, 8 
Norstad, John, 164 
Note Pad, 85 
Number-crunching, 159 
Numeric keypad, 19 



0 
Object-oriented, 152 

graphics, 154 
OCR, 152, 152-153 
Online, 153 
Online Help 

System 7, 117 
Online help, 153 

"Open,'' 40 
dialog box, 40 

within the Font/ DA Mover, 77 
Open icons, 29 
Opening 

applications, 39 
documents, 39 
Iiles, 40 
folders, 34 

in System 7, 109 
Optical Character Recognition, 152 
Option key, 19 

when you choose "Quit," 25 
Organizing 

your desktop , 14 
in System 7, 111 , 11 6 

your disk using fo lders, 34 
"Orientation,'' 57 

Outline fonts, 65, 68, 153. See allo PostScript 
fonts; TrueType fonts (System 7) 

Outline view (System 7), I 09 

p 
"Pages,'' 57 
Paper 

form-fed or line-fed 
problems with, 98 

Paperclip 
using to eject disks, 62 

Paragraphs 
a lignmem influencing entire, 46 

Posting, 47 
characters on Key Caps, 85 
how to, 47 
into the Scrapbook, 86 

Periods 
why to usc one space after, 50 

Peripherals, 154, 158 
PhoneNet, 107 
Pica, 154 
P1CT, 154 
Pictures, 27. See also Icons 
Pin-Fed Paper 

how to a lign o n an Image Writer, 58 
Pirating, 37, 154 
Pixel, 154 

INDEX "' printers 

Plugs. See Ports 
Pointer, 16 

"Hot spot" / tip of, 16, 37 
Points, 45, 154 
Pop·up menus, 17 

in System 7, 104 
Portable control panel (System 7), 126 

icon for, 126 
Ports, 81, 154 

icons for, 56 
PostScript fonts, 66, 67, 68, 162 

on the LaserWriter 
examples of, 72 

PostScript language, 153, 155 
PostScript printers, 55 

and screen fon t resolution, 67 
cicy-n amed fonts on, 67 
defin itio n of, 155 
what they print, 68 

Power outage 
ejecting disks during, 62 

Power user, 155 
trick of, 25 

Preferences 
icon for, 121 
S)'Stem 7, 12 1 

Press 
fu nCLio ns of, 15 

Press-and-drag 
functions of, 15 

Print dialog boxes, 56 
11Print .... ," 56 

Printer font icons, 68 
Printer fonts, 68 
Printer icons, 28, 56 
Printer port icons, 56 
Printers, 65 

Apple LaserWrite r 
halftones wit.h, 157 

icons for, 56 
imageseuers, 65 
lmageWriter, 65 

aligning pin-fed paper o n , 58 
city named fonts on, 67 

laser, 65 
Linotronic, 55 

halftones wit.h, 157 
PostScript, 55 

and screen font resolution , 67 
cicy named fon ts on, 67 
what they print, 68 

PostScript laser, 65 
printing to your personal, 55 
QuickDraw, 55, 65 

AT:VI with, 141, 155 
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printers (continued} "' INDEX 

Printers ( r.outinued) 
d efini tio n o f, 155 
what it prints, 68 

Printing, 55-58 
fro m t11c JmageWrite r 

example of reso!Uiion from, 68 
fro m the LaserWrite r 

example of, 68 
in SysiCm 7 

the Deskto p, I 05 
windows, 105 

pre paring to, 55-58 
spoole rs for , J!,S 
the screen, 26 
the winclo w o n a n lmageWrite r , 26 
to your personal prime r, 55 
tro ubleshooting fo r, 97 
why yo u always want to save p •·ior to , 56 

Problems with your Mac 
some he lp in solving simple, 93-98 

Programming languages 
PostSc ript, 55 
QuickDraw, 55 

Programs. Sre also Applicatio ns 
icons fo r, 28 

Public domain, 155 
Publishers and Subscribers (System 7), I 07 
Pull-down menus, 17 

"Put Away," 29 
Puzzle (System 7), I 05 

getting the orig inal back, 105 
pasting new pictures into, I 05 
switching to numbe rs, I 05 
viewing . I 05 

Q 

"Quality," 56 
Question mark icon (System 7), 5 
QuickDraw, 155 
QuickDraw printer 

what it prin ts, 68 
QuickDraw printers, 55, 65 , 155 

with AT!\1 , 141 , 155 
"Quit," 13 

vs. "Close," 13 
Quitting, 59. SPr aLfO Closing 

closing all windows when , 60 
closing all windows whe n , 59 
vs. closing, 59 

Quotation marks 
creating re al, 90 
vs. inch and foot marks, 90 
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R 
RAM, 30, 5 1, 150 

<L~ it in nuences t11e Cli pboard, 47 
finding o ut how much you have, 99 
in System 7 

amoumncedc d , 99 
me mory o f ej ected disks in, 61 
mess:-~ges abo ut no t e nough, 140 
necessa ry fo r running MultiFinde r, 138 
running Olll o f 

what to do about, 96 
the danger docume nts incur while in, 51 

Random Access Memory. See RAM 
Random Access Memory (RAM), 30 
Read-Only files/disks, ~2, 156 
ReadMe, 156 

with T each Text. 161 
Rebuilding floppy disk Desktop files, 92 
Rebuilding your Desktop 

(happy) fate o f Note Pad whe n, 85 
fa te o f "Get Info" no tes when, 31 
how to go abo ut, 92 
why rou 'd eve r want to. 92 

Redraw, 156 
Refresh rate, I 56 
Removing 

something fro m a folde r, 34 
something fro m the trash , 29 

Removing fonts, 75 
Renaming an icon, 32 
Resolution, 65, 15 fi 

ddinitiou of, 115 
lmagcWrite r , 68 
LaserWri tcr , 68 

Resolution independent, 146 
Return Key 

as a sho rtcut, 90 
Return key, 20, 42 

hard re turns with , 12 
word wrapping with , 42 

Returns 
rem oving, 43 

"Revert," 53 
Rich Text Format, 156 
ROM 

definitio n o f, 156 
RTF, 156 
Rule Number 3, I 0 

s 
"Save, '' 53 

vs. "Save as .. . :· 52 
when and how to usc, 53 



11Save as . .. ,11 35 
dialog box, 18, 35 

when closing, 59 

n;;;;;a 

to make several versions of one document, 
53 

vs. ''Save," 52 
when a nd how to usc, 52 

"Save As ... " dialog box 
creating project-specific fold ers, 35 

Saving, 5 1,5 1-53 
documents 

right into their own folder, 35- 36 
files, 36 
impon ancc of, 5 1 
wh)' you want to do it often, 5 1 

Scalable fonts. SeeTnrcType fon ts (System 7) 
Scanne rs, 156 
Scanning, 152-153, 156 
Scrapbook, 3 I , 86 

copying items out of, 86 
d eleting items from, 86 
icon for·, 120 
in System 7, 120 
pasting into , 86 
visual represen tation of, 86 

Screaming, 48 
what to do before. 48 

Screen 
choosing shad es an d color for (System 7), 

125 
dump/shot, 30 
printing, 26 

Screen fonts. See Bitmapped fonts 
Screen freezes 

what to do about, 94 
Screen savers, 91, 157 
Screen sizes (fonts), 68 
Scroll arrows, 21, 22 
Scroll bars, 22 

gray, 22 
clicking in , 23 

white, 22 
Scroll box, 21, 23 
Scrolling windows 

in Syste m 7, 110 
SCSI, 158 
Scuzzy, 158 

"Search" (System 7 "Find File"), 133 
Search within a search 

in Find File (Svstem 7), 133 
Searching for fil~s 

in System 7, 132-133 
Selecting 

applications 
in System 7 with MultiFinder, 139 
~ 

INDEX ... standard keyboard 
- , =e !Sta"WP"" 

marquee method of, 38 
m enu ite ms, 17 
more than o ne file a t a time, 38 
shift-click method of, 38 
text, 15 

Service bureaus, 55 
"Set Startup" 

missing in System 7, 11 5 
Shareware, 158 
Sharing files (System 7), I 07 
Sharing Setup control panel (System 7), 126 

icon fo r , 126 
"Sharing ... " (System 7), 11 4 

Shift key, 20 
Shift lock, 20 
Shift-clicking 

to deselec: t files, 38 
to se lect more than one file, 38 

Shortcuts 
ke)•board command, 18 

"Show Balloons" (System 7), 117 
"Show the Clipboard," 46 
"Shut Down," 6 1,63 

Shutting down, 61, 63 
from the menu, 61 
keyboard shortcuts fo r , 61 
turn computer o ff witlw ut, 63 

SIMM, 158 
Single click, 15 
Single lnline Memory Module, 158 
Single·sided disk, 8 
Size Box, 21 , 22 
Sizes 

font, examples of, 74 
Slot, 12 
Small Computer Systems Interface, 158 
Software 

definition of, 158 
version numbers of, 12 

SOS, 51 
Sound, 82 
Sound control panel (System 7), 124 
Sounds 

in System 7 S)'Stem file, 119 
hearing, 119 

Spacebar, 20 
"Special," 13 

Special characte rs 
how to access, 48 

Special menu (System 7), 115 
Spoolers, 158 
Spreadsheet, 159 
Stacks, 159 
Standard keyboards, 19 
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startup disk • INDEX 

Startup Disk, 12 
System 7 

choosing, I 15 
conlrol pa nel , 124 
icon for comrol panel, 124 

Startup Items (System 7), 120 
Startup volume, 160 
StartupScreens, 91 

creating, 91 
Stationery pad (System 7), I 06 

creating through Get Info, I 06 
Style of type, 45 

changing, 45 
fo nt families and, 78 

Suitcase, 160 
icon for, 68 

Suitcase II, 160 
SuperDrive, 8 
Switches (on/off), II 
System. See also System 7 

bombs/crashes, 95 
definition of, 160 
possible I NIT responsibility fo r, 96 
what to do about, 95 

concept of, I I 
e rror, 62 

c;jecting swck disks afte r, 62 
finding an extra, 96 
Folder, I I 
icons, ll , 27 

opening, 27-28 
selecting, 27 

moving font~ from and to, 75 
o nly one per computer , 12,95 
version numbers of, 12 

System 7, 5, 99- 136 
aliases, 127-130 

fi nd ing orig ina l fil e belonging to , 130 
ideas for using, 129 
making, 128 

Apple menu , 113 
Apple :vte nu Items, 11 3, 120 

a liases on, 113 
applications 

me nu, 11 8, 139 
"Before You Install " disk, I 00 
brief overview, 101- 108 
changing labels in , 11 5 
"Clean Up" command in , .11 6 
"Clean Up Desktop," 11 6 
Clipboard in, 120 
Color contro l panel, 11 5, 124 
compatibility of progra ms with, 100 
cont rol pane ls, 120, 123-126 
customizing window info rmation in , Ill 

Desk Accessories, I 13 
installing, 113 

d eskto p, I 0 I 
dialog boxes in , I 04 
d isabling I NITs and CDEVs in, 106 
disks 

what to do witJ1 a ll ten, 100 
Eas)' Access, I 25 
Editmenn, 114 
Extensions, I 21 
File me nu, 11 4 
File Sharing Monitor control panel, 126 
Find File , 131- 133 

"all at once," 132 
''Find Again," 132 
restricting searches in, 133 
"Search," 133 
searc h witJ1in a sea rch, 133 

Finder shortcut~. I I I 
fo lders 

expanding, 109 
fo nts 

insta lling nou-TrueTypc, 136. See aLw 
TrueType fonts (System 7) 

General ContJ·o ls, 123 
Help, 11 7 
how to get it, I 00 
how to tc U if you •·cally want it, 0!J 
icons, 109-112 

cha nging back to original, 11 2 
cleaning up, 11 6 
creati ng your own, 11 2 

Keyboard, 125 
Label men u, II •I 
labe ls 

applying Lo icons, 115 
g lobally chang-ing from comrol panel, 115 
se tt ing up your own syste m of, 115 

Labels control panel, 115, 124 
list views, II 0 
"Make Alias," 114 
Memory comrol pane l, 125 
me nus, I I 3-11 7 
missing co!OJ- me nu in , 115 
Monito•·s control panel , 125 
:VIouse, 125 
Mult i Finder and, .11 8, 137- 140 
''NeLworking Basics," 100 
ne tworking contro l pan els, 126 
outline view, 109 
pop-up menus in , 104 
Portable control panel, 126 
Preferences, 121 
Publishers a nd Subscribers, I 07 
renaming icon s in, 11 2 

.... ~ ... -.-*•-N---~~-~...,_..__.~._~.,_.~ .......... ar~ ~ ...wur~ .. a. ...... _. 
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undo ing, 11 2 
Scrapbook, 120 
sharing files in, I 07 
"Sharing ... ," 114 
Sound control panel, 124 
Special menu, 115 
Startup Disk control panel, 124 
Startup Items, 120 
stationery pads, 106 
System file , 119 
System Folder, 119 
tiny u·iangle n ext to fo lders in , I 09 
Trash Can in , 103 
TmeType fonts, 135-136 

installing, 135 
Users & Groups control panel, 126 
Views, 123 
Views conu·ol panel, 123 
virtual memory, 108 
what it takes to upgrade to, 99 
Windows, 109-11 2 
windows 

scrolling, 11 0 
viewing by name, 109 

world map, 125 
System bombs, 95 

what to d o about, 95 
System crash 

possible lr\ IT responsibility fo r, 96 
System error 

ejecting disks afte r , 62 
System file (System 7), 119 

icon fo r , 119 
System Folder (System 6), 97 

icon, 11 , 11 9 
printer icons in, 56 
printing requirements, 97 

System Folder (System 7), 11 9-121 
Apple Menu Item, 120 
Clipboard , 120 

T 

Conu·o l Panels, 120 
Extensions, 121 
installing items into, 121 
Preferences, 121 
Scrapbook, 120 
Startup I te rns, 120 
System file , 11 9 

Tab Key 
using to move around in dialog boxes, 90 

Tagged Image File Format 
d efinition of, 161 

"Tall Adjusted," 57 
TeachText, 16 1 

INDEX .,. typing 

Telecommunications, 161 
Templates 

in System 7 
making out of documents, 106 

Text 
blank spaces in , 43 
centering, 44 
formatting 

unexpected change in, 96 
highligh ted 

assign ing colo r to (S~·stem 7), 115 
shortcut for replacing, 90 

highligh ting, 42 
selecting, 15 

Text-only documents, 161 
Throwing away a locked file, 32 
TIFFs 

definition of, 161 
on scanners, 157 

nlde key, 20 
fips (a few extra), 87-92 
ntle bar, 21 
Toggle, 45, 16 1 
Tracking speed, 83 
Traditional typefaces, 65 
Trash Can 

emptying, 30 
icon for, 29 
putting so mething in, 29 
removing something from, 29 
System 7, 103 

waming dialog box, 103 
using, 29 
what to do if garbage is hanging around, 98 

Trash can 
ej ecting disks through , 61 

Triangle 
next to each folder in System 7, 109 

Tricks 
a few extra for System 7, 106 

TrueType fonts (System 7), 135-136 
installing, 135 

Turning on the computer, 11 
help with, 93 

Type. See Fonts 
Type 1 fonts, 162 
Type 2 fonts, 162 
Type 3 fonts, 162 
Type size, 67 

ou tlined sizes in dialog box 
screen resolutio n of, 67 

Typefaces. See Fonts 
Typing, 41, 41-48 

con trolling how fast, 82 
o ne space after pe .-iods, 50 
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underline in the info bar ~ INDEX 

u 
Underline in the information bar 

mean ing of, 24 
Undo, 48 

" Undo," 32 
Undoing an icon name change, 32 

in System 7, 11 2 
Unhighlighting text, ·12 
Upgrades, 12, 162 
Uploading, 162 

"User Name," 81 
Users & Groups control panel 

(System 7), 126 
icon for, 126 

Utilities, 163 

v 
"V" with Command key, 48 

Vaporware, 163 
Version numbe rs (software), 12, 162 
Video cards, 16::1 
Viewing files 

by date, 24 
by icon , 24 

cleaning up, 25 
by kind, 24 
by name, 24 
by size, 24 
by small icon , 24 

Viewing the Window, 23 
Views 

icon fo r, 123 
System 7, 123 

Views control panel (System 7), 123 
icons for, 123 

Virtual memory (System 7), I 08 
turning on, 125 

Viruses, 163-1 65 
CDEF, 164 
creating pr inting problems, 98 
how to know when you have o ne, Hi•l 
System 7's immuni ty to, 164 
WDEF, 92, I 63 

w 
Warning dialog box, 30 
WDEF virus, 92, 163 
What You See Is What You Get, 165 
White Scroll Bar, 2 1, 22 
Williams, Robin, 157 
Windows, 21-26 

act.ive, 21 
good housekeeping for, 63 
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hiding in MultiFinder, 140 
making active, 22 
moving, 2 1 

witlw ut making active, 22 
printing information in, 26 
System 7, I O!J-1 12 

cleaning up act.ive icons in, I ll 
closi ng trick, I 06 
customizing, 123 
customizing information in , Ill 
making active, 110 
prin ting, 105 
scrolling, I I 0 
viewing by name, 109 

Winiwig, 165 
Word wrap, 42 
World map (System 7), 125 
WYSIWYG, I fi5 

X 
X, Flashing 

what to d o when you get, 93 
"X" with Command key, 48 

z 
"Z" with Command key, 48 
Zoom box, 2 1 , 22 

in System 7, II 0 

Colophon 
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A HANDY (HART 

Here is " Option Opening double quote 
a handy chart : " Option Shift Closing double quote 

for finding . ' Option Opening single quote 
some of the . 

special characters · ' Option Shift ] Closing single quote; 

available that · Apostrophe 

will make your Hyphen Hyphen 

work look more Option Hyphen En dash 
professional Option Shift Hyphen Em dash 

Option Ellipsis (this character cannot 
be sejJarated at the end of a line 
as the three periods can) 

• Option 8 Bulle t 

0 0 (in font ZapfDingbats) 

• n (in font Zapf Dingbats) 

0 n (outlined) (in font Zapf Dingbats) 

© Option g Copyright symbol 
Tht Option 2 Trademark symbol 

® Option r Registration symbol 
0 Option Shift 8 Degree symbol: 105° F 
¢ Option $ Cents symbol 

I Option Shift ! Fraction bar (it fits fractions 
bel/er ana doem 't descerul below 
the baseline as the slash does) 

fi O ption Shift 5 Ligature for f and i 
fl O ption Shift 6 Ligature for f and I 
£ Option 3 English pound sign 

,: Option Shift ? Spanish symbol 

{: Option c Cedilla, lowercase 

c Option Shift c Cedilla, capital 

00 Control Q (only in the Chicago font; 
the Contro l key is not on 
a Mac Plus keyboard) 

Accent Marks Option e 
Refer to page 50 to learn Option 

how to type these in; Option u 
this page is merely a . 

quick 1-ejenmce · Option n 
1\ Option 
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